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Legal Information

The Schneider Electric brand and any registered trademarks of Schneider Electric Industries
SAS referred to in this guide are the sole property of Schneider Electric SA and its subsidiaries.
They may not be used for any purpose without the owner's permission, given in writing. This
guide and its content are protected, within themeaning of the French intellectual property code
(Code de la propriété intellectuelle français, referred to hereafter as "the Code"), under the laws
of copyright covering texts, drawings andmodels, as well as by trademark law. You agree not
to reproduce, other than for your own personal, noncommercial use as defined in the Code, all
or part of this guide on any medium whatsoever without Schneider Electric's permission, given
in writing. You also agree not to establish any hypertext links to this guide or its content.
Schneider Electric does not grant any right or license for the personal and noncommercial use
of the guide or its content, except for a non-exclusive license to consult it on an "as is" basis, at
your own risk. All other rights are reserved.

Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.

As standards, specifications and designs change from time to time, please ask for confirmation
of the information given in this publication.
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Safety Information
Important Information

Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a
procedure.

The addition of either symbol to a "Danger" or "Warning" safety label
indicates that an electrical hazard exists which will result in personal
injury if the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result inminor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

Please Note
Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid
the hazards involved.
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Safety Precautions
During installation or use of this software, pay attention to all safety messages that occur in the
software and that are included in the documentation. The following safety messages apply to
this software in its entirety.

WARNING
UNINTENDED EQUIPMENT OPERATION

• Do not use the software for critical control or protection applications where human or
equipment safety relies on the operation of the control action.

• Do not use the software to control time-critical functions because communication delays
can occur between the time a control is initiated and when that action is applied.

• Do not use the software to control remote equipment without securing it with an
authorized access level, and without including a status object to provide feedback about
the status of the control operation.

Failure to follow these instructions can result in death or serious injury.

WARNING
INACCURATE DATA RESULTS

• Do not incorrectly configure the software, as this can lead to inaccurate reports and/or
data results.

• Do not base your maintenance or service actions solely onmessages and information
displayed by the software.

• Do not rely solely on softwaremessages and reports to determine if the system is
functioning correctly or meeting all applicable standards and requirements.

• Consider the implications of unanticipated transmission delays or failures of
communications links.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.
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Application Modules

In addition to the foundational solution, a set of applicationmodules is available to use with
PowerMonitoring Expert, and the Data Center and Healthcare Editions (hereafter collectively
referred to as PowerMonitoring Expert). Depending on your system, thesemodules enhance
the capabilities of PowerMonitoring Expert by helping to better manage system equipment,
increase power efficiency and capacity, monitor and log data to capture electrical events, and
bill tenants.

The following diagram illustrates the applicationmodules that can be used with Power
Monitoring Expert:

This guide includes detailed information on how to configure the PowerMonitoring Expert
applicationmodules.

NOTE: Each applicationmodule requires a license to be used. Contact your Schneider Electric
representative for more information.
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Breaker Performance

Breaker PerformanceModule lets youmanage and report on breaker performance and wear.

The Breaker PerformanceModule includes the following configuration tool and report:

• "Breaker Aging Configuration Tool" on page 12

• "Circuit Breaker Aging Report" on page 25

Breaker Aging Configuration Tool
The Breaker Aging Configuration Tool supplies circuit breaker aging and wear data for devices
in your system to PowerMonitoring Expert. Using this feature, you canmonitor and report on
the status of circuit breaker aging and wear in your electrical system.

WARNING
INACCURATE DATA RESULTS

Do not install incorrect drivers for the circuit breakers in your system. This can lead to
algorithms not functioning correctly and to incomplete or inaccurate reports and/or data
results.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Supported devices
The Breaker Aging Configuration Tool in PowerMonitoring Expert supports the following
devices:

Standard / Country Circuit Breaker Range Control Unit Range

IEC

• Masterpact NT

• Masterpact NW

• Compact NS630b-3200

• Micrologic 2 A/E

• Micrologic 5 A/E/P/H

• Micrologic 6 A/E/P/H

• Micrologic 7 A/P/H

Micrologic 5.2/6.2/5.3/6.3 A/E
• Micrologic 5 A/E

• Micrologic 6 A/E/E-M

China

Compact NS630b-1600

• Micrologic 2 A

• Micrologic 5 A

• Micrologic 6 A

Masterpact MT

• Micrologic 2 A

• Micrologic 5 A/E/D/P/H

• Micrologic 6 A/E/D/P/H

• Micrologic 7 A/P/H

PowerPact H-, J-, and D-Frame Same asabove
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Standard / Country Circuit Breaker Range Control Unit Range

USA

• Masterpact NT for IEC, UL, and
ANSI standards

• Masterpact NW for IEC, UL, and
ANSI standards

• Compact NS630b-3200

• PowerPact H-, J-, and L-Frame

• Micrologic 2 A

• Micrologic 3 A

• Micrologic 5 A/P/H

• Micrologic 6 A/P/H

PowerPact H-, J-, and D-Frame Same asabove

Setting up the system

Adding Circuit Breaker devices
Add all necessary Circuit Breaker devices to your PowerMonitoring Expert system using the
Management Console.

Add any necessary Power E Box devices to theManagement Console. These devices are
optional for the breaker aging and wear calculations.

For instructions on how to add Circuit Breaker devices toManagement Console, see "Adding
the SER-2408/SER-3200 toManagement Console" on page 252.

Starting the ION software Modbus Gateway service
1. Open theWindows Services panel by clicking Start > Administrative Tools > Services.
2. Make sure that ION software Modbus Gateway Service is both enabled and

started/running. If the service is not enabled, then start and enable the service.

Adding new calculation service provider
1. InWindows Explorer navigate to ...\[Install path]\system\bin and double-click

ModbusServiceConfigurationTool.exe to run it. The configuration dialog appears.
2. Click Add. TheAdd Service Window dialog appears.
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3. Available Services: Select Breaker Aging Calculation Service from the dropdown list.

4. Unit ID: Enter a value of "1" if this is the first service provider you are adding. Otherwise,
enter the next logical value for Unit ID.

NOTE: If you have already setup the "Telvent Weather Data Import Service" on page 169 and
have used UNIT ID = 1, then youmust input a unit ID other than 1, (for example, 2).

5. Click Configure. TheBreaker Aging Service Configuration dialog appears. Leave these
values as the default.

Note: These settings are for advanced users only andmay bemodified if certain load con-
ditions in the system require that the polling priority and frequency of real-timemeter data be
decreased or increased.

These settings only apply to real-time data requests for breaker aging and wear calculations,
and are independent of other types of requests in the system (such as VISTA diagrams,
Gadgets, and so forth)

Real Time Request Polling Interval (in sec): This is the frequency (in seconds) that is used
to request real-timemeter data for calculations.

Real Time Request Priority Level: This is the level of priority for real-timemeter request. The
levels are:

Frequency (in seconds) Priority

0 Low

250 Medium

500 High

1000 Intermediate

5000 Urgent

10000 Control

6. Click OK to proceed. TheBreaker Aging Calculation Service appears in the list.
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A dialog appears informing you about the configuration change.

7. Click Yes to continue and to restart theModbus Software Gateway Service.

Adding new site for the calculation service
Add a new site in Management Console that will communicate with the Circuit Breaker Aging
Calculation service.

Note: These steps are only necessary if you have not yet set up and configured a site for a ser-
vice (that uses theModbus Software Gateway Service), such as the Telvent Weather Data
Import Service. If you have already set up and configured a site for a service, you can ignore
the following steps.

1. OpenManagement Console. TheManagement Console dialog appears.
2. In the left pane, click Site.

3. Right-click on the dialog and chooseNew > Ethernet Gateway Site.

TheEthernet Gateway Site Configuration dialog appears. Complete the fields. Items in
red aremandatory.
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4. Name: EnterBreakerAgingWearSite.

5. TCP/IP Address: Enter <your local PME server IP address>.

6. TCP/IP Port: EnterModbusTCP Device|502.

7. Computer: Enter <your local PME server IP address>.

8. Click OK. The new site is created.

Adding new device for the calculation service
Add a new device in Management Console to the new BreakerAgingWearSite that will
communicate with the Circuit Breaker Aging Calculation service.

1. OpenManagement Console. TheManagement Console dialog appears.
2. In the left pane, click Device.

3. Right-click on the dialog and chooseNew > Serial Device on Ethernet Gateway Site. The
Serial Device Configuration dialog appears. Complete the fields. Items in red are
mandatory.
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4. Group: EnterBREAKERS.

5. Name: EnterBreakerAgingWearProvider.

6. Device Type: EnterBreaker Aging And Wear Provider.

7. Unit ID: Enter the sameUnit ID you configured in theModbus Gateway Service
configuration tool.

8. Site: Enter the same site name you entered in the configuration tool.Ideally, the site name
you enter can be shared for both Breaker Aging and Telvent.

9. Enabled: EnterYes.

10.Click OK. The new device appears in the list.

Configuring breaker devices
Use the Breaker Aging Configuration Tool to configure breaker devices.

To configure breaker devices:

1. Navigate to the ...\system\bin folder and double-click Breaker Aging Configuration
Tool. If this is the first time you are configuring data, choose the regional setting for circuit
breaker and wear library and then click OK.

TheBreaker Aging Configuration Tool dialog appears.
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2. Click theBreaker Device tab, and then click New to add one or more breakers to the
system. The configuration dialog appears.

3. For each breaker device enter the following information:

• Name: Enter a unique name to identify this breaker in the generated Vista diagrams and
the Circuit Breaker Aging report.

• Source: Associate the device that is to provide data for this breaker (such as load values,
total harmonic distortion, and so forth). Note that you can only associate each device in
the system with one breaker device.

• Use the dropdown lists to select values forRange, Designation, Rating, andControl
Unit Rating.

• Voltage: Enter a value.

4. Click Is existing breaker device? if the breaker device already exists in the system.

5. If you select this check box, complete the available fields for each existing breaker device.
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NOTICE
UNINTENDED OPERATION

If you select the check box for Is existing breaker device?, then go to the SEC website
and search for "Is existing breaker device." Open and read the knowledgebase article, and
then follow the instructions.

Failure to follow the instructions in the knowledgebase article will result in this
feature not functioning as intended.

After you finish adding and configuring all necessary breaker devices, create any switchboards
necessary.

Configuring switchboards
Use the Breaker Aging Configuration Tool to configure switchboards.

To configure the switchboards:

1. InWindows Explorer navigate to the ...\system\bin folder and double-click Breaker
Aging Configuration Tool. If this is the first time you are configuring data, choose the
regional setting for circuit breaker and wear library and then click OK.

TheBreaker Aging Configuration Tool dialog appears.

2. Click theSwitchboard tab, and then click New to add one or more Switchboards to the
system. The configuration dialog appears.
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3. For each switchboard enter the following information:

• Name: Enter a unique name to identify this switchboard in the generated Vista diagrams and
the Circuit Breaker Aging report

• Critical Threshold % and Moderate Threshold %: Enter default values (0-100%) to be
used for each breaker associated with this switchboard when performing analysis of their
electrical aging and electrical wear levels.

Note: If necessary, a Power E Box device can be shared across multiple switchboards.

• Environmental Conditions: Use dropdown lists to select values forSwitchboard IP,
Salty Atmosphere, Corrosive Gas, andDust Level.

• Sensor Data: Select one of twomodes, and then use the dropdown lists to select values for
the parameters.

• Manual: Define static values for humidity, temperature and vibration levels experience in
the switchboard.

• Monitored: Associate the switchboard with an optional IO device (Power E Box) in the
system that is to provide real-time values for humidity, temperature, and vibration levels
measured in the switchboard. If necessary, a Power E Box device can be shared across
multiple switchboards. The devicemust first be configured in theManagement Console.

Note: If you enter a value of "0" (zero), that level is ignored for the calculations.
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• Breakers: Select one or more breakers from the list. Note that each breaker can be
associated with only one switchboard in the system.

4. Click Is existing switchboard? if the switchboard already exists in the system.

NOTICE
UNINTENDED OPERATION

If you select the check box for Is existing switchboard?, go to the PME Exchange
Community web site and search for "Is existing switchboard." Open and read the
knowledgebase article, and then follow the instructions.

Failure to follow the instructions in the knowledgebase article will result in this
feature not functioning as intended.

5. If you select this check box, use the dropdown lists to complete the fields forVibration
Level, Temperature, andHumidity for each existing switchboard.

After you finish configuring all existing switchboards, create any groups as necessary.

Configuring groups
Use the Breaker Aging Configuration Tool to configure groups. Youmust groups in order to
generate the Circuit Breaker Aging Report.

To configure groups:

1. Navigate to the ...\system\bin folder and double-click Breaker Aging Configuration
Tool. If this is the first time you are configuring data, choose the regional setting for circuit
breaker and wear library and then click OK.

TheBreaker Aging Configuration Tool dialog appears.

2. Click theGroups tab, and then click New to add one or more Switchboards to the system.
The configuration dialog appears.
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3. For each group enter the following information:

• Name: Enter a unique name to identify this group in the generated Vista diagrams and the
Circuit Breaker Aging report

• SwitchboardsSelect one or more switchboards from the list. Note that a switchboard can
be used inmultiple groups, if necessary.

After you have created all breakers, switchbreakers, and groups, you can generate a set of
optional Vista diagrams.

4. Click theGroups tab, and then click Generate Vista Diagrams. A Vista Diagram
Generation configuration dialog appears.
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Note: TheOutput Path shows the location where the Vista diagram .dgm file is saved after
clickingGenerate Vista Diagrams.

5. Click Include Custom Logo and then navigate to and select the file in order to include a
custom logo in your diagrams. Otherwise, a Schneider Electric logo appears.

6. UnderOptions, drag the indicator to define the width of Vista diagrams you generate.

7. Click Generate Vista Diagrams to generate the .dgm files, then click OK andClose.

Pasting the Circuit Breaker Aging framework in VIP

WARNING
UNINTENDED EQUIPMENT OPERATION

• ION modules and registers must only be configured by personnel with a thorough
understanding of ION architecture and the system in which themeters and software are
installed.

• Do not usemeters or the software for critical control or protection applications where
human or equipment safety relies on the operation of the control circuit.

• Do not use an ION meter's digital output for any safety critical application due to possible
unexpected change of state during power cycles, power outages, configuration changes
or firmware upgrades.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

1. Open theDesigner tool and open theVIP.<servername>. node.
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2. Drag aGrouping Object and open it.

3. Go to ...\config\fmwk\BreakerAging\CB Aging Grouping Status
Framework.fwn and select Edit > Paste to paste the framework. Depending on the
number of Circuit Breakers and groups, youmay need to set up the framework.

4. Connect the inputs of each AND/OR module (Circuit Breaker) to the critical operation and
battery usage status.

5. Repeat this step for each Circuit Breaker in the group and for all of the Circuit Breakers in the
other groups.

6. Save the framework after you finishmodifying the framework based on your Circuit Breaker
system.

Opening Vista diagrams and linking the status
1. Log in to Vista, select Open File and then browse to

...\config\diagrams\ud\BreakerAging\Groups.dgm.
2. Manually link the status object to the framework you pasted in VIP in the previous steps.

Healthcare example:

Data Center example:
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3. Repeat this step for all other groups. Your Circuit Breaker Monitoring system is now setup.

For example:

Note: Any Circuit Breakers in the groups that require attention show a red LED indicator.

4. Manually link the status object from the framework you pasted in the VIP in previous steps.

After you finish configuring all circuit breakers, you can configure and generate the Circuit
Breaker Aging Report.

Circuit Breaker Aging Report
Use PowerMonitoring Expert > Web Applications > Reports to configure and generate the
Circuit Breaker Aging Report.

1. Complete the fields to define the report:
• Title - Enter a name for the report. It appears in the header section of the report.

• Select Group - Select a group from the dropdown list to be used for determining which
switchboards and breakers are used for the analysis.

• Grouped By - Select from the dropdown list to determine how the circuit breaker aging
and electrical wear analysis results are sorted.

Switchboard Name first and Threshold Level second - The results are sorted first by
the names (in alphabetical order) of all the switchboards associated with the selected
group, and then by the criticality level in descending order of importance (Critical,
Moderate, Minor).

Threshold Level first and Switchboard Name second - The results are sorted first by
criticality level in descending order of importance (Critical, Moderate, Minor), and then by
the names (in alphabetical order) of all the switchboards associated with the selected
group

• Include Breakers with Minor Aging and Wear - Select Yes or No. Selecting Yes
allows all of the breakers to appear in the report regardless of the current electrical aging
and electrical wear levels. Selecting No allows only breakers with moderate or critical
electrical aging and electrical wear to appear.
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• Include Data Warnings - Select Yes or No.

2. Click Generate Report to produce the report.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.
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Energy Analysis

The Energy Analysis Module lets you understand energy usage patterns to find energy waste,
analyze transformer and circuit capacity as configurations change, determine what factors
contributemost to energy usage, and assess energy usage by process area or by product
output.

The Energy Analysis Module consists of the following reports:

• "Energy Regression Analysis Report" on page 27

• Duration Curve Report 1

• Energy Usage per State Report 1, 2

• Multi Equipment Operation Reports 1, 2

• Power Usage per State Report 1, 2

• Single Equipment Operation Reports 1, 2

1. For more information on how to use the Energy Analysis reports, see PowerMonitoring
Expert Web Applications help.

2. For more information on how to configure the equipment state reports, see thePower
Monitoring Expert Equipment State Report Configuration Guide on the PME Exchange
Community.

Energy Regression Analysis Report
TheEnergy Regression Analysis report allows you to analyze building energy systems,
monitor energy consumption, andmonitor for anomalies or changes in system behavior. Based
on the report results, you can perform energy efficiency upgrades or fixes as needed, or model
energy data one independent variable at a time with a wide range of desired independent
variables.

Configure and Generate the Energy Regression Analysis Report
Use the Reports module inWeb Applications to configure and generate the Energy Regression
Analysis Report.

1. Complete the fields to define the report:
• Title - Enter a name for the report. It appears in the header section of the report.

• Driver Data Source - Select a grouping and single source for the report.

• Driver Data Quantity - Select a grouping and a corresponding single quantity that is used
to calculate the values for the X-axis of the Regression Analysis Chart. For example, you
can use a weather data source and quantity as the driver for themodel you intend to
generate.

• Model Data Source - Select a grouping and single source for the report.

© 2016 Schneider Electric. All rights reserved. Page 27 of 282

Power Monitoring Expert 8.1 ApplicationModules EnergyAnalysis



• Model Data Quantity - Select a grouping and a corresponding single quantity that is used
to calculate the values for the X-axis of the Regression Analysis Chart. For example, you
can use a building electrical consumption data source and quantity as the input data for
themodel you intend to generate.

• Reporting Period - Select from the list to specify a period of time for the report that is
used to query data from the database for driver andmodel data. Select the server time
from the next dropdown list.

• Regression Type - Select Single Line or Broken Line as the type of line to be used in the
report.

• X-Axis Calculation Method - Select how data is grouped for the X-axis values from
these calculationmethod options: Cooling Degree Days (CDD), Heating Degree Days
(HDD), Average (AVG), Sum, and Delta.

Driver quantity data is retrieved differently depending on which calculationmethod you
select:

• Cooling Degree Days: All data points within the selected reporting period that are
above the Degree Days Pivot Point temperature are retrieved from the database. Any
data point at or below the Degree Days Pivot Point temperature is set to 0.

• Heating Degree Days: All data points within the selected reporting period that are
below the Degree Days Pivot Point temperature are retrieved from the database. Any
data point at or above the Degree Days Pivot Point temperature is set to 0.

• Average: All data points within the selected reporting period are retrieved from the
database.

• Sum: All data points within the selected reporting period are retrieved from the
database, and values are summedwith previous points as they are inserted into the X
data table.

• Delta: All data points within the selected reporting period are retrieved from the
database, and values are calculated by subtracting previous points before inserting
them into the X data table.

NOTE:This parameter depends on selecting the Driver Data Quantity parameter. You can
select either "Cooling Degree Days" or "Heating Degree Days" only if the driver data is weather
temperature data in Celsius or Fahrenheit degrees.

• Degree Days Pivot Point - Enter a value in degrees Celsius to define what the base
temperature in the heating degree days and cooling degree days calculations. By default,
this value is set to 18, which represents 18 degrees Celsius.

NOTE:This parameter depends on selecting the Driver Data Quantity parameter. The units for
this valuemust match the units for the Driver Data Quantity value.

• Y-Axis Calculation Method - Select how data is grouped for the Y-axis values from
these calculationmethod options: Average, Sum, and Delta.

Model quantity data is retrieved differently depending on which calculationmethod you
select:

• Average: All data points within the selected reporting period are retrieved from the
database.
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• Sum: All data points within the selected reporting period are retrieved from the
database, and values are summedwith previous points as they are inserted into the Y
data table.

• Delta: All data points within the selected reporting period are retrieved from the
database, and values are calculated by subtracting previous points before inserting
them into the Y data table.

NOTE:This parameter depends on selecting theModel Data Quantity parameter. Select Sum
only if themodel data is interval data. Select Delta only if themodel data is cumulative data.

• Aggregation Interval - Select how driver andmodel data will be combined to be
processed from these two options:

• Day - For daily aggregation, the data collected over the designated reporting period is
grouped into days, and an average value is taken for each day.

• Week - For weekly aggregation, the data collected over the designated reporting period
is grouped into weeks, and an average value is taken for each week.

• Exclude Incomplete Weeks - Determines whether or not incomplete sets of data from
the report calculations are removed.

When you select Yes, any week that does not have a value very close to the start (within
the first hour of the first day of the week) and a value very close to the end (within the last
hour of the last day of the week) is considered incomplete, and any data for that week will
be disregarded.

This parameter depends on the Aggregation Period parameter. This check is only used
when you select "Week" for the aggregation period.

• Exclude Incomplete Days - Determines whether or not incomplete sets of data from the
report calculations are removed.

When you select Yes, then any day that does not have at least 80% of the calculated
average number of values collected per day is considered incomplete, and any data for
that day will be disregarded.

This parameter depends on the X- and Y- Axis CalculationMethod parameters. This
check is used on both axes when you select "CDD,"HDD," "AVG," or "Sum."

• Exclude Days with Rollover - Determines whether or not an incorrect set of data from
the report calculations is removed due to ameter register rollover.

When you select Yes, then if the absolute value of the data point at the end of the day is
greater than the absolute value of the data point at the beginning of the day, rollover has
occurred, and any data for that day will be disregarded.

This parameter depends on the Y- Axis CalculationMethod parameter. This check is only
used on the Y-axis when you select "Delta."

• Deviation Type - Allows you to select "Percent" or "Absolute Value" deviation type from
the list to specify how the report determines when data exceptions appear in the report
charts and tables. These deviations refer to discrepancies in the Y-axis between the ideal
regression line and real data points.

There are two deviation types:
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• Percent - Select "Percent" to specify that themaximum authorized deviation value has
percentage units. Exceptions are displayed on the charts and logged in the Exceptions
Table for any data points whose Y value falls outside of the designated percent range
above or below the ideal regression line. This range will grow as one shifts rightwards
along the regression line and Y values become larger.

• Absolute Value - Select "Absolute Value" to specify themaximum authorized
deviation value has the same units as the Y-axis measurement. Exceptions are
displayed on the charts and logged in the Exceptions Table for any data points whose Y
value falls outside of the designated value range above or below the ideal regression
line. This range will stay constant as one shifts rightwards along the regression line.

• Max Authorized Deviation - Enter a value in the field. This parameter depends on what
you select for Deviation Type. If you select "Percent," the units for Max Authorized
Deviation will be percent. If you select "Absolute Value," the units for Max Authorized
Deviation will correspond to the units for theModel Data Quantity.

• Include Data Warnings - Select "Yes" to include informational messages related to the
report, or "No" to exclude thesemessages.

• Include Report Parameters Summary - Select "Yes" to include a summary of the input
parameters at the beginning of the generated report, or select "No" to exclude them.

2. Click Generate Report to produce the report.

See "Interpreting the Energy Regression Analysis Report results" on page 259 for information
on reading and interpreting the report.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.
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Energy Billing

The Energy BillingModule is a fully functional energy-based billing reporting system that
consists of the following reports:

• Billing Report

• Billing Summary Report

• Multiple Billing Report

• Multiple Billing Export Report

For more information on how to use the Billingmodule, see the BillingModule Toolkit on the
PME Exchange Community web site
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IT Billing

The IT BillingModule provides information on energy usage for use within a data center facility
for billing purposes.

The IT BillingModule includes the "Energy by IT Customer Report" on page 32.

The IT BillingModule also includes the "Energy Billing" on page 31.

Energy by IT Customer Report
The Energy by IT Customer Report is used by data center operators to generate a report that
provides information regarding energy usage for customers within the data center facility.

NOTE: This report requires a license to be used. Contact your Schneider Electric rep-
resentative for more information.

Use the Energy by IT Customer Report to:

• Troubleshoot your billing system

• Export your billing system (for CSV export)

• Examine customer specific energy usage.

NOTE: For the Energy by IT Customer Report to provide accurate information, devices must
be installed, configured, and communicating correctly, the hierarchy must be set up and con-
figured correctly, and theManaged Circuits feature run each time a device configuration
change is made. If any of these tasks are not performed correctly, your reports will provide inac-
curate information.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.

NOTE: Report output will vary depending on which hierarchy you are using.

Energy by IT Customer Report Example
The Energy by IT Customer Report data depends on the selections youmake while configuring
the report and the contents of the PowerMonitoring Expert or Data Center database.
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Emergency Power Supply System (EPSS)

The Emergency Supply System (EPSS) Module is a licensablemodule you can add to
PowerMonitoring Expert solutions.

PowerMonitoring Expert provides datamonitoring and logging to capture electrical events
and readings. The EPSS module provides the specific tools and reports to help facilities
manage the power data specifically for EPSS tests or during loss of power from amain
utility.

Schneider Electric or Schneider Electric System Integrators generate reports that
government and organizational inspectors may view as an aid to help determine if an EPSS
is in an adequate state to generate electrical power during a utility outage.

NOTE: A PowerMonitoring Expert system supports both Open Transition Transfer (OTT)
and Closed Transition Transfer (CTT). By default, the PowerMonitoring Expert system is set
for OTT. However, if your customer needs to run a CTT test, navigate to the PowerMon-
itoring Expert Exchange Community web site, in the Install andMaintain section, and then
download and run the necessary SQL script.

In addition to the features provided by the base system, the EPSS provides these
capabilities:

• Vista diagrams –Generates the system Vista diagrams based on the transfer switch and
backup generator configuration.

• Real-time data in Vista – Diagrams show electrical data, generator status, transfer
switch status and electrical data, and fuel management data.

• EPSS Test Report – A comprehensive report of load supporting capabilities for the
transfer switches, generators, and equipment. You can use this report to evaluate the
overall condition of the EPSS.

• Run history viewer – Displays Test, Load Shedding, and Power Outage run activities
stored in the system history.

• Smart Device Data Collector– Displays ATS load transfer data, logs standard data for
generators, and can also log custom data values.
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WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the EPSS system, this can lead to inaccurate reports
and/or data results.

• Do not rely solely on EPSS reports to determine if the EPSS system is functioning
correctly or meeting all applicable standards and requirements.

• Use EPSS reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Configuration Overview
To configure PowerMonitoring Expert with the EPSS Test module, follow these steps:

1. Obtain and install a license for the EPSS Test module.

2. Set up the installed ION meters, including ATS and generator frameworks. See
"ION PowerMeter Configuration" on page 179 for details.

3. Set up the installed non-ION meters, including digital and analog outputs. See "Non-ION
PowerMeter Configuration" on page 201 for details.

4. Generate and configure Vista diagrams of EPSS equipment. See "Generate EPSS
Diagrams" on page 64.

5. Set up reporting entities in the configuration tool. See "Generator Performance
Configuration Tool with EPSS Test Module" on page 39.

6. Configure and run the EPSS Test Report. See "EPSS Test Report" on page 68.

7. (Optional) Configure and run the Smart Device Data Collector. See "Smart Device Data
Collector" on page 77.

Before you start the configuration process, review the following sections to learnmore about
the EPSS Test module.

Emergency Power Supply System (EPSS)
An Emergency Power Supply System (EPSS) provides emergency electrical power to any
facilities requiring continuous power, 24 hours a day, 7 days a week. Among these facilities
are hospitals andmedical centers.

In many jurisdictions, hospitals andmedical centers need to test their emergency power
supply systems on a periodic basis and keep records of such tests. Hospitals andmedical
centers in the USA, for example, must meet the standards specified by the Joint
Commission on Accreditation of Hospital Organizations (JCAHO) to operate their facilities.



These standards include the testing of generator systems. These JCAHO standards are
derived from both National Fire Protection Association (NFPA) and National Electrical Code
(NEC) requirements.

PowerMonitoring Expert uses the Generator Performance Configuration Tool with EPSS
Test Module to generate reports that government and organizational inspectors may view as
an aid to help determine if an EPSS is in an adequate state to generate electrical power
during a utility outage. These reports demonstrate compliance not only with the JCAHO
standards, but also with the standards mandated by many other geographies, such as:

• National Electric Code Article 220.87 for the United States of America.

• HTM 0601 for the United Kingdom.

• AS/NZS 3009 for Australia and New Zealand.

• 60364-7-710 for Europe.

• CSA Z32 for Canada.

Sequence of Events
The following diagram represents what happens in a backup power system when the power
supply system is tested.

The diagram depicts:

• The ATS events Normal, Test, and Emergency along the top.

• The corresponding GEN (generator) events Stop, Start, and Running along the bottom.

These ATS andGEN events are required by the Test Report to execute its logic.

You can use this diagram to identify which events in the power system correspond to the
ATS andGEN events represented in the diagram, and to help ensure that the correct signals
are wired to themeter's digital inputs.

The diagram also identifies which events are used to control logging of Analog and Load
Profile data, shown beginning at GEN Start in the diagram.

Power Monitoring Expert 8.1 ApplicationModules EmergencyPower SupplySystem (EPSS)
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Generator Performance Configuration Tool with EPSS
Test Module

TheGenerator Performance Configuration Tool with EPSS Test Module is an application that
helps you configure the transfer switches, generators and other equipment for reporting the
data and status of the power system, including EPSS components. The reports will not work
until the required parameters in the tool are set up.

In the configuration tool, you can also generate the Vista diagrams for the configured
devices. This feature of the tool produces the diagrams faster than building the diagrams
manually. Generated diagrams may still need some adjustment—you can use Vista to
finalize the diagrams

After your system is configured using the Generator Performance Configuration Tool, you
can use the following generator-related reports:

• Generator Activity Report

• Generator Battery Health Report

• Generator Capacity Report (available for PowerMonitoring Expert 8.1 Healthcare Edition
only)

• Equipment Capacity Report (available for PowerMonitoring Expert 8.1 Healthcare Edition
only)

• EPSS Test Report (requires a license for the EPSS Module)

NOTE:If your installation does not include the EPSS, see "Generator Performance Con-
figuration Tool" on page 89.

Prerequisites
• Before opening the configuration tool, make sure the sources - which represent metering

devices - are added inManagement Console and they are communicating.

Start the Generator Performance Configuration Utility with EPSS
To start the Generator Performance Configuration Tool with EPSS Test Module, open the
StruxureWare PowerMonitoring Expert folder on the desktop and double-click the Generator
Performance Configuration Tool shortcut.
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TheGenerator Performance Configuration Tool with EPSS Test Module window contains
these tabs: Groups, Generators, Transfer Switches, Equipment, andRun History. On
these tabs, you create the entities and groups for equipment in the system. You also create
Vista diagrams and view data for prior test run results. Use the tabs to define new entities or
update existing entities.

When you first use the configuration utility, define generators, transfer switches, and other
equipment on the applicable tabs. After you do this, define the device groups on theGroups
tab. The device groups are necessary for reporting and Vista diagrams.

Use the following tabs to configure the tool:

• Groups tab - "Define Groups for EPSS" on page 56

• Generators tab - "Define Generators for EPSS" on page 42

• Transfer Switches tab - "Define Transfer Switches for EPSS" on page 51

• Equipment tab - "Define Equipment for EPSS" on page 55

• Run History tab - "View RunHistory for EPSS" on page 60

Use the following common controls for the tabs:

• Help - Click this to view online help for the tab.

• New - Creates a new entry in the grid.

• Delete - Deletes the selected entry from the grid.



• Revert - Returns amodified record to its original values, if OK orApply have not been
clicked.

• OK - Saves all changes and exits the configuration tool.

• Cancel - Exits the tool without saving changes.

• Apply - Saves all changes and leaves the tool open.

TheModified column in the grid area shows the status of the row data:

+ (plus) - a new entry.

* (asterisk) - a modified entry.

! (exclamationmark) - entry needs more information before it can be saved.

Power Monitoring Expert 8.1 ApplicationModules
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Define Generators for EPSS
Use theGenerators tab to create or update entities representing the generators in the
emergency power supply system. Configure this tab to successfully generate reports for
generator data. After you configure, you can generate the Generator Test, Generator Load
Summary, Generator Capacity, and the Generator Battery Health reports from this
information.

You can perform the following actions on this tab:

• Click New to define the properties of the generators in the system. See "Edit Generator
Properties" on page 43.

• Click Clone to define a new generator that is similar to an existing generator. The system
copies many details of the existing device into the new entry. You can then enter the
unique details of the new device. If you need to define several devices that are similar, this
feature can help you define them quickly. See "CloneGenerator Properties" on page 46.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.



Edit Generator Properties
TheEdit Generator area on the tab is used to create a generator entry and to define specific
values for it.

1. On theGenerator tab, click New.
2. Complete the following fields to define a generator.

• Name - Enter a unique name to identify the generator.

• Description - optional. You can add specific information about the generator, such as
make andmodel.

Electrical Data

• Source - Select a source name from the dropdown list. The source
represents the device that records the electrical data from the generator.

• Prime Nameplate Rating - Enter themaximum power load for the
generator. Refer to the generator's nameplate for this value.

• Unit - Select the unit of measurement for the power load.

Engine Temperature Data

• (Optional) To capture engine temperature data, check the box and complete these
fields:

• Source - Select a source name. The source represents the device that
records the engine temperature of the generator.

• Measurement - Select the engine temperaturemeasurement.

• Unit - Select either F (for Fahrenheit) or C (for Celsius) for the temperature
unit of measurement.

The EvaluationMethod does not convert units from one type to another.
Set the Unit type for Engine Temperature Data on theGenerators tab to
the sameUnit type in the EvaluationMethod.

• Click Edit Evaluation Method to open theEvaluation Method editor. The
Evaluation Method editor is used to select the evaluationmethod and the
respective pass/fail criteria that you want to use when evaluating a
generator. See "Edit EvaluationMethod" on page 47.

• Click Assign Engine Data to open theEngine Data Measurements
editor. TheEngine Data Measurements editor is used to define engine
data values and other custom data values for generators. Defining engine
datameasurements is optional. See "Edit Engine Data" on page 49.

• Click Assign Engine Data to open theAssign Engine Data
Measurement editor. TheEngine Data Measurement editor is used to
associate engine data values with specific generator measurements. For
information about this activity, see "Assign Engine Data" on page 49.

Power Monitoring Expert 8.1 ApplicationModules

© 2016 Schneider Electric. All rights reserved. Page 43



Power Monitoring Expert 8.1 ApplicationModules

Page 44 © 2016 Schneider Electric. All rights reserved.

Exhaust Gas Temperature Data

• (Optional) If exhaust gas data is not being captured, you do not need to select and
complete these values. To capture exhaust data, check the box and complete these
fields:

• Source - Select a source name. The source represents the device that
records the exhaust gas temperature of the generator.

• Single Exhaust orDual Exhaust - Select one of these options to indicate
whether the exhaust gas temperature is measured for a single exhaust or a
dual exhaust generator.

• Measurement - Select the exhaust gas temperaturemeasurement.

• Unit - Select either F (for Fahrenheit) or C (for Celsius) for the temperature
unit of measurement.

• Click Edit Evaluation Method to open theEvaluation Method editor. The
Evaluation Method editor is used to select the evaluationmethod and the
respective pass/fail criteria that you want to use when evaluating a
generator. See "Edit EvaluationMethod" on page 47.

• Click Assign Engine Data to open theEngine Data Measurements
editor. TheEngine Data Measurements editor is used to define engine
data values and other custom data values for generators. Defining engine
datameasurements is optional. See "Edit Engine Data" on page 49.

• Click Assign Engine Data to open theAssign Engine Data
Measurement editor. TheEngine Data Measurement editor is used to
associate engine data values with specific generator measurements. For
information about this activity, see "Assign Engine Data" on page 49.

Status Measurements

• Use this area to configure the states used to record the status of a generator. A
generator can be in one of three states: Starting, Running, andStopped. When a
generator is in one of the states, the active value is stored in themeasurement. The
states appear in theEvents Summary section of the EPSS Test Report.

• Source - Select a source name. The source represents the ION device that
records the status of a generator.

• Starting - (Optional) This state indicates that the generator is starting.
Select the check box, select themeasurement that provides the starting
state input, and enter the active value for themeasurement. If this setting
does not apply to your installation, do not select the check box.

• Running - This state indicates that the generator is running. Select a
measurement that provides the running state input, and enter the active
value for themeasurement.

• Stopped - This state indicates that the generator has stopped. Select a
measurement that provides the stopped state input, and enter the active
value for themeasurement.



Two stop signals could be sent from the generator controller – the initial
stop signal, which is followed by 3-5minute cooling period, and the final
stop signal after the cooling period is complete. If the generator has two
stop signals, be sure to use themeasurement for the first stop signal before
the generator goes into the coolingmode. Do not use the stop signal after
the cooling period.

The active value for themeasurements can be any value you choose.

For example, assume that the system has been configured with
measurements of GENStarting, GENRunning, and GENStopped. You
assign thesemeasurements to theStarting, Running, andStopped
states respectively and enter 1 as the Active Value for each.

• When the generator starts, the active value for GENStarting becomes
1, andStarting is the state for the generator.

• When the generator is running, the active value for GENRunning
becomes 1, andRunning is the state for the generator.

• When the generator stops, the active value for GENStopped becomes 1,
andStopped is the state for the generator.

When an EPSS Test Report is generated, the states for the generator, and
the time when they occurred, are included in theEvents Summary section
of the report. See PowerMonitoring Expert Web help for information about
this report.

Additional notes about the Status Measurements:

If there is only onemeasurement to indicate that the generator is either running
or stopped, then you select that measurement for both theRunning and
Stopped states, and assign a different active value for each. For example, if
themeasurement used to indicate whether a generator is running or not is
GenRunningStopped, define the states like this:

For theRunning state:

1. Select GenRunningStopped as themeasurement.
2. Set the Active Value to 1.

When the generator is running, the active value for GenRunningStopped
is 1, andRunning is the state for the generator.

For theStopped state:

1. Select GenRunningStopped as the status measurement.
2. Set the Active Value to 0.

When the generator is stopped, the active value for GenRunningStopped
is 0, andStopped is the state for the generator.

• Monitor for EPS Available - (Optional) This state indicates that the
emergency backup source is available.

Power Monitoring Expert 8.1 ApplicationModules
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Select the check box, select themeasurement that provides the available
state input, and then enter the active value for themeasurement. If this setting
does not apply to your installation, do not select the check box.

Recommended state is 0 or 1.

• Required Time (Seconds) - Enter a value in seconds. The
Required Time value specifies the amount of time required to
be considered a pass.

If you click Apply at this point, you can run the EPSS Test
Report for date ranges, but not for a run history.

Battery Waveforms

• (Optional) Use this area to if you want to configure and generate the
Generator Battery Health Report. To enable the report, check the box and
complete these fields:

• Source - Select a source name that is performing the
waveform capture. This option is only available for ION7550
and ION7650meters.

• Measurement - Select themeasurement recording the
battery waveform. For a typical configuration, this is the V4
waveform.

3. Click Apply to save the changes and remain on the tab.

4. Repeat these steps to define other generators.

5. If you are defining several similar generators, use theClone button. See "CloneGenerator
Properties" on page 46.

Clone Generator Properties
You can use the clone feature to copy the properties of an existing generator entity and use
those properties as the baseline for multiple generators. The clone feature can help you
define several similar generators quickly.

1. On theGenerators tab, select the generator you want to use as the baseline for another
generator.

2. Click Clone to create a new generator based on a selected entity. Many fields are copied
from the selected generator. The fields which are not copied have an information icon to
indicate where you need to enter data, as follows:

• Name - Enter a unique name to identify the generator.

• Electrical Data -Source - Select a source name from the dropdown list. The source
represents the device that records the electrical data from the generator.

• Status Measurements -Source - Select a source name. The source represents the
metering device that records the status of a generator.

For information about other generator properties, see "Edit Generator Properties" on page
43.



Edit Evaluation Method
TheEvaluation Method editor is used to select the evaluationmethod and the respective
pass/fail criteria that you want to use when evaluating a generator.

1. Click Edit Evaluation Method to open theEdit Evaluation Method editor.

2. Complete the following to set up evaluation criteria for a generator:

• Evaluation Method - Select an evaluationmethod. For Load Bank, you can select
from one to three stages to include in the evaluation. If you select Load Bank, the
Generator Load Summary section of the EPSS Test Report shows the details of the
selected stages of the load bank test. The stages are represented on the graph. The
table below describes the evaluationmethods.

• Number of Stages - Select the number of stages for the evaluation if you selected
Load Bank.

• Suggested Load % orMinimum Exhaust Gas Temperature - Depending on the
evaluationmethod that you selected, enter a numerical value for the percentage or for
the temperature.

• Run Duration (Minutes) - Enter theminimum number of minutes that the test needs to
run for evaluation purposes.

3. Click OK to save the evaluation criteria and return to theGenerators tab.
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The evaluationmethods and their respective pass/fail criteria are listed in the following table.
Load is the default evaluationmethod.

Evaluation Method Pass/Fail Criteria

Load The generator must run at an electrical load%that is equal to or
greater than themanufacturer's suggested electrical load%for
the run duration.

Engine Temperature The generator must run at an engine temperature that is less
than or equal to the engine temperature for the duration.

Exhaust GasTemperature The generator must run at an exhaust gas temperature that is
equal to or greater than themanufacturer's suggested exhaust
gas temperature for the run duration.

Load Bank The generator must pass the stages selected for the electrical
load bank test. If more than one stage is selected, the generator
must passeach stage consecutively.

LoadOR Engine Temperature The generator must passeither the electrical load or the engine
temperature test.

LoadOR Exhaust GasTemperature The generator must passeither the electrical load or the exhaust
gas test.

Load AND Exhaust GasTemperature The generator must passboth the electrical load and the exhaust
gas test.

Load AND Engine Temperature The generator must passboth the electrical load and the engine
temperature test.

LoadOR Engine Temperature OR Exhaust
GasTemperature

The generator must passeither the electrical load or the exhaust
gas test or the exhaust gas test.

LoadOR Engine Temperature AND Exhaust
GasTemperature

The generator must passeither the electrical load or the engine
temperature test and the exhaust gas temperature test.

Load AND Engine Temperature OR Exhaust
GasTemperature

The generator must passboth the electrical load and the engine
temperature test OR the exhaust gas temperature test.

Load AND Engine Temperature AND
Exhaust GasTemperature

The generator must passboth the electrical load and the engine
temperature test and the exhaust gas temperature test.

You can edit the test criteria for a test method by selecting the test name and then updating
its criteria. The following table shows the default test criteria for each evaluationmethod.
Confirm that these values meet the regulations mandated by local jurisdictions, or meet the
minimum values recommended by themanufacturer, and update them if necessary.

Test Name Stage Minimum Run Duration

Load 1 30% 30minutes

Engine Temperature 1 140 F 30minutes

Exhaust GasTemperature 1 900 F 30minutes

Load Bank 1 25% 30minutes

Load Bank 2 50% 30minutes

Load Bank 3 75% 60minutes



Edit Engine Data
TheEngine Data Measurements editor is used to define engine data values and other
custom data values for generators. The items beingmeasured, typically analog data, can
differ from generator to generator. Battery voltage and coolant temperature are two common
measurements.

If you want to use the Smart Device Data Collector to log generator data, add the engine data
values you need. These values can also be reported on the Trend Report, Tabular Report,
EPSS Test Report, and dashboard gadgets.

Follow these steps to add engine data values and other custom data values.

1. Click Edit Engine Data to open theEdit Engine Data Measurements editor.

2. Click New to enable the input fields.

3. Complete the following to define new data values:

• Name - Enter a name for the data value.

• Units - Enter a unit of measure for the data value.

4. Click OK to save the new data value and return to theGenerators tab.

Next, assign these data values to generator measurements. See "Assign Engine Data" on
page 49 for instructions.

Assign Engine Data
TheEngine Data Measurement editor is used to associate engine data values with specific
generator measurements. See "Edit Engine Data" on page 49 for instructions to define
custom engine data values.

1. Click Assign Engine Data to open theAssign Engine Data Measurement editor.

Power Monitoring Expert 8.1 ApplicationModules
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2. Click New.

3. Complete these fields to associate a data value with a specific measurement:

• Engine Data Measurement - Select the data value. The dropdown list contains all of
the data values that were configured on the Edit Engine DataMeasurements screen. 

• Source - Select the device name that records the generator data.

• Measurement - Select themeasurement for the data value.

• Data Collector - Check this option to enable users to enter measurement data through
the Smart Device Data Collector web tool. See "Smart Device Data Collector" on page
77. This data can also be included in the EPSS Test Report.

4. Click OK to save your changes and return to theGenerators tab.



Define Transfer Switches for EPSS
Use the Transfer Switches tab to configure the automatic transfer switch entities in the
system. Complete this tab when you are configuring the EPSS Test Report.

You can perform the following actions on this tab:

• Click New to create a transfer switch entry and to define specific values for it. See "Edit
Transfer Switch Properties" on page 52 for instructions.

• Click Clone to define a new transfer switch that is similar to an existing entry. The
system copies many details of the existing device into the new entry. You can then enter
the unique details of the new device. If you need to define several devices that are similar,
this feature can help you define them quickly. For more information, see "Clone Transfer
Switches" on page 53.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.
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• Click Edit Priority Levels to open thePriority Levels editor. TheEdit Priority Levels
editor is used to select at least one priority level that you want to apply to your transfer
switches. See "Edit Priority Levels" on page 54 for instructions.

Edit Transfer Switch Properties
TheEdit Transfer Switch area on the tab is used to create a transfer switch entry and to
define specific values for it.

1. Click New to create a transfer switch entity.
2. Complete the following to define a transfer switch.

• Name - Enter a unique name to identify the transfer switch.

• Description - optional. Enter other information that you want to use to identify the
transfer switch.

• Load Data - Check this box if you want to generate the Equipment Capacity
Management Report for the ATS.

• Source - Select ameter source that is recording electrical data from the
ATS.

• Measurement - Select the electrical measurement item you want to track
when the report is generated, such as Current Phase Average.

• Rating - Enter the rating value for themeasurement, such as 400.

• Unit - Enter the unit of measurement, such as A.

• Priority Level - Select a priority level from the dropdown list. You need to assign a
priority level to each transfer switch. After you assign a priority level, the required
transfer time for it appears under the dropdown list.

• Status Measurements - Configure the states used to record the status of the ATS.
When a transfer switch is in one of the states, the active value is stored in the
measurement. The states appear in theEvents Summary section of the EPSS Test
Report.

• Data Collector - Check this option to enable users to enter measurement
data through the Smart Device Data Collector web tool. See "Smart
Device Data Collector" on page 77. This data can also be included in the
EPSS Test Report.

• Source - Select a source name. The source represents the device that
records the status of a transfer switch.

• Normal - The ATS is in the Normal position and power is supplied to the
load from the utility. Select themeasurement that provides the input
indicating that the ATS is in theNormal state, and then enter the active
value for themeasurement.

• Test - The ATS is in the Test mode. Select themeasurement that
provides the input indicating that the ATS is in the Test state, and then
enter the active value for themeasurement.



• Emergency - The ATS is in the Emergency position and power is
supplied to the load from the generator. Select themeasurement that
provides the input indicating that the ATS is in theEmergency state, and
then enter the active value for themeasurement.

• Monitor for Power Outage - If you aremonitoring utility power, select
this option. Select themeasurement that indicates a power outage
occurred and enter theActive Value for themeasurement.

The active value for themeasurements can be any value you choose.

For example, assume that the system has measurements called EPSS_Norm, EPSS_
Test, EPSS_Emerg, and EPSS_Util. You assign thesemeasurements to theNormal,
Test, Emergency, andPower Outage states and enter 1 as the active value for each.

When the ATS is in the Normal position, the active value for EPSS_Norm is 1, and
Normal is the state for the ATS. When the ATS is set to the Test mode, the active value
for EPSS_Test is 1, and Test is the state for the ATS. When the ATS is in the
Emergency position, the active value for EPSS_Emerg is 1, andEmergency is the state
for the ATS. If a power outage occurs, the active value for EPSS_Util is 1, andPower
Outage is the state for the ATS.

In the EPSS Test Report, the states for the ATS and the time when they occurred are
included in the Events Summary section.

In the Automatic Transfer Switch Summary section of the report, the states are used to
derive the Transfer Time and In Emergency time:

• Transfer Time - The duration (in seconds) to switch to theEmergency state. For Test
mode, the Transfer Time is the time to switch from theNormal state to theEmergency
state once the test signal has been received. When an actual power outage occurs, the
Transfer Time is the time to switch from theNormal state to theEmergency state
once the power outage signal has been received.

• In Emergency - The duration (in hours, minutes, and seconds) the ATS receives power
from the generators. This is the time between theEmergency state and theNormal
state.

3. Click Apply to save the changes and remain on the tab.

4. Repeat these steps to define other transfer switches.

5. If you are defining several similar transfer switches, use theClone button. See "Clone
Transfer Switches" on page 53.

Clone Transfer Switches
You can use the clone feature to copy the properties of an existing transfer switch entity and
use those properties as the baseline for multiple transfer switches. The clone feature can
help you define several similar transfer switches quickly.

1. On the Transfer Switches tab, select the transfer switch you want to use as the baseline
for another transfer switch.

2. Click Clone to create a new transfer switch based on a selected entity. Many fields are
copied from the selected transfer switch. The fields which are not copied have an
information icon to indicate where you need to enter data, as follows:

• Name - Enter a unique name to identify the generator.
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• Status Measurements -Source - Select a source name.

For information about other transfer switch properties, see "Edit Priority Levels" on page
54.

3. Click Apply to save the new transfer switch entity.

Edit Priority Levels
TheEdit Priority Levels editor is used to select at least one priority level that you want to
apply to your transfer switches.

1. Click Edit Priority Levels to open theEdit Priority Levels editor.

2. Click New to add a priority level.

3. Complete the following to define priority levels:

• Name - Enter a unique name to identify the priority level.

• Required Transfer Time (Seconds) - Enter the transfer time in seconds. This value
indicates themaximum acceptable time for the ATS to switch from the Test state to the
Emergency state.

• Evaluate this Priority Level when reporting on Power Outages - Select this check
box to include a priority level in the pass or fail grading. Clear the check box to exclude
the priority level from grading. By excluding a priority level, you can exclude non-critical
switches from evaluation.

For example, if a transfer switch has a priority level of Life Safety and it must be graded
as a result of a power outage, then select this check box. Conversely, if a transfer
switch has a priority level of Equipment, this transfer switchmay not have to be graded
as a result of a power outage. In this case, clear the check box.

• Color Picker - Select the color that the priority level detail will appear in the test report.

Default priority levels are shown in the following table. You can change any of these to a
priority level scheme of your choice.



Name Required Transfer Time Power Outage Enabled
Life Safety 10 True
Critical 10 True
Equipment 30 False

4. Click OK to save the priority level and return to the Transfer Switch tab.

Define Equipment for EPSS
Use theEquipment tab to create a logical device with a sourcemeasurement and rating.
You can add these logical devices to device groups for reporting. Complete this tab when
you are configuring reports.

You can perform the following actions on this tab:

• Click New to enter new record for a device. See "Edit Equipment Sources" on page 56 for
instructions to define the devices.

• Click Clone to copy an existing record andmakeminor changes. The system copies
many details of the existing device into the new entry. You can then enter the unique
details of the new device. If you need to define several devices that are similar, this
feature can help you define them quickly.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.
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Edit Equipment Sources
TheEquipment tab displays the equipment load sources andmeasurements defined in the
system.

1. Click New to create a record.
2. Complete these fields:

• Name - Enter a unique name to identify the record.

• Description - Enter additional information about the device. Optional.

• Source - Select the load source for the device.

• Measurement - Select themeasurement for the device.

• Rating - Enter themaximum rated load for the device.

• Unit - Enter the unit of themeasurement.

3. Click Apply to save the record and remain on the tab.

4. Repeat these steps to enter additional devices.

Define Groups for EPSS
A performance group is a combination of generators, transfer switches, and other equipment
for reporting and generating Vista diagrams. Complete theGroups tab when you are
configuring reports.



You can perform the following actions on this tab:

• Click New to create a new group for generating reports and Vista diagrams. A group can
contain any device that has been configured on the other tabs. See "Edit Groups" on page
58 for instructions to define the groups.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.

• Click theEdit Load Sources to associate a group with the electrical loads that the group
of generators must carry in a power outage. See "Edit Group Load Sources" on page 59 for
instructions.

• Click Generate Vista Diagrams to generate the frameworks for the EPSS groups. You
can select which groups to include in the diagrams. See "Generate EPSS Vista
Diagrams" on page 63 for instructions.
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Edit Groups
TheGroups tab displays the device groups defined in the system. The generators, and
transfer switches, and other equipment must be defined on their respective tabs before you
can add them to a group.

1. Click New to create a group.
2. Complete the following to define the values for a group:

• Name - Enter a unique name to identify the group.

• Test Frequency - Select the frequency, in days, that the group should be tested. Refer
to local regulations for an appropriate value.

• Generators - Select the generators to include in the group.

• Equipment - Select the equipment to include in the group.

• Transfer Switches - Select transfer switches to include in the group.

TheSelect All andSelect None options let you work easily with large numbers of
sources by selecting all check boxes or clearing all check boxes at the same time.

3. Click Apply to save the group and remain on the tab.

4. Repeat these steps to create other groups.

Edit Group Priority Levels
The following reports use priority levels:

• Generator Capacity Report – Priority level values are required to accurately display the
colors indicated in the priority levels.

• EPSS Test Report – Priority level values are required for the ATSs in the system to
PASS or FAIL an ATS based on the required transfer time of the priority level.

Default priority levels are setup as default.

TheEdit Priority Levels editor is used to select at least one priority level that you want to
apply to the equipment groups. The default priority level names and transfer times are:

• Critical - 10 sec

• Equipment - 30 sec

• Life Safety - 10 sec

You can change any of these names and transfer times and add new priority levels as
necessary.

1. Click Edit Priority Levels. ThePriority Levels screen appears.



2. Click New to add a priority level.

3. Complete the following to define priority levels:

• Name - Enter a unique name to identify the priority level.

• Required Transfer Time (Seconds) - Enter the transfer time in seconds. This time
indicates themaximum acceptable time it takes the equipment to move from the Test
state to theEmergency state.

• Color - Click the color box to select a color for the priority level. This color appears on
the Generator Capacity Report summary page, where the generator loads are
compared.

4. Click OK to save the priority level and return to theGroups tab.

Edit Group Load Sources
On theSelect Load Sources screen , you can associate a group with the various electrical
loads that the group of generators must carry during a power outage.

Be sure to define the priority levels for the system before you configure load sources. See
"Edit Priority Levels" on page 54 for instructions.

1. Click Edit Load Sources. TheEdit Load Sources screen appears.
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2. Click New to add a load source.

3. Complete these fields:

• Source - Select themeasurement source.

• Measurement - Select themeasurement to monitor.

• Priority Level - Select the priority level to assign to the load source.

4. Click OK to save the new load source and return to theGroups tab.

You can use theClone button to associate a group with several sources where the load
is logged against the samemeasurement. The cloned group contains the same
measurement and priority level as the original.

View Run History for EPSS
Use theRun History tab to view ormodify run activities that represent the Test, Load
Shedding, and Power Outage activities that have occurred in the system. The history
indicates when components of the EPSS have become active, such as when a generator
was running or when a transfer switch entered test or emergency status. The runs stored in
history can be used as input for reports and dashboards in PowerMonitoring Expert.

Because the system stores the history of these activities, you can generate useful reports
about the equipment operation. The reports can identify when the system was active, why
the system was active, and what devices were active.



The first time the history records are generated on theRun History tab, the systemmay
take a long time depending on the amount of history present in the system. When changes
occur in the EPSSconfiguration, the run history must be generated again.

For example if you remove a generator from a group, the run history for that group needs to be
rebuilt because that generator may have been the reason for the detection of a run. Now that
the generator is not part of the group, the system needs to build the run history again to have
accurate data.

You can perform the following actions on this tab:

• Click Detection Options to modify the criteria of a run event that will cause it to appear
on this tab. See "Modify Run Detection Options" on page 62.

• Click Refresh Run History to update the tab with the latest run events that have
occurred in the system.

• Click Delete Run History to remove all run event records from the tab.

• Modify the name and run reason for a run event. See "Modify Run Details" on page 62.
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Modify Run Detection Options
The run detection options can be defined to help guard against bad data in the system. To
record actual run activities, you can set the parameters so the system only records runs that
fall within the criteria.

Theminimum run length value is present to prevent false positives, whichmay occur during
commissioning when the states of the generators and transfers switches are changing
quickly and seemingly at random. This may be due to signals being recorded that really do
not reflect actual generator or transfer switch activity.

You can set themaximum run length to eliminate "hanging" runs. A hanging run occurs when
the stop signal for a generator is not recorded properly. As a result, every time during the test
it records a running signal but there is no way for the system to know when it stops. If the
system does not see a stop signal, it sets the end of the run to be the start of the run plus the
maximum run duration. Therefore you cannot determine how long the generator was actually
running.

Complete the following steps to define the run criteria for the system to store runs in history.

1. Click Detection Options. TheRun Detection Options screen appears.

2. Change the values in theminimum andmaximum fields.

3. Click OK to save the changes and return to theRuns tab.

4. Click Refresh to update the tab with the run events that match the new detection criteria.

Modify Run Details
The system defines run data, such as name, start time, end time, reason, and active sources
automatically. You can change the name of the run event and the reason for the run.

• The default run name is the start date of the run, such as June 12 2011. If a group has
multiple runs on the same date, the subsequent runs have the same date with the run
number appended, such as June 12 2011 Run 2 and June 12 2011 Run 3.

• The system automatically detects the reason for the run. If the detected reason is
incorrect, you can change the reason. For example, the reason appears as Test, but the
run is actually Load Shedding.

Other details about the run event cannot bemodified directly. If the sources for a run are not
correct, you can exclude or include specific sources when generating a report based on this
run.

1. Click the run record you want to modify. The run details appear below the grid.



2. In theName field, change the suggested run name as necessary.

3. In theReason list, select the correct reason for the run.

4. Click OK to save the changes for the run.

Generate EPSS Vista Diagrams
After the generators, transfer switches, and device groups are configured, you can generate
the Vista diagrams for the configured devices. The same information can be built manually in
Vista , but the Generator Performance Configuration Tool with EPSS Test Module provides a
way to build these diagrams automatically. Vista diagrams help provide you with real time
insight into the system.

See "Set up the Template Diagram" on page 63 and "Generate EPSS Diagrams" on page 64
for instructions.

After the diagrams are generated, you can open them in Vista or Designer and optimize the
designs. See "Vista Diagram Examples" on page 65 for descriptions and examples of the
generated diagrams.

EPSS Vista diagrams are useful to the customer so they can see real-time information about
the status of the generators, transfer switches, and other components of the system. The
diagrams can include the customer logo and amap of the customer's facility. The customer
can view the diagrams in the Diagrams module of PowerMonitoring Expert after the
diagrams have been linked to the Diagrams module.

The system includes a template that you can use to set up certain parts of the diagrams
before you generate them.

Set up the Template Diagram
The template diagram allows you to produce a consistent structure for the generated
diagrams. The template file is used as a basis for the dynamically generated EPSS
diagrams. The template is a normal diagram file that the system uses to apply common
elements to the generated diagrams.

With the template, you can apply linked-button elements to the generated diagrams, which
will help you reduce the amount of time to configure the diagrams.

Follow these steps to set up the diagram template.

1. Open the Vista Diagrams application.
2. Open the Epss_Template.dgm file in the folder:

...\config\diagrams\ud\EPSS\templates

3. To the left side of the diagram, add the buttons with the appropriate links.

4. Do not link the EPSS button to any diagram, because you will already be on the EPSS
pages when they are generated.

5. Save and close the template diagram.
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When diagrams are being generated by the configuration tool, the template is read in and any
objects on the diagram will be added to every diagram created by the tool.

NOTE:On the generated diagrams, the background image is dynamically created. The back-
ground does not come from the EPSS template diagram.

Generate EPSS Diagrams
Before you generate the EPSS Vista diagrams, make sure all devices and groups are
configured correctly. Save the changes you havemade to the EPSS configuration.

1. Click theGroups tab.
2. Click Generate Vista Diagrams. The Vista Diagram Generation screen appears.

3. In theOutput Path field, enter or select the folder where you want to store the diagrams.

4. (Optional) In the Included EPSS Groups box, select the device groups that you want to
generate diagrams for. Uncheck any groups you do not want to generate.

5. (Optional) In the Transfer Switch Options box, select the colors you want to use for
normal and emergency status.

6. (Optional) Check the Include Test Button on Transfer Switches option if you want to
add a control object for each ATS on the diagrams. This object allows you tomanually test
the ATS from the diagram. The control must bemanually linked using Vista once the
diagrams have been created.

7. (Optional) Check the Include Links to EPSS Groups... option if you want the device
diagrams to have a link to the EPSS Group diagram.

8. In theDiagram Width field, select the horizontal width in pixels of the diagrams.



9. Select Facility Logo and enter the image file if you want the diagrams to include the
customer logo at the top-left of every diagram.

10.Select Generate Facility Map if you want to include amapwith the diagrams. If you do
this, you will be able to add the generator and transfer switch device locations to themap.

• Enter the Facility Name to appear on themap.

• Select the image file for themap.

11.Click Generate Vista Diagrams to generate and store the diagrams in the selected
output folder.

Several diagrams will be created: the homepage that lists all EPSS groups, summary pages
that list all generators and transfer switches, and the detail pages for each EPSS Group,
Generator and ATS in the system.

You can open the diagrams in Vista and optimize the designs if necessary. Refer to
ION Reference for information about configuring themodules in the diagram. 

See the next section"Vista Diagram Examples" on page 65 for descriptions and examples of
the generated diagrams.

Vista Diagram Examples
When you generate the Vista diagrams, several diagrams are produced.

• Home Page diagram - One HomePage diagram is generated. This diagram contains a
navigation bar that has links for the facility map, device group diagrams, and device
diagrams.

• Group diagrams - For each group selected on the configuration screen, one group
diagram is produced. This diagram contains an object for each generator or transfer switch
in the group. A Oneline diagram for each device group is also generated and linked to the
diagrams. You will need tomanually configure the generated Oneline diagrams. Several
default objects are included for assistance.

• Device detail diagrams - For each generator and transfer switch in a group, a diagram is
generated. The device diagram includes status information for the device, including run
status, test parameters, and real-time electrical data.

• Facility Map - This diagram is generated if the option was selected on the configuration
screen. This diagram includes amoveable icon for each generator and transfer switch in
all the selected device groups. On themap diagram, you can drag and drop the device
icons to themap to represent the physical locations of those devices.
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Home Page Diagram

EPSS Group Diagram



Device Diagram

Facility Map
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EPSS Test Report
The EPSS Test Report shows the run details and overall status for generators and transfer
switches in the group. For example, the report shows the transfer time of the lead ATS and
indicates whether the transfer time passes or does not pass the test requirements.

Use the Reports module inWeb Applications to configure and generate the EPSS Test
Report.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.

Report Prerequisites
In the Generator Performance Configuration Tool with EPSS Test Module, define the
following tabs and fields in order to generate the report.

Generators Tab
• Name - Enter a name for the generator entity.

• Electrical Data - Enter themeasurement source, nameplate rating, and unit of
measurement.

• Status Measurements - Enter the source of the status measurement and the start, run,
and stop values. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but you can change this to accommodate
customer requirements.

See "Define Generators for EPSS" on page 42 for instructions on the above settings.

Transfer Switches Tab
• Name - Enter a name for the ATS entity.

• Status Measurements - Select the source of the status measurement and the start, run,
and stop values. Configure themeters that provide thesemeasurements.

• Priority Levels - Default levels are provided, however you can change these levels to
accommodate customer requirements.

See "Define Transfer Switches for EPSS" on page 51 for instructions on the above
settings.

Groups Tab
• Name - Enter a name for the group entity.

• Select at least one entity from theGenerators, Transfer Switches, orEquipment lists.
The group can contain entities from each list combined.

See "Define Groups for EPSS" on page 56 for instructions.

After these required items are defined, the report can be configured and generated, as
described next.



EPSS Test Report Example
The following images are examples of various sections of an EPSS Test Report in the order
in which they occur.

Title Page

The title page of the test report shows the title, company name, group, the name of the
person preparing the report, and the test period.

Sources

TheSources section shows the devices in the selected group.
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Events Summary

TheEvents Summary section shows the status of the generators and transfer switches in
the group.

Automatic Transfer Switch Summary

TheAutomatic Transfer Switch Summary section includes sections for the Lead ATS,
the Time to Emergency Power Source Available, andAll Automatic Transfer Switches
in the group.



Generator Summary

TheGenerator Summary section shows the evaluationmethod is being used to determine
the status of the generator being tested.

This example shows the Load Bank evaluationmethod was used on the generator.

Generator Load Summary

TheGenerator Load Summary section shows a chart of the electrical load data for the
generator being tested.
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This is an example showing the Load Bank evaluationmethod was used.

Longest Continuous Load

This section includes a table summarizing theminimum, average, andmaximum electrical
readings for the longest continuous load by load bank stages. The following images show
data for each stage of the load bank test.



Generator Engine Temperature Summary

This example shows the Load AND Engine Temperature AND Exhaust Gas Temperature
evaluationmethod used on the generator.

This section also includes a chart of the engine temperature readings for the longest
continuous load and a table summarizing theminimum, average, andmaximum engine
temperature readings for the longest continuous load.
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Generator Engine Temperature Details

This section shows summarized engine temperature details by time intervals.



Generator Exhaust Gas Summary

This section shows a chart of the exhaust gas temperature data.

Generator Exhaust Gas Details

This section shows summarized exhaust gas temperature details by time intervals.
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Generator Electrical Details

This section shows summarized electrical details by time intervals.

Generator Engine Details

This section shows engine parameter details, such as battery voltage and oil pressure
readings.



Smart Device Data Collector
If the installation includes the EPSS, the Smart Device Data Collector is available. The
Smart Device Data Collector is a web tool where you canmanage your facility data,
including:

• Record ATS load transfer data into PowerMonitoring Expert for reporting and analysis.
This web tool replaces the paper and spreadsheet method of recording ATS testing data.

• Log standard data for a generator, including battery voltage, coolant temperature, and oil
pressure. This feature helps you enter more complete data so reports and analysis are
more accurate.

• Log data for custom data values, such as for generator maintenance and cleaning tasks.

PowerMonitoring Expert includes several reports that display transfer switch data and
generator data submitted through the Smart Device Data Collector, including EPSS Test
Report, Generator Test Report, Tabular Report, Trending Gadget, and Trending Report. The
next section explains how tomake sure submitted data appears in the reports and gadgets.

NOTE: The Smart Device Data Collector cannot be used to log data to PowerMonitoring
Expert until generators and ATS equipment have been set up in the Generator Performance
Configuration Tool.

Generator and ATS Data Workflow
NOTE: Data Collector can receive data from EPSS and generator systems. Depending on
your system, you will need to configure your system using either the Generator Performance
Configuration Tool or Generator Performance Configuration Tool with EPSS Test Module.

Data submitted through Smart Device Data Collector can be included in various reports and
gadgets:

• EPSS or generator related data submitted through Data Collector can be included in the
EPSS or Generator Test Report and show the Run record in the Run History.

• Non-EPSS or non-generator data can be included in other reports: Tabular Report and
Trending Report.

Follow these steps to configure generators and ATS entities in the Generator Performance
Configuration Tool to work with the Smart Device Data Collector tool.

1. Set up the generator meter in Management Console. See thePowerMonitoring Expert
User Guide for instructions to add and configuremeters in Management Console.

2. Add the generator entity in the Generator Performance Configuration Tool or Generator
Performance Configuration Tool with EPSS Test Module. Note the following:

• TheStarting, Running, andStopped state values for the generator must be defined.

3. On theGenerators tab, click Edit Engine Data. On the Engine DataMeasurements
screen, add the custom data values you want to log and report on.
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4. Save the new data values and return to theGenerators tab.

5. Click Assign Engine Data. On the Assign Engine Data screen, configure the
measurement for each of the data values. Note the following:

• Source - Select the generator source.

• Measurement - Select ameasurement with a name that begins with: WAGES External
Input 1.

• Data Collector - Check this option for the data value.

6. Save the data assignments and return to theGenerators tab.

7. For the ATS data, make sure theData Collector option is checked in the ATS properties.
See "Define Transfer Switches for EPSS" on page 51 and note the following:

• TheNormal, Test, andEmergency state values for the ATS must be defined.

8. Verify the generator or ATS entities are included in a group on theGroups tab.

9. Login to the Smart Device Data Collector.

10.Enter and submit the generator or ATS data. See "LogGenerator Data" on page 85.

11.Enter and submit the ATS test data. See "Log Data for ATS Load Transfer Tests" on page
81.

12.Login to PowerMonitoring Expert and view the data in reports and gadgets:

• EPSS or Generator Test Report - See "EPSS Test Report" on page 68."EPSS Test
Report" on page 68

• Tabular Report - See thePowerMonitoring Expert Help for instructions.

• Trending Report - See thePowerMonitoring Expert Help for instructions.

• Trending Gadget - See the gadget online help for instructions.

Start the Smart Device Data Collector
You can use any of these devices to open the Smart Device Data Collector.

• iOS(iPhone/iPad)

• Blackberry

• Android Phone/Tablet

• PC/laptop

The web tool can be accessed remotely at this URL:

http://<server_name>/DataCollector

A link to the web tool is also provided in the PowerMonitoring Expert programs folderStart >
All Programs > Schneider Electric:



The Smart Device Data Collector uses the same login credentials as PowerMonitoring
Expert. It can only be accessed by users with the Controller, Operator, or Supervisor access
level.

1. Go to the URL in a browser or use the shortcut in the programs folder. The sign in screen
appears.

Power Monitoring Expert 8.1 ApplicationModules
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2. Enter your login credentials. Themain screen appears.

Themain screen contains theSelect Group box (for generator groups, ATS groups, other
equipment groups) and theSelect Equipment box for a device in the selected group.

An error message appears if you do not have the correct access level or
you enter the wrong credentials.

The selection boxes are empty if the generators or ATS equipment have not enabled the
Smart Device Data Collector option in the configuration tool.

To view the online help or sign out of the tool, click themenu button.



Log Data for ATS Load Transfer Tests
When you test the ATS for generator load transfer, use the Smart Device Data Collector to
mimic the ATS test sequence and store test data. This data can be compared to the ATS and
generator settings configured in Generator Performance Configuration Tool with EPSS Test
Module.

NOTE: This feature of the web tool is only available for installations that include the EPSS
ordering option.

NOTE: In the configuration tool, verify theData Collector option is enabled for the ATS you
want to test. You can verify this in the Transfer Switches tab. See "Edit Transfer Switch
Properties" on page 52 for instructions.

Follow these steps to perform the ATS test:

1. In the first two selection boxes, select the group and the ATS you want to evaluate.
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2. At the ATS control panel, start the test to power up the generator. Then, in the Smart
Device Data Collector, click Test Start. This sets the start time of the ATS test.



3. Review the generator meter reading. When the load has transferred and the load threshold
is reached, click Load Transfer. This sets the time the ATS transferred the load from
utility to generator.

4. After the generator runs for the typical test duration, change the ATS back to normal
operation.
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5. Click Test End. This sets the stop time for the test.

6. Evaluate the test data in theResult box.

• Transfer Time – This is the difference between Load Transfer and Test Start.

• Test Time – This is the duration the generator carried the load.

7. Reset the test or submit results.

• Click Reset if you want to discard the test data.

• Click Submitwhen you are ready to submit data to the data server for logging. Green
check marks appear in theResult box when data is sent successfully.

ATS timestamps are displayed in server time, submitted ATS states are entered in the
database in UTC timestamp. The collected data will be logged to the database against
configured group’s sources andmeasurements. This data appears as a run in the run history.



Log Generator Data
When you need to enter generator data into PowerMonitoring Expert, you can use the Smart
Device Data Collector to submit the data.

NOTE: In the Generator Performance Configuration Tool, verify theData Collector option is
enabled for the generator you want to log data for. See "Assign Engine Data" on page 49 for
instructions. The custom data values you create in the configuration tool will appear in the
web tool.

Follow these steps to log generator data:

1. In the first two boxes, select the group and specific generator you want to log data for.
The custom data value fields, such as Battery Volts, for the generator appear.

NOTE: The data value fields are the data values added in the configuration tool. For each
data value, there is a value entry box and a date box.

2. For each data value, enter the new data in the box.
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• Click Set to set the timestamp for the new data.

• If you want to edit the timestamp value, click Edit and enter the value. All date fields in
use theMM/DD/YYYY format.

3. Click Submit to log the new data.

When the data has been successfully logged, the field borders turn green and a green
check mark appears. The submitted timestamp is in server time. In PowerMonitoring
Expert, the data is logged in UTC.



An error message appears if a field is blank or has data with invalid format, as shown in
these examples. Data with the incorrect format or blanks do not get stored in Power
Monitoring Expert.

4. To edit the data after you click Submit, click Edit and the fields become editable again.

5. Click Clear if you want to clear all the fields.

You can select other groups and devices to submit additional data.
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Generator Performance

To configure Generator Performance:

1. Obtain and install a license for the Generator Performancemodule.

2. Set up the installed ION meters, including ATS and generator frameworks. See
"ION PowerMeter Configuration" on page 179 for details.

NOTE: Transfer Switches and Automatic Transfer Switches (ATS) does not apply to data
centers. Even though ATS appears in the configuration tool and reports, you can ignore all ref-
erences to ATS when configuring a data center facility.

3. Set up the installed non-ION meters, including digital and analog outputs. See "Non-ION
PowerMeter Configuration" on page 201 for details.

4. Set up reporting entities in the configuration tool. See "Generator Performance
Configuration Tool" on page 89. If your system includes the "Emergency Power Supply
System (EPSS)" on page 34, see "Generator Performance Configuration Tool with EPSS
Test Module" on page 39.

5. Configure and run the Generator Performance reports.



Generator Performance Configuration Tool
Use theGenerator Performance Configuration Tool to configure the generators and other
equipment for reporting the data and status of the power system.

If your installation includes the Emergency Power Supply System (EPSS), see
"Generator Performance Configuration Tool with EPSS Test Module" on page 39.

Prerequisites
• Before opening the configuration tool, make sure the sources - which represent metering

devices - are added inManagement Console and they are communicating.

Start the Generator Performance Configuration Tool
To start the Generator Performance Configuration Tool, open the PowerMonitoring Expert
folder on the desktop and double-click the Generator Performance Configuration Tool
shortcut.

TheGenerator Performance Configuration Tool window contains these tabs: Groups,
Generators, Transfer Switches, Equipment, andRun History. On these tabs, you create
the entities and groups for equipment in the system. You also view data for prior test runs.
The tabs contain a grid area and an editor area, as shown next. The grid area is initially empty
but it will be populated with entries that you create through the editor area. Use the editor area
to define the settings for new items, or to update the settings for an item that you select in the
grid area.
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When you first use the configuration tool, you need to define generators and equipment on
the applicable tabs. After you do this, define the device groups on theGroups tab.

NOTE: In order to use the reports, youmust define the device groups on theGroups tab.

Use the following tabs to configure the tool:

• Groups tab - "Define Groups" on page 95

• Generators tab - "Define Generators" on page 91

• Transfer Switches tab - Define, describe and configure the transfer switches.

• Equipment tab - "Define Equipment" on page 93

• Run History tab -"View RunHistory" on page 98

Use the following common controls for the tabs:

• Help - Click this to view online help for the tab.

• New - Creates a new entry in the grid.

• Delete - Deletes the selected entry from the grid.

• Revert - Returns amodified record to its original values, if OK orApply have not been
clicked.

• OK - Saves all changes and exits the configuration tool.

• Cancel - Exits the tool without saving changes.

• Apply - Saves all changes and leaves the tool open.



TheModified column in the grid area shows the status of the row data:

+ (plus) - a new entry.

* (asterisk) - a modified entry.

! (exclamationmark) - entry needs more information before it can be saved.

Define Generators
Use theGenerators tab to create or update entities representing the generators in the power
supply system. Complete this tab if you need to produce reports for generators.

You can perform the following actions on this tab:

• Click New to define the properties of the generators in the system. See "Edit Generator
Properties" on page 92.

• Click Clone to define a new generator that is similar to an existing generator. The system
copies many details of the existing device into the new entry. You can then enter the
unique details of the new device. If you need to define several devices that are similar,
this feature can help you define them quickly. See "CloneGenerator Properties" on page
92.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.

Power Monitoring Expert 8.1 ApplicationModules
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Edit Generator Properties
TheEdit Generator area on the tab is used to create a generator entry and to define specific
values for it.

1. On theGenerator tab, click New.
2. Complete the following fields to define a generator.

• Name - Enter a unique name to identify the generator.

• Description (Optional) - You can add specific information about the generator, such as
make andmodel.

• Electrical Data

• Source - Select a source name. The source represents the device that
records the electrical data from the generator.

• Prime Nameplate Rating - Enter themaximum power load for the
generator. Refer to the generator's nameplate for this value.

• Unit - Select the unit of measurement for the power load.

• Battery Waveform (Optional) - Use this area to if you want to configure and generate
the Battery Health Report. To enable the report, check the box and complete these
fields:

• Source - Select a source name that is performing the waveform capture.
This option is available for ION 7550 and ION 7650meters.

• Measurement - Select themeasurement recording the battery waveform.
For a typical configuration, this is the V4 waveform.

Specific frameworks for the battery voltage waveform must
also be configured. See "Generator Battery Health" on page
106 for additional instructions.

• Status Measurements - These fields are not required.

3. Click Apply to save the changes and remain on the tab.

4. Repeat these steps to define other generators.

5. If you are defining several similar generators, use theClone button. See "CloneGenerator
Properties" on page 92.

Clone Generator Properties
You can use the clone feature to copy the properties of an existing generator entity and use
those properties as the baseline for multiple generators. The clone feature can help you
define several similar generators quickly.

1. On theGenerators tab, select the generator you want to use as the baseline for another
generator.

2. Click Clone to create a new generator based on a selected entity. Many fields are copied
from the selected generator. The fields which are not copied have an information icon to
indicate where you need to enter data, as follows:

• Name - Enter a unique name to identify the generator.



• Electrical Data -Source - Select a source name from the dropdown list. The source
represents the device that records the electrical data from the generator.

• Status Measurements -Source - Select a source name. The source represents the
metering device that records the status of a generator.

For information about other generator properties, see the previous section"Edit Generator
Properties" on page 92.

3. Click Apply to save the new generator entity.

Define Equipment
Use theEquipment tab to create a logical device with a sourcemeasurement and rating.
You can add these logical devices to device groups for reporting. Complete this tab if you
need to produce reports for equipment capacity.

You can perform the following actions on this tab:

• Click New to enter new record for a device. See "Edit Equipment Sources" on page 94 for
instructions to define the devices.
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• Click Clone to copy an existing record andmakeminor changes. The system copies
many details of the existing device into the new entry. You can then enter the unique
details of the new device. If you need to define several devices that are similar, this
feature can help you define them quickly.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.

Edit Equipment Sources
TheEquipment tab displays the equipment load sources andmeasurements defined in the
system.

1. Click New to create a record.
2. Complete these fields:

• Name - Enter a unique name to identify the record.

• Description - Enter additional information about the device. Optional.

• Source - Select the load source for the device.

• Measurement - Select themeasurement for the device.

• Rating - Enter themaximum rated load for the device.

• Unit - Enter the unit of themeasurement.

3. Click Apply to save the record and remain on the tab.

4. Repeat these steps to enter additional devices.



Define Groups
A performance group is a combination of generators and other equipment for reporting. The
Groups tabmust be completed before you can configure and produce any reports.
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You can perform the following actions on this tab:

• Click New to create a new group for generating reports. A group can contain any device
that has been configured on the other tabs. See "Edit Groups" on page 96 for instructions
to define the groups.

• Click Delete to remove records from the system.

• Click Revert (before you click Apply orOK) if youmake changes to a record and want to
revert to your initial settings.

• Click Edit Priority Levels to create or modify response times for devices and equipment.
See "Edit Group Priority Levels" on page 97 for instructions.

• Click theEdit Load Sources to associate a group with the electrical loads that the group
of generators must carry in a power outage. See "Edit Group Load Sources" on page 98 for
instructions.

Edit Groups
TheGroups tab displays the device groups defined in the system. The generators and other
equipment must be defined on their respective tabs before you can add them to a group.

1. Click New to create a group.
2. Complete the following to define the values for a group:

• Name - Enter a unique name to identify the group.

• Generators - Select the generators to include in the group.



• Equipment - Select the equipment to include in the group.

TheSelect All andSelect None options let you work easily with large numbers of
sources by selecting all check boxes or clearing all check boxes at the same time.

3. Click Apply to save the group and remain on the tab.

4. Repeat these steps to create other groups.

Edit Group Priority Levels
The following reports use priority levels:

• Generator Capacity Report – Priority level values are required to accurately display the
colors indicated in the priority levels.

• EPSS Test Report – Priority level values are required for the ATSs in the system to
PASS or FAIL an ATS based on the required transfer time of the priority level.

Default priority levels are setup as default.

TheEdit Priority Levels editor is used to select at least one priority level that you want to
apply to the equipment groups. The default priority level names and transfer times are:

• Critical - 10 sec

• Equipment - 30 sec

• Life Safety - 10 sec

You can change any of these names and transfer times and add new priority levels as
necessary.

1. Click Edit Priority Levels. ThePriority Levels screen appears.

2. Click New to add a priority level.

3. Complete the following to define priority levels:

• Name - Enter a unique name to identify the priority level.
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• Required Transfer Time (Seconds) - Enter the transfer time in seconds. This time
indicates themaximum acceptable time it takes the equipment to move from the Test
state to theEmergency state.

• Color - Click the color box to select a color for the priority level. This color appears on
the Generator Capacity Report summary page, where the generator loads are
compared.

4. Click OK to save the priority level and return to theGroups tab.

Edit Group Load Sources
On theEdit Load Sources screen, you can associate an equipment group with the various
electrical loads that the equipment must carry during a power outage.

Define the priority levels for the system before you configure load sources. See "Edit Group
Priority Levels" on page 97 for instructions.

1. Click Edit Load Sources. TheSelect Load Sources screen appears.

2. Click New to add a load source.

3. Complete these fields:

• Source - Select themeasurement source.

• Measurement - Select themeasurement to monitor.

• Priority Level - Select the priority level to assign to the load source.

4. Click OK to save the new load source and return to theGroups tab.

You can use theClone button to associate an equipment group with several sources
where the load is logged against the samemeasurement. The cloned group contains the
samemeasurement and priority level as the original.

View Run History
Use theRun History tab to view ormodify run activities that represent the Test, Load
Shedding, and Power Outage activities that have occurred in the system. The history



indicates when components of the power system have become active, such as when a
generator was running. The runs stored in history can be used as input for reports and
dashboards.

Because the system stores the history of these activities, you can generate useful reports
about the equipment operation. The reports can identify when the system was active, why
the system was active, and what devices were active.
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The first time the history records are generated on theRun History tab, the systemmay
take a long time depending on the amount of history present in the system. When changes
occur in the equipment configuration, the run history must be generated again.

For example if you remove a generator from a group, the run history for that group needs to be
rebuilt because that generator may have been the reason for the detection of a run. Now that
the generator is not part of the group, the system needs to build the run history again to have
accurate data.

You can perform the following actions on this tab:

• Click Detection Options to modify the criteria of a run event that will cause it to appear
on this tab. See "Modify Run Detection Options" on page 100.

• Click Refresh Run History to update the tab with the latest run events that have
occurred in the system.

• Click Delete Run History to remove all run event records from the tab.

• Modify the name and run reason for a run event. See "Modify Run Details" on page 101.

Modify Run Detection Options
The run detection options can be defined to help guard against bad data in the system. To
record actual run activities, you can set the parameters so the system only records runs that
fall within the criteria.



Theminimum run length value is present to prevent false positives, whichmay occur during
commissioning when the states of the generators are changing quickly and seemingly at
random. This may be due to signals being recorded that really do not reflect actual generator
activity.

You can set themaximum run length to eliminate "hanging" runs. A hanging run occurs when
the stop signal for a generator is not recorded properly. As a result, every week during the
test it records a running signal but there is no way for the system to know when it stops. If
the system does not see a stop signal, it sets the end of the run to be the start of the run plus
themaximum run duration. Therefore you cannot determine how long the generator was
actually running.

Complete the following steps to define the run criteria for the system to store runs in history.

1. Click Detection Options. TheRun Detection Options screen appears.

2. Change the values in theminimum andmaximum fields.

3. Click OK to save the changes and return to theRun History tab.

4. Click Refresh to update the tab with the run events that match the new detection criteria.

Modify Run Details
The system defines run data, such as name, start time, end time, reason, and active sources
automatically. You can change the name of the run event and the reason for the run.

• The default run name is the start date of the run, such as June 12 2015. If a group has
multiple runs on the same date, the subsequent runs have the same date with the run
number appended, such as June 12 2015 Run 2 and June 12 2015 Run 3.

• The system automatically detects the reason for the run. If the detected reason is
incorrect, you can change the reason. For example, the reason appears as Test, but the
run is actually Load Shedding.

Other details about the run event cannot bemodified directly. If the sources for a run are not
correct, you can exclude or include specific sources when generating a report based on this
run.

1. Click the run record you want to modify. The run details appear below the grid.
2. In theName field, change the suggested run name as necessary.

3. In theReason list, select the correct reason for the run.

4. Click OK to save the changes for the run.
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Generator Activity Report
TheGenerator Activity Report shows the test run hours and other test run data for each
generator in the selected group.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software. This can lead to inaccurate
reports and/or data results.

• Do not rely solely on system reports to determine if the system is functioning correctly
or meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Report Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields in order
to generate the report:

Generators Tab
• Name - The generator entity needs a name.

• Electrical Data - Specify the requiredmeasurement source, nameplate rating, and unit of
measurement.

• Status Measurements - The source of the status measurement and the start, run, and
stop values must be selected. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but this may be changed to accommodate
customer requirements.

For instructions on the above settings see either of these sections:

• For Generator Performance Configuration Tool, see "Define Generators" on page 91.

• For Generator Performance Configuration Tool with EPSS Test Module, see "Define
Generators for EPSS" on page 42.
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Configure and Generate the Generator Activity Report
Use the Reports module inWeb Applications to configure and generate the Generator
Activity Report.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator Per-
formance Configuration Utility.

1. Complete the fields to define the report:
• Title - Enter a name for the report.

• EPSS Group - Select the group for which the report is intended. When you select a
group in the list, the field to the right shows the devices included in the group.

• Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click >
to move those sources to theSources Excluded area.

b. Tomove all of the sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The
devices in the group will appear in theSources section of the generated
report. Excluded devices will appear as grayed-out entries.

• Reporting Period - Select the date range for the data you want to include. This can be
a fixed number of prior days, such as Last 7 Days, or a fixed date range. The initial
setting is Last 7 Days. In the US, select at least 30 days of load data recorded at 15
minute intervals to satisfy regulations. Also select the type of timestamp to use in the
report, either Server Local Time or UTC (Universal Time).

• Threshold (Hours) - Enter themaximum number of hours the generators should run in
non-emergency use. Enter a value that is in compliance with local authority
requirements. For example, in the US, the EPA requires that generators can run no
more than 100 hours in non-emergency use.

• Include Activity Details - Click Yes to include the generator details in the report. Click
No to exclude this section.

• Include Data Warnings - Click Yes to include data warnings in the report. If there are
none, the section is not included. Click No to exclude this section.

2. Click Generate Report to produce the report.



Generator Activity Report Example

Summary Page
The first page of the report shows the title, company name, group, a bar graph representing
the test run hours on each generator, and a table of test run data for each generator.

Details Page
The details page shows a pie chart of the type of hours for each generator and the total run
time table.

Power Monitoring Expert 8.1 ApplicationModules
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Generator Battery Health
TheGenerator Battery Health system contains several components that provide the
customer with information about the generator battery bank. Specifically, themonitor shows
the customer the starting voltage signature, which indicates the battery bank’s voltage drop
and recovery during and after starting the generator.

The following tasks must be completed to set up the Generator Battery Health system:

• Install and configure the ION7550 / ION7650meter to the battery bank to bemonitored.
Refer to thePowerLogic ION7550 / ION7650 Installation Guide andPowerLogic ION7550
/ ION7650 User Guide for more information. Obtain the latest version of these documents
from www.schneider-electric.com.

Note the following:

• Digital signal from the Crank relay connected to the digital input of the
ION7550/ ION7650meter. This is the signal that triggers that triggers the
oneshot timer to start recording waveform

• V1 - V3 voltage inputs must have PTs in order to isolate the ground from
the system beingmonitored and the battery.

• Connect V4 to the positive side of the battery. Input impedence of V4
terminal is 5Mohm (phase - Vref). For themost up to date specification,
contact the local representative.

• Connect Vref to battery ground.

• Fusingmust be installed according to themeter installation instructions.

• Perform visual inspection of connections to help ensure there is physical
separation between the system connected to V1, V2 and V3, and the
battery connected to V4.

• For other wiring options with PTs, see thePowerLogic ION7550 /
ION7650 Installation Guide.

DANGER
EQUIPMENT ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Treat the battery circuit as energized to the category of the installation.

Failure to follow these instructions will result in death or serious injury.
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Refer to the following diagram as an example for connections to themeter.

• Configure the Battery Health Framework to capture the battery voltage signature or
waveform and deploy the framework to themeter. See the next section for instructions.

• In the Generator Performance Configuration Tool, check the Battery Waveforms option for
the generator to be included in the customer's Battery Health report. See "Edit Generator
Properties" on page 92 or "Edit Generator Properties" on page 92 or "Edit Generator
Properties" on page 43 for instructions.

• Configure the Generator Battery Health Report to display the graph of the voltage
signature. The customer can use the report to help understand the battery bank
condition. The report can display multiple generators for the same starting date or a
single generator onmultiple starting dates. See "Configuring and Running the Battery
Health Report" on page 115.

This chapter provides instructions for configuring the framework to capture the voltage
signature.

Configure the Battery Health Framework
The Battery Health Framework is designed to capture and record a generator’s battery
voltage signature at start up. This voltage signature provides some indication of the health of
the generator’s battery bank. A typical waveform capture of the voltage drop when starting is
shown next:



Note the following items about this example:

• This capture shows about 4 - 5 seconds worth of data, accomplished via 3 waveform
recorders in series configured at a resolution of 16x96.

• The voltage does not immediately recover to its original value (~26 v) but it begins to ramp
up.

• There is about 0.5 seconds of data before the voltage drop to approximately 20 v.

Two options in the framework are possible to capture the waveform, based on how the crank
relay signal is triggered - pulse or KYZ.

Example Framework
The following figure shows the typical modules for the framework.

The types of module used are:

• Data Acquisition

• Digital Input

• Convert

• OneShot Timer

• Waveform Recorder

See the following descriptions for the way eachmodule works in this framework.
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Refer to ION Reference for details on how eachmodule operates and for settingmodule
parameters.

Data Acquisition – Data Acqn 1

The V4 signal from themeter goes to the Data Acquisitionmodule.

Digital Input – G1 Crank Relay

This module accepts the Cranking Relay signal from the field. When the signal goes high, the
logic to record the battery voltage triggers.

The Input mode can be set to Pulse or KYZ, as explained next.

Pulse Input Mode
When the Crank Relay signal goes high, a pulse is generated on the Trigger output register,
labeled "G1Crank Relay." The setup registers for the Digital Input module are shown next.

Note that the Input Mode value is Pulse. The Trigger output can now be fed into the first
Waveform Recorder along with V4 from the Data Acquisitionmodule.



KYZ Input Mode
If you are using the sameDigital Input to handle the Generator Start signal (EPSS_Start) it is
probably set to KYZmode.

Input Mode KYZmeans that a pulse is generated on the Trigger output register when the
Crank Relay signal goes high AND when it goes low. The Convert module and One Shot
Timermodule (explained later) prevent triggering the downstream logic twice.

The Crank Relay Module is setup like this:

Note that the Input Mode value is KYZ.

Convert
The signal from the Digital Input module cannot be fed directly into the One Shot Timer. The
Convert module converts the digital signal to analog for the One Shot Timer.

One-Shot Timer
To prevent triggering the downstream logic twice, send the state (EPSS_Start) from the
Convert module into the One Shot Timer:

Send the output register into the first Waveform Recorder G1 Battery 1.
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First Waveform Recorder – G1 Battery 1
The Data Acquisitionmodule andG2Crank Relay module are the inputs to the first
Waveform Recorder, labeled “G1 Battery 1.”

These are the setup registers for themodule:

Note the following about the setup registers:

• Depthmust be non-zero – 100 is a good number.

• RecordMode should be Circular.

• Format should 16x96. This means 16 samples per cycle and 96 cycles, so at 60 Hz this
results in approximately 1.6 seconds worth of data.

• Record Delay Cycles is set to 95 to allow the “window of observation” to move so that
only post-event data is captured. Refer to ION Reference for more details.

Second and Third Waveform Recorders
The secondWaveform Recorder - G1 Battery 2 - is cascaded with the first to capture another
1.6 seconds of the battery voltage signature. Do this by using the Record Complete output
register on G1 Battery 1 as a flag to trigger G1 Battery 2 to start recording.



The thirdWaveform Recorder - G1 Battery 3 - is cascaded with the second recorder to
capture the final 1.6 seconds of the battery voltage signature. As above, use the Record
Complete output register on G1 Battery 2 as a flag to trigger G1 Battery 3 to start recording.

The Setup Registers should be the same as first waveform recorder with different labels.
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Battery Health Waveform Capture Results
After the framework is complete, in Vista you should see the voltage signature that looks
similar to the illustration shown next.

After you obtain this type of result, you can configure the generator in the Generator
Performance Configuration Tool and define the Battery Health Report in the Power
Monitoring Expert 8.1 Healthcare EditionPowerMonitoring Expert - Data Center EditionWeb
Applications Reports feature. Refer to these sections for instructions on these tasks.

• "Edit Generator Properties" on page 92 if the system does not include the EPSS.

• "Edit Generator Properties" on page 92.

• "Edit Generator Properties" on page 43, if the system includes the EPSS.

• "Configuring and Running the Battery Health Report" on page 115.



Generator Battery Health Report
TheGenerator Battery Health Report shows the captured waveform image of the
generator voltage when the generator starts.

The waveform image includes a reference waveform that shows the initial voltage signature
when the batteries were first installed and tested. The reference waveform helps compare
the current battery condition to their initial condition.

Research has indicated that when a battery begins to fatigue, the waveform for the voltage
during start-up changes. The voltage waveform can be captured and stored in the system for
ongoing analysis.

By capturing the voltage waveform when the batteries are in a known good condition,
subsequent waveforms can be compared to it to identify changes. In the Generator Battery
Health report, you can compare waveform images to see the changes over time. Adverse
changes in the waveform indicate a degradation of battery condition.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software. This can lead to inaccurate
reports and/or data results.

• Do not rely solely on system reports to determine if the system is functioning correctly
or meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Prerequisites
In the Generator Performance Configuration Tool (with or without the EPSS), define the
following tabs and fields in order to generate the report:

Generators Tab
• Name - The generator entity needs a name.

• Electrical Data - Themeasurement source, nameplate rating, and unit of measurement
are required.

• Status Measurements - The source of the status measurement and the start, run, and
stop values must be selected. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but this may be changed to accommodate
customer requirements.

• Battery Waveforms - Select the source and themeasurement. Configure themeters that
provide thesemeasurements. Also, configure the frameworks as described in "Generator
Battery Health" on page 106.
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For instructions on completing this tab, see the following:

• "Edit Generator Properties" on page 92 if the system does not include the EPSS.

• "Edit Generator Properties" on page 92.

• "Edit Generator Properties" on page 43, if the system includes the EPSS.

After these required items are defined, the report can be configured and generated, as
described next.

Configuring and Running the Battery Health Report
Use the Reports module inWeb Applications to configure and generate the Battery Health
Report.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator Per-
formance Configuration Utility.

1. Complete the fields to define the report:
• Title - Enter a name for the report.

• Select EPSS (Generator) Group - Select the generator group for which the report is
intended. The list shows the groups that include generators that can record the battery
voltage waveform via ION 7550 / ION 7650meter. See "Edit Generator Properties" on
page 92 for more details about selecting the battery waveform selection for a generator.
When you select a group in the list, the field to the right shows the devices included in
the group.

• Exclude Sources - Click this to define the sources to exclude from the report.



a. In theSources Included area, select sources to exclude and then click >
to move those sources to theSources Excluded area.

b. Tomove all of the sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The
devices in the group will appear in theSources section of the generated
report. Excluded devices will appear as grayed-out entries.

• Select Generator Starts - Select the option to specify the start records. If you click
Select Reference Starts you can choose the specific start records by generator and
date. For example, you can use this option to compare yesterday's Gen 1 start voltage
signature to the Gen 1 start voltage signature from six months prior.

• Include Data Warnings - Click Yes to include the data warnings in the report. If there
are no data warnings, the section is not included in the report. Click No to exclude this
section.

• Cumulative Degradation Threshold - Enter the value that represents themaximum
total voltage difference between the reference waveform and the evaluated waveforms.
For example, if the waveform is off by 1.0 on each point from the reference, the total
degradation is 10. If the threshold value is 8, then the degradation exceeds the
threshold.

2. Click Generate Report to produce the report.
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Battery Health Report Example
In this example, the starting voltage waveform (blue) is very similar to the reference
waveform (red). The drop to 20 VDC is the point at which the generator started. After the
start, battery voltage rises to normal state of charge after the start.

Generator Battery Health Export
TheGenerator Battery Health Export report is based on the same data as the graphic-
based report. The export version provides the raw data in CSV file format. The export file can
be imported by other systems, such as Energy Operation.



Configure and Run the Generator Battery Health Export
Use the PowerMonitoring Expert 8.1 Healthcare Edition PowerMonitoring Expert - Data
Center EditionWeb Application Reports feature to configure and produce theGenerator
Battery Health Export file.

1. In the Reports Library, expand theGenerator Performance expand the Healthcare
Reports folder and click Generator Battery Health Export. The report template appears.

2. Complete the fields to define the report.

• Title - Enter a name for the export file.

• Select EPSS Group - Select the generator group for which the report is intended. The
list shows the groups that include generators that can record the battery voltage
waveform via ION 7650meter. For more details about selecting the battery waveform
selection for a generator, see:

• For Generator Performance Configuration Tool, see "Edit Generator
Properties" on page 92.

• For Generator Performance Configuration Tool with EPSS Test Module,
see "Edit Generator Properties" on page 43.

• When you select a group in the list, the field to the right shows the devices included in
the group.

• Exclude Sources - Click this to define the sources to exclude from the report.
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a. In theSources Included area, select sources to exclude and then click >
to move those sources to theSources Excluded area.

b. Tomove all of the sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The
devices in the group will appear in theSources section of the generated
report. Excluded devices will appear as grayed-out entries.

• Select Generator Starts - Select the option to specify the start records. If you click
Select Reference Starts you can choose the specific start records by generator and
date. For example, you can use this option to compare yesterday's Gen 1 start voltage
signature to the Gen 1 start voltage signature from six months prior.



• Cumulative Degradation Threshold - Enter the value that represents themaximum
total voltage difference between the reference waveform and the evaluated waveforms.
For example, if the waveform is off by 1.0 on each point from the reference, the total
degradation is 10. If the threshold value is 8, then the degradation exceeds the
threshold.

3. Click Generate Report to produce the report.

Battery Health Export Example

Power Monitoring Expert 8.1 ApplicationModules

© 2016 Schneider Electric. All rights reserved. Page 120



Generator Load Summary Report
TheGenerator Load Summary Report provides a summary graph of electrical data during
a generator run. The report includes a load curve, minimum-maximum-average load
summary, and other electrical details.

This report is only included with the system if the EPSS is not installed.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software. This can lead to inaccurate
reports and/or data results.

• Do not rely solely on system reports to determine if the system is functioning correctly
or meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Report Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields in order
to generate the report.

Generators Tab
• Name - The generator entity needs a name.

• Electrical Data - Themeasurement source, nameplate rating, and unit of measurement
are required.

• Status Measurements - The source of the status measurement and the start, run, and
stop values must be selected. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but this may be changed to accommodate
customer requirements.

See "Define Generators" on page 91 for instructions on the above settings.

Configure and Generate the Generator Load Summary Report
Use the Reports module inWeb Applications to configure and generate the Generator Load
Summary Report.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.
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NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator Per-
formance Configuration Utility.

Generator Load Summary Report Example
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Generator Test Report
TheGenerator Test Report shows the run details and overall status for generators and
transfer switches in the group. For example, the report shows the transfer time of the lead
ATS and indicates whether the transfer time passes or does not pass the test requirements.

Use the Reports module inWeb Applications to configure and generate the Generator Test
Report.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.

Report Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields in order
to generate the report.

Generators Tab
• Name - Enter a name for the generator entity.

• Electrical Data - Enter themeasurement source, nameplate rating, and unit of
measurement.

• Status Measurements - Enter the source of the status measurement and the start, run,
and stop values. Configure themeters that provide thesemeasurements.

• Evaluation Method - “Load” is default, but you can change this to accommodate
customer requirements.

See "Define Generators" on page 91 for instructions on the above settings.

Groups Tab
• Name - Enter a name for the group entity.

• Select at least one entity from theGenerators, Transfer Switches, orEquipment lists.
The group can contain entities from each list combined.

See "Define Groups" on page 95 for instructions.

After these required items are defined, the report can be configured and generated, as
described next.



Power Capacity

Power Capacity let youmanage and report on generator and UPS systems, and report on
branch circuits within a data center facility.

Power Capacity includes the following configuration tools:

• "Generator Power Configuration Utility" on page 126

• "UPS Power Configuration Utility" on page 135

Power Capacity includes the following reports:

• "Branch Circuit Power Report" on page 125

• "Generator Power Report" on page 134

• "UPS Power Report" on page 142

Branch Circuit Power Report
The Branch Circuit Power Report is used by data center facility operators to generate a
report that describes the average andmaximum loading for branch circuits within the data
center facility, as well as the percentage load compared to the breaker size. This section
describes the procedures involved in creating a report, how the reports are used, examples of
the generated report, and themanaging and saving of the report.

NOTE: This report requires a license to be used. Contact your Schneider Electric rep-
resentative for more information.

The Branch Circuit Power Report is used for:

• Proactive capacity management

• Incident investigation

• Customer expansion planning

• Service Level Agreement (SLA)management

NOTE: For the Branch Circuit Power Report to provide accurate information, devices must
be installed, configured, and communicating correctly, youmust use and correctly configure
theCircuit > Rack > Customer hierarchy, and theManaged Circuits feature run each time
a device configuration change is made. If any of these tasks are not performed correctly,
your reports will provide inaccurate information. See "Switching to the Customer Circuit hier-
archy template" section in thePowerMonitoring Expert 8.1 – Data Center Edition Com-
missioning Guide for more information.
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Branch Circuit Power Report example
The Branch Circuit Power Report data depends on the selections youmake while configuring
the report and the contents of the PowerMonitoring Expert or Data Center database.

Generator Power Configuration Utility
TheGenerator Power Configuration Utility lets you create, edit, andmanage one or more
generator systems that will be used for reporting on the power capacity of those systems.

TheGenerator Power Configuration Utility window consists of a single panel that contains a
grid area and an editor area. The grid area is empty initially but will be populated with entries
you create through the editor area. Use the editor area to define the settings for new items, or
to update the settings for an item that you select in the grid area.

The generator system is the logical system configuration that will be used for reporting power
capacity.

This configuration utility allows you to create, edit, andmanage one or more generator
systems that will be used for reporting on the power capacity of those systems.

For information on generator redundancy types, see "Generator System Redundancy Types"
on page 266.

Generator Configuration Restrictions
The configuration tool enforces certain rules when creating a generator system, group, or
generator:

• Generator System

• Namemust be unique.



• One or more systems are allowed.

• Generator Groups

• Namemust be unique.

• At least one groupmust be present in each system.

• All groups are connected to the same load.

• For N, N+1, and N+2 system types:

Only one group is allowed.

Each generator in the groupmust have the same nameplate rating (kVA) value.

Each generator in the groupmust have the same derated nameplate rating (kW) value.

• For 2N, 2(N+1) and 2(N+2) system types:

Up to three groups are allowed.

All groups must have the same number of generators.

All generators in the groups must have the same nameplate rating (kVA) value.

All generators in the groups must have the same derated nameplate rating (kW) value.

• Generators

• Namemust be unique.

• At least one generator must be present in each group.

• A maximum of 12 generators is allowed in each group.

Define generator systems
The generator system is the logical system configuration that will be used for reporting power
capacity.

The following image is an example of the Generator Power Configuration Utility with a
sample generator system selected.
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Control Description

Help Opens the help for the utility.

New Createsa new entry in the grid.

Delete Deletes the selected entry from the grid.

OK Savesall changesand exits the utility.

Cancel Exits the utilitywithout saving changes.

Apply Savesall changesand leaves the utility open.

Grid Area Columns Description

Modified Displaysa status symbol for the record.

+ (plus) A new entry.

* (asterisk) An existing entry hasbeenmodified.

! (exclamationmark) The entry is incorrect.

System Displays the system name.

Type Displays theGenerator system type (N, 2N, N+2, etc)

Description Displaysa description of the system



To start the Generator Power Configuration Utility, either:

• Double-click theGenerator Power Configuration Utility icon located in the Power
Monitoring Expert DC Ed folder on the desktop,

or

• Click Start > All Programs > Schneider Electric > Power Monitoring Expert DC Ed
> Generator Power Configuration Utility.

To define a new generator system:

1. Click New. The Edit System: New System area appears below the grid.

2. Click anywhere in the editor area. The Properties screen appears.
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3. Complete the details for the generator system:

a.Generator System Name:Enter a name for the generator system. Each generator
systemmust have a unique name.

b.Description:Enter a description for the generator system. This field is optional.

c.Redundancy Type:Select the redundancy type for the generator system. The different
redundancy types are explained in "Generator System Redundancy Types" on page
266.

d.Groups:Shows the number of generator groups contained in the generator system.
Click Add to add groups to the generator system. Click Remove to delete groups.

e.Generators Per Group:Shows the number of generators in each generator group in the
system. Click Add to add generators to the group. Click Remove to delete generators.

This property is only available when the system redundancy type is 2N, 2(N+1) or 2
(N+2). To define the number of generators for a system with redundancy type N, N+1 or
N+2, use the generator group properties. See "Define Generator Groups" on page 131
for more information.

4. Click Done to save the generator system.

Once complete, you can configure the other components of the system:

"Define Generator Groups"

"Define Generators"

"Define Generator Loads"

"Define Generator Utilities"



Define Generator Groups
A generator group represents a logical grouping of generators. The system contains at least
one group and can contain multiple groups. Depending on the system type, the group
properties may be different, as shown below. See "Generator Configuration Restrictions" on
page 126 for more information.

To define the properties for a generator group:

1. Click on the group object border. The Properties screen appears.

2. Complete the details for the generator group:
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a.Generator Group Name:Enter a name for the group.

Each generator groupmust have a unique name.

b.Description:Enter a description for the group. This field is optional.

c.Generators Per Group:Click Add to increase the number of generators in the group.
Click Remove to decrease the number. This property is available only for system
redundancy types N, N+1 or N+2.

3. Click Done to save the generator group.

Define Generators
A generator represents an actual generator device in the data center. A group contains at
least one generator and can contain multiple generators. For some system types, each group
must contain the same number of generators. See "Generator Configuration Restrictions" on
page 126 for more information.

To define a generator:

1. Click on the generator object border. The selected generator will be highlighted in blue and
the Properties screen appears.

2. Complete the details for the generator:

a.Generator Name:Enter the name for the generator.

This namemust be unique for each generator in the system.

b.Description:Enter a description for the generator. This field is optional.

c.Nameplate Rating (kVA):Enter themaximum output power (kVA) of the generator.
This valuemust be greater than zero.

d.Derated Nameplate Rating (kW):Enter themaximum power capacity (kW) that the
generator is expected to support. This valuemust be equal or less than the nameplate
rating value, and greater than zero.

3. Click Done to save the generator.



Define Generator Loads
A generator load represents the logical load attached to a generator group. Each generator
systemmust have only one load.

To define a generator load:

1. Click the generator load element in the system diagram. The Properties screen appears.

2. Complete the details for the generator load:

a.Load Name:Enter a name for the load.

b.Description:Enter a description for the load. This field is optional.

c.Data Source:Select one or moremeter sources where load data is logged for this load.

d.Additional Utilities:Click Add to increase the number of utility objects for the load.
Click Remove to decrease the number of utility objects.

3. Click Done to save the generator load.

Define Generator Utilities
A utility represents the logical utility provider that feeds a particular load under normal
operation. This logical utility has no functional purpose in the calculations for power
redundancy. It is used to provide amore complete diagram representation for the generator
system. A systemmay have one or two utilities represented in the diagram.

To define a utility:

1. Click the utility element in the diagram. The Properties screen appears.
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2. Complete the details for the utility:

a.Utility Name:Enter a name for the utility.

b.Description:Enter a description for the utility. This field is optional.

3. Click Done to save the utility.

Once the configuration of the generators, loads, and utilities are complete, click Apply to
save, or click OK to save the configuration and exit the utility.

Generator Power Report
TheGenerator Power Report provides information regarding the generator backup power
system and its ability to handle a utility power outage while still complying with the intended
redundancy design. The report is generated after a representation of your backup generator
system is created and configured using the Generator Power Configuration Utility.

NOTE: This report requires a license to be used. Contact your Schneider Electric rep-
resentative for more information.

TheGenerator Power Report data depends on the selections youmake while configuring the
report and the contents of the PowerMonitoring Expert database. See "Generator Power
Capacity Measurements" on page 134 for more details on the Generator Power Report data.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.

Generator Power Capacity Measurements
TheGenerator Power Report uses a priority table to determine whichmeasurement to use for
querying power data for a load.

The table is stored in the PowerMonitoring Expert database, and consists of a list of
measurement IDs with a priority value for eachmeasurement. When the report is querying for
data, it iterates through themeasurement list according to the priority and queries the
database for load data. Once data is found, it is returned in the report.



By default, the table GEN_CapacityMeasurement holds four knownmeasurements:

UPS Power Configuration Utility
The UPS Power Configuration Utility lets you create, edit, andmanage one or more UPS
systems that will be used for reporting on the power capacity of those systems. The UPS
Power window contains a grid area and an editor area. The grid area is initially empty but will
be populated with entries you create. The editor area displays the configuration diagrams and
allows you to define andmodify the configurations.

The UPS system consists of UPS groups, modules, and loads. The configuration utility
provides a way to organize the components of the system graphically and define properties
for each component.

For information on UPS redundancy types, see "UPS System Redundancy Types" on page
270.

UPS Power Configuration Restrictions
The configuration tool enforces certain rules when you creating UPS systems, groups and
modules:

• UPS System

• Namemust be unique.

• One or more systems are allowed.

• UPS Groups

• Namemust be unique.

• At least one groupmust be present in each system.

• A maximum of three groups are allowed in each system.

• For N, N+1, and N+2 system types:

Each group in the systemmay have a different number of UPS modules.
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Each UPS module in the groupmust have the same nameplate rating (kVA) value.

Each UPS module in the groupmust have the same derated nameplate rating (kW)
value

Each group is connected to one load only. No other group can be connected to the same
load.

• For 2N, 2(N+1) and 2(N+2) system types:

All groups must have the same number of UPS modules.

All UPS modules in the groups must have the same nameplate rating (kVA) value.

All UPS modules in the groups must have the same derated nameplate rating (kW)
value.

Depending on the number of groups present in the system, a loadmay be shared by two
groups. See the "UPS Power Configuration Utility" on page 135 for more information.

• UPS Modules

• Namemust be unique.

• At least onemodulemust be present in each group.

• A maximum of 12modules is allowed in each group.

Define UPS Systems
The UPS system is the logical system configuration that will be used for reporting power
capacity.

The following image is an example of the UPS Power Configuration Utility with a sample
generator system selected.



Control Description

Help Opens the help for the utility.

New Createsa new entry in the grid.

Delete Deletes the selected entry from the grid.

OK Savesall changesand exits the utility.

Cancel Exits the utilitywithout saving changes.

Apply Savesall changesand leaves the utility open.

Grid Area Columns Description

Modified Displaysa status symbol for the record.

+ (plus) A new entry.

* (asterisk) An existing entry hasbeenmodified.

! (exclamationmark) The entry is incorrect.

System Displays the system name.

Type Displays the UPS system type (N, 2N, N+2, etc)

Description Displaysa description of the system
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To start the UPS Power Configuration Utility:

• Double-click theUPS Power Configuration Utility icon in the Power Monitoring
Expert DC Ed folder located on the desktop,

or

• Click Start > All Programs > Schneider Electric StruxureWare Power Monitoring
Expert DC Ed > UPS Power Configuration Utility.

To define a new UPS system:

1. Click New. The Edit System: New System area appears below the grid.

2. Click anywhere in the editor area. The Properties screen appears.



3. Complete the details for the UPS system:

a.System Name: Enter a name for the UPS system. Each UPS systemmust have a
unique name.

b.Description:Enter a description for the UPS system. This field is optional.

c.Redundancy Type: Select the redundancy type for the UPS system. The different
redundancy types are explained in "UPS System Redundancy Types" on page 270.

d.Groups: Shows the number of UPS groups contained in the UPS system. Click Add to
add groups to the UPS system. Click Remove to delete groups.

e.Modules Per Group: Shows the number of UPS modules in each group in the system.
Click Add to add UPS modules to the group. Click Remove to delete modules.
This property is only available when the system redundancy type is 2N, 2(N+1) or 2
(N+2). To define the number of modules for a system with redundancy type N, N+1 or
N+2, use the UPS group properties. See "Define UPS loads" on page 142 for more
information.

4. Click Done to save the UPS system.

Now you can configure the other components of the system:

"Define UPS groups"

"Define UPS modules"

"Define UPS loads"
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Define UPS groups
A UPS group represents a logical grouping of UPS modules. The system contains at least
one group and can contain multiple groups. Depending on the system type, the group
properties may be different, as shown below. See "UPS Power Configuration Restrictions"
on page 135 for more information.

To define the properties for a UPS group:

1. Click on the group object border. The Properties screen appears.

2. Complete the details for the UPS group:

a.Group Name:Enter a name for the group. Each UPS groupmust have a unique name.

b.Description:Enter a description for the group. This field is optional.

c.Modules Per Group:Click Add to increase the number of UPS modules in the group.
Click Remove to decrease the number. This property is available only for system
redundancy types N, N+1 or N+2.



3. Click Done to save the UPS group.

Define UPS modules
A UPS module represents an actual UPS device in the data center. A group contains at least
one UPS module and can contain multiple modules. For some system types, each group
must contain the same number of UPS modules. See "UPS Power Configuration
Restrictions" on page 135 for more information.

To define a UPS module:

1. Click on themodule object border. The selectedmodule will be highlighted in blue and the
Properties screen appears.

2. Complete the details for the UPS module:

a.UPS Module Name:Enter the name for themodule. This namemust be unique for
each UPS module in the system.

b.Description:Enter a description for themodule. This field is optional.

c.Data Source:Select themeter source in PowerMonitoring Expert where load data is
logged for the UPS module. The sourcemust be unique for each UPS module.

d.Nameplate Rating (kVA):Enter themaximum output power (kVA) of the UPS module.
This valuemust be greater than zero.

e.Derated Nameplate Rating (kW):Enter themaximum power capacity (kW) that the
UPS module is expected to support. This valuemust be equal or less than the
nameplate rating value, and greater than zero.

3. Click Done to save the UPS module.
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Define UPS loads
A UPS load represents the logical load attached to a UPS group. This logical load has no
functional purpose in the calculations for power redundancy. The UPS load is used only to
provide amore complete diagram representation for the UPS system.

To define a UPS load:

1. Click the UPS load element in the system diagram. The Properties screen appears.

2. Complete the details for the UPS load:

a.Load Name:Enter a name for the load.

b.Description:Enter a description for the load. This field is optional.

3. Click Done to save the UPS load.

UPS Power Report
The UPS Power Report data depends on the selections youmake while configuring the
report and the contents of the PowerMonitoring Expert database. See "UPS Power Report
Capacity Measurements" on page 142 for more details on report data.

NOTE: This report requires a license to be used. Contact your Schneider Electric rep-
resentative for more information.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.

UPS Power Report Capacity Measurements
The UPS Power Report uses a priority table to determine whichmeasurement to use for
querying power data for a UPS module.



The table is stored in the PowerMonitoring Expert database, and consists of a list of
measurement IDs with a priority value for eachmeasurement. When the report is querying
for data, it iterates through themeasurement list according to the priority and queries the
database for load data. Once data is found, it is returned in the report.

By default, the table GEN_CapacityMeasurement holds four knownmeasurements:
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Power Efficiency

The Power Efficiency features help youmanage and report onmonitoring devices that make
up the power loss system, and report on branch PUE and average power consumed for the
IT equipment running in a data center facility.

System Efficiency includes the following configuration tool:

• "Power Losses Configuration Utility" on page 144

System Efficiency includes the following reports:

• "Power Losses Report" on page 148

• "Power Usage Effectiveness (PUE) Summary Report" on page 150

Power Losses Configuration Utility
The Power Losses Configuration Utility allows you to create, edit, andmanage the different
logical sources, such as transformers or UPS modules monitoring devices that make up the
power losses system. It is this system that will be used for reporting on its losses.

The Power Losses Configuration Utility window consists of two tabs labeled Transformers
andUPS Modules. Each tab contains a grid area and an editor area. The grid area is empty
initially but is populated with entries you create through the editor area. Use the editor area to
define the settings for new items, or to update the settings for an item that you select in the
grid area.

Before you can generate a Power Losses Report, you need to define a power losses system
using the Power Losses Configuration Utility.

The following image is an example of the Power Losses Configuration Utility.



Control Description

Help Opens the help for the utility.

New Createsa new entry in the grid.

Delete Deletes the selected entry from the grid.

OK Savesall changesand exits the utility.

Cancel Exits the utilitywithout saving changes.

Apply Savesall changesand leaves the utility open.

Grid Area Columns Description

Modified Displaysa status symbol for the record.

+ (plus) A new entry.

* (asterisk) An existing entry hasbeenmodified.

! (exclamationmark) The entry is in error.

Power Losses Configuration Restrictions
The configuration tool enforces certain rules when you create a power losses system:

• All Devices

• Namemust be unique.

• A meter sourcemust be assigned only once to a particular device.

• Transformers

• Zero, one, or more low voltage transformers may be present in the power losses
system.
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• Zero, one, or moremedium voltage transformers may be present in the power losses
system.

• UPS Modules

• Zero, one, or more UPS modules may be present in the power losses system.

Define the Power Losses components
To start the Power Losses Configuration Utility, either:

• Double-click thePower Losses Configuration Utility icon located in the Power
Monitoring Expert DC Ed folder,

or

• Click Start > All Programs > Schneider Electric > StruxurerWare Power Monitoring
Expert DC Ed > Power Losses Configuration Utility.

Select the appropriate tab to define the following power losses components:

"Define Transformers for Power Losses"

"Define UPS modules for Power Losses"

Define Transformers for Power Losses
To create or update components representing the transformers used in your power losses
system:

1. Select the Transformers tab.
2. Click New. The Edit fields are enabled.

3. Define the transformer:



a.Name:Enter a unique name for the transformer.

b.Description:Enter a description for the transformer (e.g. make, model). This field is
optional.

c. Input Side Meter Source:Select a source name from the drop-down list. The source
represents the PowerMonitoring Expert device that records the electrical data from the
input side of the transformer. "Power Losses ReportingMeasurements" on page 148 for
more information.

d.Output Side Meter Source:Select a source name from the dropdown list. The source
represents the PowerMonitoring Expert device that records the electrical data from the
output side of the transformer. "Power Losses ReportingMeasurements" on page 148
for more information.

e.Low Voltage/Medium Voltage:Select Low Voltage or Medium Voltage from the drop-
down list to indicate the transformer voltage rating type.

4. Click OK to save the transformer.

Define UPS modules for Power Losses
To create or update components representing the UPS modules used in your power losses
system:

1. Select theUPS Modules tab.
2. Click New. The Edit fields are enabled.

3. Define the UPS module:

a.Name:Enter a unique name for the UPS module.

b.Description:Enter a description for the UPS module (e.g. make, model). This field is
optional.
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c. Input Side Meter Source:Select a source name from the drop-down list. The source
represents the PowerMonitoring Expert device that records the electrical data from the
input side of the UPS module. "Power Losses ReportingMeasurements" on page 148
for more information.

d.Output Side Meter Source:Select a source name from the drop-down list. The source
represents the PowerMonitoring Expert device that records the electrical data from the
output side of the UPS module. "Power Losses ReportingMeasurements" on page 148
for more information.

4. Click OK to save the UPS module.

Power Losses Report
The Power Losses Report provides the breakdown of the cost of various losses throughout a
Data Center's power system and to lets you analyze and quantify the cost of inefficiencies
due to transformers (MV and LV) and UPS modules.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.

Power Losses Reporting Measurements
The Power Losses Report uses a priority table to determine whichmeasurement to use for
querying energy and power data for the different devices defined in the power losses system.

The table is stored in the PowerMonitoring Expert database, and consists of a list of
measurement IDs with a priority value for eachmeasurement. When the report is querying for
data, it iterates through themeasurement list according to the priority and queries the
database for the specific type of data. Once data is found, it is returned in the report.



The report also looks for different types of logical measurements, cataloged in a separate
Measurements table.

By default, the table PSL_PSLMeasurementCategory holds two knownmeasurements:

By default the table PSL_PSLMeasurementPriorityMapping holds the following information:

Devices that providePowermeasurements:

Devices that provideEnergy measurements:

Devices that provideCurrent Phase Averagemeasurements:
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Power Usage Effectiveness (PUE) Summary Report
The Power Usage Effectiveness (PUE) Summary Report displays PUE and average power
consumed for a data center facility, along with average power consumed for the IT equipment
running in the facility. Additionally, two graphical trends are displayed in a dashboard that
corresponds to the facility PUE values and to the energy consumption of the facility.

NOTE: The PUE Report does not require the data center VIP to be configured. See the "VIP"
sectionPowerMonitoring Expert 8.1 – Data Center Edition Commissioning Guide. However,
the framework does provide an example of the aggregation of power for the data center and
the IT Load, and the resulting calculation of interval energies that are required for the report to
run.

This section provides an overview of the PUE Summary Report and includes:

• Definitions of some of the terms associated with PUE

• PUE Summary Report prerequisites

• Calculations used to generate the PUE Summary Report.

Terms and Definitions
• PUE – Power Usage Effectiveness, defined as a ratio between the total power consumed

by a data center facility and the power consumed by the IT equipment that runs in the
facility. For example, a PUE value of 2.0 indicates that for every watt of IT equipment
power consumed, an additional watt is consumed to operate the facility that houses the
equipment (e.g. equipment cooling, power distribution to the equipment).

• Total Data Center Power – Represents all the power consumed by the data center
facility at one point in time. This value should represent an instantaneous power
consumption value.

• Total Data Center Energy – Represents all the energy used by the data center facility for
a given time interval. This value typically represents a 15-minute energy usage value.

• Total IT Equipment Power– – Represents all the power consumed by the IT equipment
used in a data center facility at one point in time. This value should represent an
instantaneous power consumption value

• Total IT Equipment Energy – Represents all the energy used by the IT equipment in the
data center facility for a given time interval.  This value typically represents a 15-minute
energy usage value.



• Support – Represents the overhead amount of energy or power required to operate the
data center, which does not account for IT equipment power consumption. This value
represents the data center power distribution losses, as well as the power consumed to
cool down the data center facility.

Prerequisites
Before a PUE Summary Report can be successfully generated, the following prerequisites
must bemet:

• PowerMonitoring Expert – Data Center Edition is installed and operational.

• The proper licensing is obtained for this module.

• Reporter is installed and functional.

• The PowerMonitoring Expert database contains Total Data Center Power and Total Data
Center Energy data, as well as Total IT Equipment Power and Total IT Equipment Energy,
as defined in the previous section.

• The PUE Summary Report Pack is installed and operational.

• IT Equipment Power Measurement:Click Select Measurement to choose the
measurement for instantaneous power consumption for all the IT equipment used.

NOTE: Confirm that the Data Center source and the IT Equipment source entries are correct
before generating a report. If these entries are not correct, the generated report can contain
inaccurate information.

PUE Summary Report Example
The sections and content contained in the PUE Summary Report depend on the selections
made in the PUE Summary Report template and the contents of the PowerMonitoring
Expert database. See the following sample report.
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PUE Summary Report Calculations
In this sample, all time periods are based on July 25, 2013.

24 Hours 7 Days 30 Days Last 12 Months
From July 24 12:00AM
until
July 25 12:00AM

From July 18 12:00AM
until
July 25 12:00AM

From June 25 12:00AM
until
July 25 12:00AM

From July 25, 2012
12:00AM until
July 25, 2013 12:00AM

The values in the table below are calculated as follows:

PUE – The ratio between the data center and IT equipment energy measurement values. 
This value is calculated for each of the required time periods by the following formula:

PUE =
Sum of Data Center Energy
Sum of IT Equipment Energy

IT Equipment – The average of the IT equipment powermeasurement values for each of the
time periods.



Data Center – The average of the data center powermeasurement values for each of the
time periods.

The values displayed in the charts below are calculated as follows:

PUE Trend – The weekly PUE values are calculated by the following formula where N
represents a week of the year:

PUE week N =
Sum [ Data Center Energy ] week N
Sum [ IT Equipment Energy ] week N

Energy Trend – The weekly energy values for IT equipment and support are calculated by
the following formulas where N represents a week of the year:

IT Equipment Energy week N = Sum [ IT Equipment Energy ] week N

Support Energy week N = Sum [ Data Center Energy] week N - Sum [ IT
Equipment Energy ] week N
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UPS Performance

Uninterrupted Power Supply (UPS) Auto Test
The Uninterrupted Power Supply (UPS) Auto Test solution provides a Vista diagram to the
user in order to monitor theMGE5500 series UPS in PowerMonitoring Expert.

NOTE: The UPS Auto Test solution is supported only for theMGE5500 UPS.

Adding UPSs to Management Console
1. Log in to theManagement Console.

2. In Management Console, click Devices and add each new UPS device.

Configuring UPS Groups with UPS Configuration Tool
1. Open the UPS Configuration Tool.
2. In the UPS Configuration Tool, click New and add each new UPS that you added in the

Management Console.

3. (Optional) Change the value for theDisplay Name that appears in the Vista diagram if you
want.

This Display Name appears only in the Vista diagram and does not impact the name that
you use in theManagement Console.



4. After adding all new UPS devices, click theGroups tab.

5. Click New to create new groups for the UPS devices.
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6. After you finish adding all UPSs and associated groups, click Apply.

Generating a Vista diagram
1. Click Generate Vista Diagrams.



TheVista Diagram Generation dialog appears.

TheOutput Path shows where the Vista diagram .dgm file is saved after clicking
Generate Vista Diagrams. The file name or location can bemodified from the default
value if desired.

2. Select the check box for Include Custom Logo and then navigate to and select the file in
order to include a custom logo in your diagrams. Otherwise, a Schneider logo appears.

3. UnderOptions, drag the indicator to define the width and dimensions of Vista diagrams
you generate.

4. Click Generate Vista Diagrams to generate the .dgm files, then click Close.

Pasting UPS framework in VIP
1. Open the Designer tool and open the VIP.<servername>.node.
2. Drag aGrouping Object and open it. Make sure that the toolbox is available (Options >

Show toolbox).

3. Go to ...\config\fmwk\UPS\ and select Edit > Paste to paste the framework.
Depending on the number of UPSs and groups, youmay need to set up the framework,
The default template assumes the user has two groups with five UPSs in each group.
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The example below shows an instance where the user has three groups with a different UPS
in each group:



4. Connect the inputs of each AND/OR module (UPS) to the critical operation and battery
usage status.
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5. Repeat this step for each UPS in the group and for all of the UPSs in the other groups.

6. Save the framework after you finishmodifying the framework based on your UPS system.

Setting up Vista Diagram status
1. Browse to ...\config\diagrams\ud\UPS\UpsGroups.dgm.

2. Link the status object from the framework that you pasted in VIP in the previous steps.



3. Repeat this step for all other groups. Your UPS Monitoring system is now setup.

Any UPS in the groups that require attention show a red indicator.

Running a report
After you finish configuring all UPSs, you can run a report by selecting a group.

Uninterrupted Power Supply (UPS) Auto Test Report
TheUPS Auto Test Report shows the test solution and provides a Vista diagram to the
user in order to monitor theMGE5500 series UPS.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.
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Uninterrupted Power Supply (UPS) Battery Health
Report

TheUPS Battery Health Report is designed to show information related to the health of the
battery for a UPS device. The UPS devices intended for use with this report are UPS
devices that do not have an auto-test capability.

Supported Devices
The only devices supported by UPS Battery Health are as follows:

l ION7550 / ION7650

The UPS Battery Health system contains several components that provide the customer
with information about the generator battery bank. Specifically, themonitor shows the
customer the starting voltage signature when the UPS comes online, which indicates the
battery bank’s voltage drop and recovery at that time.

The following tasks must be completed to set up the UPS Battery Health system:

• Install and configure the ION 7550 / ION7650meter to the battery bank to bemonitored.
Refer to thePowerLogic ION7550 / ION7650 Installation Guide andPowerLogic ION7550
/ ION7650 User Guide for more information. Obtain the latest version of these documents
from www.schneider-electric.com.

Note the following:

• V1 - V3 voltage inputs must have PTs in order to isolate the ground from
the system beingmonitored and the battery.

• Connect V4 to the positive side of the battery. Input impedence of V4
terminal is 5Mohm (phase - Vref). For themost up to date specification,
contact the local representative.

• Connect Vref to battery ground.

• Fusingmust be installed according to themeter installation instructions.

• Perform visual inspection of connections to ensure there is physical
separation between the system connected to V1, V2 and V3, and the
battery connected to V4.

• For other wiring options with PTs, see thePowerLogic ION7650
Installation Guide.

DANGER
EQUIPMENT ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Treat the battery circuit as energized to the category of the installation.

Failure to follow these instructions will result in death or serious injury.
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Refer to the following diagram as an example for connections to themeter.

• Configure the UPS Battery Health Framework to capture the battery voltage signature or
waveform and deploy the framework to themeter. See the next section for instructions.

• Configure the UPS Battery Health Report to display the graph of the voltage signature.
The customer can use the report to help understand the battery bank condition.

This chapter provides instructions for configuring the framework to capture the voltage
signature.

Configuring the UPS Battery Health Framework
The UPS Battery Health Framework is designed to capture and record a UPS’s battery
voltage signature at start up. This voltage signature provides some indication of the health of
the UPS’s battery bank. A typical waveform capture of the voltage drop when the UPS
comes online is shown below:



Note the following items about this example:

• This capture shows about 4 - 5 seconds worth of data, accomplished via one (1)
waveform recorder configured at a resolution of 512 x 4.

• The voltage does not immediately recover to its original value but it begins to ramp up.

• There is about 0.5 seconds of data before the voltage drop to approximately 20 V.

Two options in the framework are possible to capture the waveform, based on how the crank
relay signal is triggered - pulse or KYZ.

Example Framework
The types of module used are:

• Data Acquisition

• Digital Input

• Convert

• OneShot Timer

• Waveform Recorder

See the following descriptions for the way eachmodule works in this framework.

Refer to ION Reference for details on how eachmodule operates and for settingmodule
parameters.
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Data Acquisition – Data Acqn 1

The V4 signal from themeter goes to the Data Acquisitionmodule.

One-Shot Timer
To prevent triggering the downstream logic twice, send the state from the Convert module
into the One Shot Timer:

Send the output register into the first Waveform Recorder G1 Battery 1.

First Waveform Recorder – G1 Battery 1
The Data Acquisitionmodule is the input to the first Waveform Recorder, labeled “G1 Battery
1.”

These are the setup registers for themodule:

Note the following about the setup registers:

• Depthmust be non-zero – 100 hundred is a good number.



• RecordMode should be Circular.

• Format should 16x96. This means 16 samples per cycle and 96 cycles, so at 60 Hz this
results in approximately 1.6 seconds worth of data.

• Record Delay Cycles is set to 95 to allow the “window of observation” to move so that
only post-event data is captured. Refer to ION Reference for more details.

Configure and Generate the UPS Battery Health Report
Use the Reports module inWeb Applications to configure and produce the UPS Battery
Health Report.

For more information on generating andmanaging reports, see the "Reports" section of the
Web Applications help file.

UPS Battery Health Report Example
In this example, the starting voltage waveform (blue) is similar to the reference waveform
(red). The drop to near 51 volts DC is the point at which the generator started. After the start,
battery voltage rises to normal state of charge.

The first section shows a summary table of the reference and comparison waveforms. It
shows the timestamp for the waveform that corresponds to the recorder timestamp of the
waveform, and whether or not the drop or recovery are found.

The next section shows a chart that shows the reference and comparison waveforms in a
stacked view. If a voltage drop is found in both waveforms, then those waveforms are time
aligned based on their voltage drop minimum values. If a drop is not found in both
waveforms, then those waveforms are time aligned based on their absolute minimum
values.

The chart shows a gray band around the Analysis Section that represents the section of the
waveform where the voltage drop and recovery voltage samples are found.
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This section shows a chart with details of the waveform analysis. Following the analysis table, a
chart shows a stacked view of the reference and comparison waveform voltage drops. The chart
also shows a red horizontal band that represents the area that is under the voltage threshold.



Telvent Weather Data Import Service

The Telvent Weather Data Import Service allows you to import current weather data from the
Telvent weather source you specify into PowerMonitoring Expert in order to forecast
weather conditions and to correlate weather-related conditions to energy consumption. The
Telvent Weather Data Import Service device driver can import real-time and historical data
into PowerMonitoring Expert.

NOTE: The Telvent Weather Data Import Service requires an active Telvent subscription
account.

Configure the data import service
To begin using the Telvent Weather Data Import Service, youmust first configure it using the
Modbus Service Configuration Tool and theManagement Console.

Run the Modbus Service Configuration Tool
1. InWindows > Explorer, navigate to the system\bin folder and then double-click

ModbusServiceConfigurationTool.exe to run it. TheModbus Service Configuration
Tool dialog appears.

2. Click Add. TheAdd Service Window dialog appears.

3. From theAvailable Services dropdown list, select Telvent Weather Service.

4. ForUnit ID, enter "1" and then click Configure. The Telvent Weather Service
Configuration dialog appears.
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5. Complete the fields as follows:

Telvent User Name field: Enter your Telvent subscription user name.

Telvent Password field: Enter your Telvent subscription password.

For location, choose and complete the fields for one of the following:

GPS Location: Enter values for Latitude and Longitude.

Station ID:Enter a specific Weather Station ID.

Postal Address: Enter a postal address (ZIP or postal code).

From the dropdown lists, select the unit measurements you want. ForDegree Day, enter
what the Telvent weather service provides as units.

6. Click OK. Telvent Weather Service now appears in the list underService Name in the
Modbus Service Configuration Tool dialog and begins collecting data immediately.



7. Click OK, and then click Yes to restart theModbus Software Gateway Service.

Configure the Management Console
1. From the desktop, navigate to the ...\Power Monitoring Expert 8.1 Healthcare Edition

folder and double-click Management Console, enter your user name and password, and
click OK. TheManagement Console dialog appears.

2. In the left pane, click Sites.

3. Right-click on the dialog and chooseNew > Ethernet Gateway Site.

TheEthernet Gateway Site Configuration dialog appears.
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4. Complete the fields as follows:

Name field: Enter a name for the site, such as SoftwareGatewayService.

TCP/IP Address field: Enter the local IP address or the server namewhere Power
Monitoring Expert 8.1 Healthcare Edition is installed.

TCP/IP Port field: Enter port 502.

5. Click OK.

6. In the left pane, click Devices.

7. Right-click on the dialog and chooseNew > Serial Device on Ethernet Gateway Site.



TheSerial Device Configuration dialog appears.

8. Complete the fields as follows:

Group field: Select a group for the device, such as MAIN.
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Name field: Enter a name for the device, such as Telvent.

Device Type field: Select Telvent Weather Service.

Unit ID field: Enter "1" .

Site field: Select Software Gateway Service.

Enabled field: ChooseYes.

Description field: Enter a description of the device if you want.

9. Click OK. The new device now appears in the list of devices. The Telvent Weather Data
Import Service is now configured.

Verifying the service is active
After the Telvent Weather Data Import Service is configured, you can verify that the service
is active in Vista.

1. Select the site you configured, such as SoftwareGatewayService.
2. From the desktop, navigate to the ...\Power Monitoring Expert 8.1 Healthcare Edition

folder and double-click Vista.

3. Log in with your username and password, and then click OK. TheVista dialog appears.

4. Choose File > New to create a new diagram.

5. Drag a Numberic Object from the toolbar onto the diagram.

6. Right-click on the object and then click the Link tab.

7. Select Custom and click Edit Link.

8. In theCreate Link dialog, select the device you configured, suchWeather.Telvent, and
click OK.

9. Make selections forManagers,Modules, andOutput Registers, and then click OK.

10.Open the Vista diagram and verify that the service is logging observedmeasurements.

NOTE: All observedmeasurements are logged and all observedmeasurements are read
in real time. Hourly observedmeasurements are logged every half-hour, and all daily
observedmeasurements are logged every 12 hours.



AccuSine® Power Correction System (PCS) device

The AccuSine Power Correction System device is used to help reducemaintenance and
wear on an electrical system and to improve Power Quality. Adding a AccuSine Power
Correction System device to your PowerMonitoring Expert system allows youmonitor and
correct the harmonics of the power for your buildings.

Configuring the AccuSine PCS device
To begin using the AccuSine Power Correction System, youmust first configure it using the
Management Console.

1. Navigate to and double-click Management Console. TheManagement Console dialog
appears.

2. In the left pane, click Devices.

3. Right-click on the dialog and chooseNew > Ethernet Device.

TheEthernet Device Configuration dialog appears.
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4. Complete the fields as follows:

Group field: Select a group for the device, such as Correction.

Name field: Enter a name for the device, such as AccuSine.

Device Type field: Select AccuSine_PCS.

TCP/IP Address field: Enter your server IP Address.

Computer field: Enter the name of your server.

Enabled field: Select Yes.

Description field: Enter a description of the device if you want.

5. Click OK. The new device now appears in the list of devices. The AccuSine Power
Correction System is now configured.

Verifying the device is active
After the AccuSine Power Correction System is configured, verify that the device is active.

1. InVista, generate the network diagram.
2. Open the network diagram.

3. Click on each tab to verify that harmonic measurement data appears in each.

NOTE: Allow a few moments for measurement data to appear and refresh on the tabs.



4. After you verify that themonitoring and correction is active, close the diagram.
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ION Power Meter Configuration
This section describes how to complete the following tasks:

1. Add ION powermeters to the PowerMonitoring Expert solution.
2. Deploy a custom framework on an ION powermeter using the Designer application of

PowerMonitoring Expert solution.

3. Configure the framework with site-specific information.

Experience using ION Setup, Designer, and other software is necessary to configure
ION powermeters. Successful completion of these tasks ensures that:

• The operational states on the Active Transfer Switches (ATS) and generators are
associated with the digital inputs on the ION powermeters, and that the digital inputs are
appropriately labeled and logged in the ION_Data database.

ATS do not need to configured for the Generator Performancemodule, only for EPSS.

• The engine data for the generators is associated with the analog inputs on the ION power
meters, and that the analog inputs are appropriately labeled and logged in the ION_Data
database.

• The electrical details for the generators are logged and saved in the ION_Data database.

WARNING
UNINTENDED OPERATION

• Do not use ION meters for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Refer to the ION Reference for more information on ION module operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Supported ION Power Meters
PowerMonitoring Expert can use the following ION powermeters:

• PM8000, ION7550 and ION7650 for ATSs only, generators only, or for generators and
ATSs combined

• ION7550 RTU for ATSs only

Related information

For information about adding ION powermeters to PowerMonitoring Expert, see the
Management Console online help or theStruxureWarePowerMonitoring Expert Help.

For details about configuring Analog or Digital Input modules, refer to ION Reference.
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Maintenance and Backups
As a good practice, always save a backup of the final framework that is pasted onto the
meter. Use Designer to create a copy of the framework from themeter. Save the framework
to a location from where the framework can be pasted back to themeter if necessary.

Be sure to save a backup of themeter's framework before deploying and configuring the
EPSS frameworks.

If a meter needs to be replaced, use the backup copy of the ION meter framework for the new
ION meter. For all other installation and configuration steps, youmust follow the original
commissioning steps as described in the following sections.

Refer to existing PowerMonitoring Expert documentation for instructions to backupmeter
frameworks.

Prerequisites
The following items must be completed before attempting to configure ION powermeters to
record data from generators, automatic transfer switches (ATS) and other equipment.

• PowerMonitoring Expert must be installed and operational.

• All ION powermeters must be installed and communicating.

• ION powermeters selected tomonitor each ATS devicemust have the following
available data recorders and inputs:

• One available data recorder

• At least three available digital inputs (site specific)

• ION powermeters selected tomonitor each generator devicemust have the following
available data recorders and inputs:

• Two available data recorders

• Three available digital inputs (site specific)

• Two available data recorders

• See "Additional Information about Digital and Analog Inputs" on page 181 for more
information.

• Each ATS should be physically wired to the appropriate ION powermeters so that the
following status signals are represented:

• Normal

• Emergency

• Test

• Power Outage (optional)

• Each generator should be physically wired to the appropriate ION powermeters so that
the following status signals are represented:



• Start (optional)

• Emergency Power Source Available (optional)

• Run

• Stop

• The following generator electrical datamust bemetered and available for each generator:

• Vln a

• Vln b

• Vln c

• Vln avg

• Vll ab

• Vll bc

• Vll ca

• VII avg

• I a

• I b

• I c

• I avg

• kW tot

• kVA tot

• PF sign tot

• Freq

Additional Information about Digital and Analog Inputs

Digital Inputs
Meters used tomonitor generators and other equipment must have enough available digital
inputs to handle the incoming status signals. The number of required digital inputs depends
on how many signals are available and whether they are single state or dual state signals.

Example of single state signals, where signalA represents GEN Running

• When signalA = 1, GEN Running is TRUE

• When signalA = 0, GEN Running is FALSE

Example of dual state signals, where signalA represents GEN Running andGEN Stopped

• When signalA = 1, GEN Running is TRUE

• When signalA = 0, GEN Stopped is TRUE

Analog Inputs
Meters used tomonitor generators must have available analog inputs to handle the incoming
generator-specific analog data. The number of required analog inputs depends on how many
measurements are being recorded. For example, analog data can include the following:

• Exhaust Gas Temperature left and right

• Engine Coolant Temperature in and out.

• Engine Oil Pressure

Generator analog signals can be obtained through the analog inputs or via Modbus Master
from the engine controller. Refer to thePowerLogic ION7550/7650 User Guide for more
information.

Add ION Devices to the System
Follow these steps to add ION powermeters to your system configuration.

Complete these steps to prevent any unwanted database actions whenmodifying the
meter framework. 
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1. Stop the Log Inserter Service, as follows:

a. Open theWindows Services panel by clicking:

Start > Administrative Tools > Services

The path toServicesmay vary depending on theWindows operating system being
used.

b. Right-click ION Log Inserter Service and select Stop.

2. Open theManagement Console.

3. Use the Device window inManagement Console to add each ION powermeter.

The Device window includes Group andName fields. Group is the name under which
you want to associate the device you are adding. Name identifies themeter that you are
adding. Themeter name should include a reference to identify which ATS or generator is
connected to themeter.

When ameter has been added it appears in the list of devices in group.name format. For
example, if you named the group EPSS, and identified themeter as ATS1, the name in the
device list is EPSS.ATS1. Similarly, if you used the same group to add ameter identified
as GEN1, the name in the device list is EPSS.GEN1. See theStruxureWare Power
Monitoring Expert User Guide or online help for information about adding ameter.

After the powermeter is added, configure the appropriate frameworks as described in
"Deploying ATS Frameworks for EPSS" on page 182 and "Deploying Generator
Frameworks" on page 192.

Deploying ATS Frameworks for EPSS

Overview
UseDesigner to copy and paste the ATS framework to your ION powermeter. Repeat this
process for every powermeter in your system that records ATS data for EPSS purposes.

Pasting ATS Frameworks
Before you deploy ATS frameworks, you need to be aware of the implications of free pasting
and lock pastingmodules.

Use free pasting to paste a new module with a different name if a module with the same
name already exists. This helps to ensure that existingmodules and their functionality are
not replaced.

Use lock pasting to overwrite an existingmodule and its functionality with a new module,
while retaining themodule name. However, you need to understand what themodules are
currently being used for before you lock paste themodules. A lock paste replaces the
functionality of thosemodules.

• If a powermeter already uses all modules of a certain type that are a necessary part of the
framework, then a lock paste operation is required.



• If all of the available digital or analog input modules are in use, a lock paste of the analog
or digital input modules is required to help ensure that the parameter settings are updated

Copy the ATS Framework to the ION Power Meter
UseDesigner to copy and paste the ATS framework to the powermeter. Repeat this
process for every powermeter in the system that records ATS data for the EPSS.

Follow these steps to copy the ATS framework and paste it to the powermeter.

1. InManagement Console click Tools > System > Designer. The Designer login
window appears.

2. Enter the login credentials with administrator or supervisor access and click OK.

3. Click File > Open, select the powermeter that has the ATS connected to it, and then
click OK to open themeter’s framework.

4. Navigate toAdvanced Setup and double-click the Frameworks folder to open it.
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5. Make sure that the Toolbox is open. Select Options > Show Toolbox if it is not open.

6. Select Edit > Paste from framework. ThePaste from frameworkwindow appears,
from which you paste the framework to the Frameworks – ION Advanced
Configuration folder.

7. Navigate to C:\Program Files (x86)\Schneider Electric\PowerMonitoring Expert for
Healthcare\config\fmwk\EPSS, select the EPSS ATS framework .fwn file, and click
Open.

For example, in the following image the EPSS ATS framework file is EPSS ATS.fwn.

8. Press SHIFT and left-click to lock paste all of the Digital Input modules listed in thePaste
Summary dialog, and free paste all of the remainingmodules.

The lock paste overwrites amodule if it already exists on themeter. For
more information, see "Deploying ATS Frameworks for EPSS" on page
182.



9. Do not selectMaintain external inputs.

10.Press OK to paste the EPSS ATS framework.

Configure the ATS Frameworks
After the EPSS ATS framework has been pasted, configure the EPSS ATS framework with
site-specific data.

1. Double-click the framework folderEPSS ATS to open its node diagram.

The nodes of the ATS framework, as shown next, support the three single state status
signals: Normal, Emergency, and Test. These status signals are received by their
respective digital input modules ATS1Normal, ATS1 Emergency, and ATS1 Test.
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© 2016 Schneider Electric. All rights reserved. Page 185



Power Monitoring Expert 8.1 ApplicationModules

Page 186 © 2016 Schneider Electric. All rights reserved.

The names of the digital input modules are examples to identify how the label the
components in the framework. You can rename them tomatch the system being
deployed. For example, ATS1 could be just ATS. The remaining steps use these label
names to illustrate the updates made to the framework.

2. Right-click a Digital Input module to access its registers. The ION Module Setup screen
appears.

The following image shows the registers for the digital input module ATS1Normal. The
ATS controller hardware that this module interfaces with governs how Input Mode,
Polarity, andDebounce should be configured.



3. To update a register, select the register and click Modify. TheModify Registers screen
appears.

4. Change the values to the site-specific sources and quantities. Click OK to return to the
node diagram. For example:

• The Setup Register Input Mode is set to KYZ, which forces a pulse output on both
leading and trailing edges of the signal. This causes the data recorder to record the state
on each transition of the signal.

• TheOutput Register label EPSS_Norm is the name associated with the signal received
by the digital input module ATS1Normal. Themaximum number of characters for the
label is 15. Examples of Output Register labels for digital input modules ATS1
Emergency and ATS1 Test are EPSS_Emerg and EPSS_Test, respectively.

Make sure that Output Register labels are consistently labeled across the
entire system. For example, if you plan to represent the ATS Normal state as
EPSS_Norm, then you need to use the same label for all of the ATSs.

For systems that use a single meter to record EPSS status measurements for
multiple EPSS devices, the Output Register naming convention for digital
input modules must bemodified from quantity to quantity@source. 

For example, change EPSS_Test to EPSS_Test@ATSxx where xx uniquely
identifies the ATS device.

The quantity@source format allows the data it represents to be uniquely
identified.
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The quantities remain the same (EPSS_Test, EPSS_Emerg, EPSS_Norm)
but the source name is now unique (ATSxx). If this change is not made,
data for all ATSs or generators recorded on themeter cannot be uniquely
identified.

5. Right-click the Data Recorder module to access its setup registers.

6. Set theDepth setup register to at least a value of 100 to help ensure that data is recorded.

7. Select Use Custom Label and add a label that clearly identifies the data recorder within
the framework.

8. When you have completed all of the necessary site-specific modifications, click File >
Send & Save from the node diagram to write your changes to the ION powermeter.

Refer to the ION Reference for more information about configuring setup registers.

9. Restart the Log Inserter Service after you configure the framework.

You can configure the EPSS ATS framework to remotely switch the ATS into test mode, as
described next.

(Optional) If you have a power outage signal, feed it into the abovemodule with the EPSS
Normal Emergency and Test.

Configure Remote ATS Test for ION7550/7650 Power Meter
Switching an ATS to test mode remotely is done by linking a control object in a Vista diagram
to a digital output on the ION7550/7650meter that is connected to the ATS controller.

Refer toStruxureWare PowerMonitoring Expert User Guide for more instructions on working
with Vista diagram control objects.

For details about configuringmodules, refer to ION Reference.



NOTE: The EPSS ATS framework must be deployed to themeter and configured before you
can set up the framework for ATS remote switching. For instructions, refer to "Deploying
ATS Frameworks for EPSS" on page 182.

Configure the Digital Output
Follow these steps to configure the digital output for the ION7550/7650 powermeter.

1. Open Designer and login as a supervisor.
2. Connect to themeter.

3. In themeter framework, open the EPSS ATS folder.

4. From the Toolbox drag and drop an External Booleanmodule into the EPSS folder.

5. Locate the Digital Output folder and drag in a Digital Output module.

You can also use CTRL-SHIFT left click to drag in a shortcut to the Digital Output module.

The folder should look similar to the following example:

6. Configure the External Boolean Setup Registers as shown next:

7. Connect the ATSTestSwitch output to the Source input of the Digital Output module, as
shown next.
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8. Configure the Digital Output module as shown next:

Note the following details for themodule setup:

• Polarity - Set this to "Non-Inverting"

• Pulse Width - Set this to "0"

• Port - Set this to the physical port on themeter that is connected to the ATS. In this
case, DO1.

• Use Custom Label - Enter a name easy to recognize, such as "ATSTestOutput."

9. Click theSend and Save icon.

Configure the Vista diagram for themeter, as described next.

Configure the Vista Diagram
Follow these steps for the ION7550/7650 powermeter. Make sure Designer is closed before
linking any objects in Vista.

1. Login to Vista as a supervisor and open a new diagram.
2. From the Toolbox, drag a Control object onto the diagram.

3. Right-click on the Control object. The Control Object Configuration screen appears.

4. Use a custom label, such as "ATSTestSwitch."



5. Configure the link to the External Booleanmodule's Switch output register, as shown
next.

6. Click OK.

7. Right-click the ATSTestSwitch object. The Control Object Configuration screen appears.

8. On theAction tab, set the Level to Operate field to "Controller" as shown next.
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9. Click OK.

10.Close the Toolbox.

11.Restart the ION Log Inserter Service after you configure the framework.

Now you can control the ATS by clicking the switch.

Deploying Generator Frameworks

Overview
UseDesigner to copy and paste the generator framework to the powermeter. Repeat this
process for every powermeter in the system that records generator data for purposes. The
generator framework is designed to capture generator status changes when they occur, and
then to log generator-specific field data when the generator is active.

This framework is a template that should be adjusted tomeet the requirements of your site.
GEN Start or GEN Run can be used to initiate logging, and the frequency can be adjusted in
the periodic timer.

• The status signals for status events GEN Start, GEN Run, andGEN Stop are recorded in
the Gen State Log whenever any one of them changes state.



• The logic is designed to record analog and general electrical data when the generator is
running. The data is logged at oneminute intervals.

• The external BooleanGen Log Enmust be linked to a control object in a Vista diagram and
enabled before any data is logged. This allows users to notify the system that they are
running a test and to log data accordingly.

Pasting Generator Frameworks
Before you deploy generator frameworks, you need to be aware of the implications of free
pasting and lock pastingmodules.

Use free pasting to paste a new module with a different name if a module with the same
name already exists. This helps to ensure that existingmodules and their functionality are
not replaced.

Use lock pasting to overwrite an existingmodule and its functionality with a new module,
while retaining themodule name. However, you need to understand what themodules are
currently being used for before you lock paste themodules. A lock paste replaces the
functionality of thosemodules.

• If a powermeter already uses all modules of a certain type that are a necessary part of the
framework, then a lock paste operation is required.

• If all of the available digital or analog input modules are in use, a lock paste of the analog
or digital input modules is required to help ensure that the parameter settings are updated

Copy Generator Framework to ION Power Meter
UseDesigner to copy the generator framework to the powermeter. Repeat this process for
every powermeter in the system that records generator data.

1. InManagement Console click Tools > System > Designer. The Designer login
window appears.

2. Enter the login credentials with administrator or supervisor access and click OK.
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3. Click File > Open, select the powermeter that has the generator connected to it, and then
click OK to open themeter’s framework.

4. Once themeter’s framework is open, navigate toAdvanced Setup and double-click the
Frameworks folder to open it.

5. Ensure that the Toolbox is open. Select Options > Show Toolbox, to open the Toolbox.

6. Select Edit > Paste from framework to open thePaste from frameworkwindow, from
which you paste the generator framework to the Frameworks – SPM Advanced
Configuration folder.



7. Navigate to ...\Program Files (x86)\Schneider Electric\PowerMonitoring Expert DC
Ed\config\fmwk\EPSS ...\Program Files (x86)\Schneider Electric\PowerMonitoring
Expert for Healthcare\config\fmwk\EPSS, select the generator framework .fwn file, and
click Open.

For example, in the following image the generator framework file is EPSS GEN.fwn.
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8. Press Shift and left-click to lock paste all of the Analog Input and Digital Input modules
listed in thePaste Summary dialog, and free paste all of the remainingmodules.

The lock paste overwrites amodule if it already exists on themeter. For
additional information see "Deploying ATS Frameworks for EPSS" on page
182.

9. Do not selectMaintain external inputs.

10.Press OK to paste the generator framework.

Configure the Generator Framework
Configure the generator framework with site-specific data. Refer to the ION Reference for
more information about configuring setup registers.

1. After the generator framework has been pasted, double-click the folderEPSS GEN to
open its node diagram. 



The nodes of the generator framework shown below support the three single state status
signals: GEN Start, GEN Run, andGEN Stop. These status signals are received by their
respective digital input modules GEN Start, GEN Run, andGEN Stop.

The names of the digital input modules are simply placeholders that are used as examples
to identify how the components in the framework should be labeled. You can rename them
tomatch the system being deployed. For example, GEN could beGEN1. The remaining
descriptions in this section use these example labels to illustrate the updates made to the
framework.

The framework also supports three analog signals. In the following image, these are Ex
Gas L (exhaust gas left), Ex Gas R (exhaust gas right), and Coolant T (coolant
temperature), and these signals are received by their respective analog input modules: Ex
Gas L, Ex Gas R, and Coolant T. Thesemodule are examples only and they can be
modified to any other parameters that need to bemonitored and recorded.

A. Analog Input Modules

B. Digital Input Modules
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2. Right-click a Digital Input module to access its setup registers. The following image
shows the registers for the digital input module GEN Start. The generator controller
hardware that this module interfaces with governs how it needs to be configured.

3. To update a register, select the register and click Modify. TheModify Registers screen
appears.

4. Change the values to the site-specific sources and quantities, and click OK to return to
the node diagram. For example:

• The Setup Register Input Mode is set to KYZ, which forces a pulse output on both
leading and trailing edges of the signal. This causes the data recorder to record the state
on each transition of the signal.

• TheOutput Register label EPSS_Start is the name associated with the signal
received by the digital input module GEN Start. Themaximum number of characters for
the label is 15. Examples of Output Register labels for digital input modules GEN Run
andGEN Stop are EPSS_Run and EPSS_Stop, respectively.

Make sure that Output Register labels are consistent across the entire system. For
example, if you plan to represent the GEN Start state as EPSS_Start, then you need
to use the same label for all of the generators.

Make sure that Output Register labels are consistent across the entire system.
For example, if you plan to represent the GEN Normal state as EPSS_Norm,
then you need to use the same label for all of the generators.

For systems that use a single meter to record EPSS status measurements for
multiple EPSS devices, the Output Register naming convention for digital input
modules must bemodified from quantity to quantity@source. 



For example, change EPSS_Test to EPSS_Test@GENxx where xx uniquely
identifies the generator device.

The quantity@source format allows the data it represents to be uniquely
identified.

The quantities remain the same (EPSS_Test, EPSS_Emerg, EPSS_
Norm) but the source name is now unique (GENxx). If this change is not
made, data for all generators recorded on themeter cannot be uniquely
identified.

5. Right-click an Analog Input module to access its registers. Shown below are the registers
for the analog input module Ex Gas L. The generator controller hardware that this module
interfaces with governs how it needs to be configured.

• TheOutput Register label ExGasL is the name associated with the signal received by
the analog input module Ex Gas L. Themaximum number of characters for the label is
15. Examples of Output Register labels for analog input modules Ex Gas R and Coolant
T are ExGasR and CoolTemp, respectively.

• Output Register labels should be consistent across the entire system. For example, if
you plan to represent Exhaust Gas Left as ExGasL then you need to use the same label
for all of the generators.

6. When you have completed all of the necessary site-specific modifications, click File >
Send & Save from the node diagram to write your changes to the powermeter.

7. Restart the ION Log Inserter Service after configuring the generator frameworks.

Power Monitoring Expert 8.1 ApplicationModules

© 2016 Schneider Electric. All rights reserved. Page 199



Power Monitoring Expert 8.1 ApplicationModules

Page 200 © 2016 Schneider Electric. All rights reserved.



Non-ION Power Meter Configuration
This chapter section provides information about configuring non-ION powermeters for the
PowerMonitoring Expert solution.

WARNING
UNINTENDED OPERATION

• Do not use the powermeters for critical control or protection applications where human
or equipment safety relies on the operation of the control circuit.

• Refer to your meter's technical documentation for more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Supported Power Meters
PowerMonitoring Expert can use the following non-ION powermeters for the EPSS:

• PM800 series powermeters. Refer to "Configuring PM800 Series Meters" on page 202.

• PowerLogic Circuit Monitor Series 3000 and 4000 PowerMeters. Refer to "Configuring
CM3000 and CM4000 Series Meters" on page 220.

• Momentum PLC. Refer to "ConfiguringMomentum PLC" on page 239.

Supported Sequence of Event Recorders
• SER-2408/SER-3200. Refer to "Adding the SER-2408/SER-3200 toManagement

Console" on page 252.

Prerequisites
The following prerequisites must be completed before attempting to configure a non-
ION powermeter to record data from generators and other equipment for the EPSS:

• PowerMonitoring Expert is installed and operational.

• All meters must be installed and communicating.

• The following status signals for each ATS are physically wired to the digital inputs on the
appropriate meters.

• Normal

• Emergency

• Test

• Power Outage (optional)

• The following status signals for each generator are physically wired to the digital inputs on
the appropriate meters.
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• Start (optional)

• Emergency Power Source Available (optional)

• Run

• Stop

• The following generator electrical data aremetered and available for each generator:

• Currents: A, B, C, N, Avg

• Minimum Apparent Power Total

• Minimum Real Power Total

• Frequency

• Real Power Total

• Apparent Power Total

• Voltages: A-B, B-C, C-A, L-L Avg, A-N, B-N, C-N, L-N Avg

• The following signals for each generator are physically wired to the analog inputs on the
appropriate meters. The number of analog inputs required depends on how many
measurements are being recorded. For example, analog data can include the following:

• Exhaust Gas Temperature left and right

• Engine Coolant Temperature in and out.

• Engine Oil Pressure

Configuring PM800 Series Meters
This chapter describes how to use PowerLogic™ ION Setup to configuremeters. This
chapter does not explain how to add powermeters to the system or how to use ION Setup.

• For information about addingmeters to the system, refer to theManagement Console
online help or theManagement Console section of theStruxureWare PowerMonitoring
Expert User Guide.

• For information about ION Setup software, refer to ION Setup online Help or the
PowerLogic ION Setup User Guide.

For more information about configuring the PM800 series meters using ION Setup software:

• Additional Device Support in ION Setup in the ION Setup online help

• PowerLogic ION Setup Device Configuration Guide

You can configure the PM800 series meter for switching the ATS into test mode
remotely. See "Configure Auto-Enable Data Logs for CM4000 and PM800 series" on
page 236 for instructions.



Add PM800 Series Meters to a Site in ION Setup
Use ION Setup to add PM850 or PM870meters to the site.

1. In the devices area, right-click and select Insert Item. TheNew Network Item screen
appears.

2. SelectMeter and click OK. TheNew Device screen appears.

3. Select theGeneral tab

4. In the Type list, select PowerLogic PM800 Series Power Meter.

5. Select theDisplay tab. In the Template Options box, select the type of meter you are
adding.

6. Click OK to add themeter.

7. In the Network Viewer (left pane), click themeter icon. The setup screens appear in the
Content Viewer (right pane).

The following image shows a partial list of the setup screens. Use the I/O Setup, Onboard
Alarms/Events, andData Log setup screens to access the parameters that need to be
configured. The remaining topics in this chapter describe the parameter changes that are
required.
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Formore information about adding PM850 or PM870meters to a site in ION Setup, refer to
the following:

• ION Setup online Help

• PowerLogic ION Setup Device Configuration Guide, "PM800 series powermeter" section

• PowerLogic ION Setup User Guide, "Adding and Configuring Devices" section

Configuring Digital and Analog Inputs
This section describes how to configure the digital and analog inputs for the PM800meters.
The instructions assume that you are using separate PM800 series powermeters to record
data for ATSs and generators.

WARNING
UNINTENDED OPERATION

• Do not use themeters for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Refer to your meter's technical documentation for more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Configure Digital Inputs
1. In the Content Viewer, double-click I/O Setup to access the Digital Inputs for themeter.

2. Select the I/O point that you want to configure and click Edit.

The following image shows Digital In A-S1 selected.



3. Update the Label field with a name that ends with the $ character.

The $ character activates the translated device dynamic labeling feature. If the $ 
character is not used, the default label is used.

• For an ATS, examples of labels that conform to the naming convention are EPSS_
Test$, EPSS_Emerg$, EPSS_Norm$, and EPSS_Util$.

• For a generator, examples of labels are EPSS_Start$, EPSS_Run$, and EPSS_
Stop$.

4. SetMode to Normal, Pulse Weight to a non-zero value, for example 100, and leave
Units set as NoUnits.

5. Click OK to update the parameters and to close the dialog.

6. Repeat the steps above for each I/O point that you want to configure.

7. Click Send to save the changes and send the configuration to themeter.

Configure Analog Inputs
PM800 series powermeter Analog Inputs are only available when you install the PM8M2222
Input/Output module on themeter.

Refer to thePowerMeter Input/Output Module PM8M2222, PM8M26, PM8M22 Installation
Manual for more information about installing the input/output module. Obtain this installation
manual at www.powerlogic.com. Select the country, and thenEnergy and Power Quality
Meters > PowerLogic Multifunction Power Meters > PM800 Series > Downloads >
Tech Publications.

1. In the Content Viewer, double-click I/O Setup to access the Analog Inputs for themeter.

2. Select the I/O point that you want to configure and click Edit.

The following image shows Analog In A-AI1 selected.
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3. Click Edit to open the parameter window for the I/O point and update the Label field with a
name that ends with the $ character.

For a generator, examples of labels for analog inputs are Exhaust Gas L$, Exhaust
Gas R$, and Coolant T$.

The following image shows the label updated to Exhaust Gas L$.

4. Click OK to update the parameters and to close the dialog.

5. Repeat the steps above for each I/O point that you want to configure.

6. Click Send to save the changes and send the configuration to themeter.



Configuring Onboard Alarms and Events
For each digital input configured in I/O Setup, you need to configure the alarms to record
when the digital input on an ATS or a generator changes from OFF to ON, and also from ON
toOFF.

Configure Digital Input Alarms for ATSs
This section assumes that you configured digital inputs Digital In A-S1 as EPSS_Test$,
Digital In A-S2 as EPSS_Emerg$, andDigital In A-S3 as EPSS_Norm$. Youmust
configure an alarm for the digital input change from OFF to ON and from ON toOFF.

Digital input change from OFF to ON

Complete the following steps to configure an alarm when a digital input changes from OFF to
ON.

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following figure shows theDigital In A-S1 input selected and its label EPSS_Test$.

4. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

5. Make sure that Enable is selected.

6. In the Label field, change the digital alarm name from Digital In A-S1 to Test ON.
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7. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform
Capture if you want to trigger a waveform capture on alarm.

When the status for EPSS_Test$ changes to ON, Data Log 1 records all channels
currently configured on it.

Digital input change from ON to OFF

Complete the following steps to configure an alarm when a digital input for EPSS_Test$
changes from ON toOFF.

1. Click Add to add another digital input alarm parameter to the list in the left pane of the
Digital Alarm Setup dialog.
If the 12 available digital input alarms have been configured, you need to re-configure an
existing alarm for the ON to OFF status change.

2. Select Status Input Off from the list to set the alarm when the digital input changes from
ON toOFF.



3. Select EPSS_Test$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name to Test OFF.

6. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform
Capture if you want to trigger a waveform capture on alarm.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and
from ON toOFF for all of the applicable I/O points.

The following table summarizes the configuration of the alarms, assuming that the I/O
points are Digital In A-S1, Digital In A-S2, and Digital In A-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Test$ Digital In A-S1 Status Input On Test ON

EPSS_Test$ Digital In A-S1 Status Input Off Test OFF

EPSS_Emerg$ Digital In A-S2 Status Input On EmergON

EPSS_Emerg$ Digital In A-S2 Status Input Off Emerg OFF

EPSS_Norm$ Digital In A-S3 Status Input On Normal ON

EPSS_Norm$ Digital In A-S3 Status Input Off Normal OFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Configuring Digital Input Alarms for Generators
This section assumes that you configured digital inputs Digital In A-S1 as EPSS_Start$,
Digital In A-S2 as EPSS_Run$, andDigital In A-S3 as EPSS_Stop$. Youmust configure
an alarm for the digital input change from OFF to ON and from ON toOFF.

EPSS_Start$: Digital input change from OFF to ON

Complete the following steps to configure an alarm when a digital input changes from OFF to
ON.

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following figure shows theDigital In A-S1 input selected and its label EPSS_
Start$
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4. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

5. Make sure that Enable is selected.

6. In the Label field, change the digital alarm name from Digital In A-S1 toStart ON.

7. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform
Capture if you want to trigger a waveform capture on alarm.

When the status for EPSS_Start$ changes to ON, Data Log 1 records all channels
currently configured on it.



EPSS_Start$: Digital input change from ON to OFF

Complete the following steps to configure an alarm when a digital input for EPSS_Start$
changes from ON toOFF.

1. Click Add to add another digital input alarm parameter to the list in the left pane of the
Digital Alarm Setup dialog. NOTE: If the 12 available digital input alarms have been
configured, you need to re-configure an existing alarm for the ON to OFF status change.

2. Select Status Input Off from the list to set the alarm when the digital input changes from
ON toOFF.

3. Select EPSS_Start$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStart OFF.

6. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform
Capture if you want to trigger a waveform capture on alarm.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and
from ON toOFF for all of the applicable I/O points.

The following table summarizes the configuration of the alarms, assuming that the I/O
points are Digital In A-S1, Digital In A-S2, and Digital In A-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Start$ Digital In A-S1 Status Input On Start ON

EPSS_Start$ Digital In A-S1 Status Input Off Start OFF

EPSS_Run$ Digital In A-S2 Status Input On RunON

EPSS_Run$ Digital In A-S2 Status Input Off RunOFF
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Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Stop$ Digital In A-S3 Status Input On StopON

EPSS_Stop$ Digital In A-S3 Status Input Off Stop OFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Define a Digital Alarm for a Single Digital Input

If a single digital input is used to record signals indicating when the generator is running, and
also when the generator has stopped, you need to define the digital alarm as follows.

1. In theDigital Alarm Setup dialog, select the Digital Input/Output point that will be used
to record the alarm. For example, if you configuredDigital In A-S1with a label of EPSS_
Run$, select this I/O point.

2. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

3. Make sure that Enable is selected.

4. In the Label field, change the digital alarm name from Digital In A-S1 toRun ON.

5. Set Priority to High(1), and select Data Log 1 as the data log to use.

EPSS_Run$: Digital input change from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of the
Digital Alarm Setup dialog.

2. Select Status Input Off from the list to set the alarm when the digital input changes from
ON toOFF.

3. Select EPSS_Run$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStop ON.

6. Set Priority to High(1), and select Data Log 1 as the data log to use.

7. Click OK to close the dialog.

8. Click Send to save the changes and send the configuration to themeter.

As a result of this alarm configuration where EPSS_Run$ represents both the Running and
Stopped states for the generator, whenRun ON is TRUE, the signal is recorded as "1", and
whenStop ON is TRUE, the signal is recorded as "0".

Defining the Data Log Parameters
This section explains how to define data log parameters for the digital inputs, analog inputs,
and load profile data. The instructions assume that you use Data Logs 1 and 2. However, you
can use any Data Log that meets your requirements.



Define Data Log Parameters for Digital Inputs
Complete the following steps to define the data log parameters for the digital inputs.

1. In the Content Viewer, double-click Data Log #1 to open theSetup dialog for the data log
parameters.

2. Set Status to Enable and Interval to Only On Event. TheOnly On Event mode appears as
0 in the Interval field of theSetup dialog.

3. Select Channels, click Edit. The Parameter Selection dialog appears.

4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
EPSS_Emerg$.

5. Select the IO Point xx Digital State, where xx is the number of the I/O point present on
themeter. Click >> to move the parameter to theSelected box.

6. Repeat steps 4 - 5 for all I/O points available for the ATS or generator.
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7. In theAvailable box, expandMiscellaneous and select Present MilliSeconds. Click >>
to move it to theSelected column.

Add all I/O points for a given ATS or generator to the data log to help ensure
that all of the states are recorded in the data log when any state changes.

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Define Data Log Parameters for Analog Inputs and Load Profile Data
Configure the system to log the analog inputs and load profile data automatically when the
generator state changes to Running. When the generator state is Running, the alarm status
for digital input EPSS_Run$ is ON.

Using ION Setup, the process to configure automatic logging is:

1. Associate Data Log 2 with the digital input alarm Run ON that you previously defined for
EPSS_Run$.

2. Select the parameters for the Analog Input data to be logged in Data Log 2.

3. Select the parameters for the Load Profile data to be logged in Data Log 2.

4. Set the status of Data Log 2 to Auto-Enable.

These steps assume that you use Data Log 2.

Associate Data Log 2 with the Digital Input Alarm Run ON

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select the digital input alarm Run ON that was defined for I/O point EPSS_Run$. You
previously selected Data Log 1 when you configured this digital input alarm for the
generator.

4. In theData Logs: group, select 2. Now both 1 and 2 are selected.



5. Click OK to close the dialog.

6. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Analog Input Data to be logged in Data Log 2

1. In the Content Viewer, double-click Data Log #2 to open theSetup dialog for the data log
parameters.

2. Select Interval and click Edit to open theEnter Logging Interval dialog. Select
Continuous from the list inMode, set Interval to 1minute, and click OK to close the
dialog.

3. Select Channels, click Edit. The Parameter Selection dialog appears.
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4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
Exhaust Gas L$.

5. UnderAnalog Input, select the IO Point xx Analog Input Value, where xx is the
number of the I/O point present on themeter. Click >> to move the parameter to the
Selected box.

6. Repeat steps 4 - 5 for each analog input available for the generator.

7. Click OK to close the dialog.

8. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Load Profile Data to be logged in Data Log 2

1. In theSetup dialog for Data Log 2, select Channels and click Edit. TheParameter
Selection dialog appears.

2. Expand each of the following categories. Within each category select the parameters
indicated. For each parameter click >> to move it to theSelected column:

a. InCurrents, select Current A, Current B, Current C, Current N, and Current Avg.

b. InMinimum Readings, select Min Apparent Power Total, Min Real Power Total.

c. InMiscellaneous, select Frequency.

d. InPowers, select Real Power Total and Apparent Power Total.

e. InVoltages, select Voltage A-B, Voltage B-C, Voltage C-A, Voltage L-L Avg, Voltage
A-N, Voltage B-N, Voltage C-N, and Voltage L-N Avg.



3. Click OK to close the dialog.

4. Click Send to save the changes and send the configuration to themeter.

Set the Status of Data Log 2 to Auto-Enable

Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs.
Data is recorded in the data log at a defined interval if the loggingmode is set to
Continuous. Logging stops when the alarm ends.

1. In theSetup dialog for Data Log 2, select Status and click Edit. TheSelect Status dialog
appears.

2. In the drop-down list, select Auto-Enable and click OK to close the dialog.

3. Click Send to save the changes and send the configuration to themeter.

You can also use Vista to set a Data Log to Auto-Enable. Refer to "Configure Auto-Enable
Data Logs for CM4000 and PM800 series" on page 236 for more information.
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Configure Remote ATS Test Mode for PM800 Series Meter
Switching an ATS to test mode remotely is done by linking a control object in a Vista diagram
to a digital output on the PM800 series meter that is connected to the ATS controller.

Refer toStruxureWare PowerMonitoring Expert User Guide for more instructions on working
with Vista diagram control objects.

For details about configuringmodules, refer to ION Reference.

NOTE: The EPSS ATS framework must be deployed to themeter and configured before you
can set up the framework for ATS remote switching. For instructions, refer to "Deploying
ATS Frameworks for EPSS" on page 182.

Configure the Digital Output
Configure the onboard KY output for themeter as follows:

1. In ION Setup for themeter, click I/O Setup. TheGateway Site screen appears.
2. In theParameters box, select Digital Out KY and click Edit.

3. In theMode field, select Normal.

Themode is dependent on the characteristics of the digital input port on the ATS
controller.

4. In theControl field, select Externally Controlled.

This allows themeter to accept external commands from an application like Vista.

5. Click OK. TheGateway Site screen appears.

6. Select Send to update themeter.

Configure the Vista Diagram for themeter, as described next.



Configure the Vista diagram
Follow these steps for the PM800 powermeter. Make sure Designer is closed before linking
any objects in Vista.

In Vista, open a new diagram and complete the setup as follows:

1. Open a new diagram in Vista.
2. Drag a Control object from the Toolbox and link it to KY Energize, as shown next.

3. Right-click the Control object.

4. On theAction tab, set the Level to Operate field to Controller, and click OK.

5. Drag another Control object from the Toolbox and link it to KY DeEnergize.

6. Right-click the Control object.

7. On theAction tab, set the Level to Operate field to Controller, and click OK.

8. Drag a Status object and link it to the Standard KY Digital Output Status, as shown next.
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9. Save the diagram. The following image is an example of the Vista diagram.

You can now use the diagram to control and view the state of the onboard digital output port.

Configuring CM3000 and CM4000 Series Meters
This section describes how to configure CM3000 and CM4000 series meters for the system.



To obtain theCM3000 InstallationManual, CM3000 ReferenceManual, and related
instructions, go to www.powerlogic.com and search for "cm3000 installation." 

To obtain instructions for installing and configuring CM4000 series meters, go to
www.powerlogic.com. Select the country, and thenEnergy and Power Quality Meters >
PowerLogic Energy and Power Quality Meters > CM4000 > Downloads > Tech
Publications.

• InstallationManual

• ReferenceManual

• Series 4000T ReferenceManual

• I/O Extender and Input/Output Option Card

You can configure the CM4000 series meter for switching the ATS into test mode
remotely. See "Configure Auto-Enable Data Logs for CM4000 and PM800 series" on
page 236 for instructions.

Add CM4000 Series Meters to a Site in ION Setup
Complete the following steps to add CM4000 series meters to a site in ION Setup.

1. In the Network Viewer, right-click the workstation icon and select Insert Item > Site. The
New Site dialog appears.

2. Add a name to identify the site, select Ethernet, and click OK. The new site appears in
the Network Viewer.

3. In the Network Viewer, right-click the new site name and select Insert Item > Meter. The
New Device dialog appears.

4. Complete the following:

Name - Enter a name to identify themeter.

Type - Select Modbus TCP Device from the dropdown list.

IP Address - Enter the IP address for theModbus TCP.

Port - Select 502 from the dropdown list.

Group - Select a group name from the list or enter a name to define a new group.
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5. Click theDisplay tab and select the CM4000 (EPSS) template option.

6. Click OK. Themeter is added to the Network Viewer.

7. In the Network Viewer, click themeter icon. The setup screens appear in the Content
Viewer.

The following image shows the setup screens. Use the I/O Setup, Onboard
Alarms/Events, andData Log setup screens to access the parameters that need to be
configured. The remaining topics in this chapter describe the parameter changes that are
required.

Configuring Digital and Analog Inputs
This section describes how to configure digital and analog inputs to record data on CM4000
series powermeters for the ATSs and generators.

Configure Digital Inputs
In the Content Viewer, double-click I/O Setup to access the Digital Inputs for themeter.

1. Select the I/O point that you want to configure and click Edit.
The following image shows Dig In B-S1 selected.



2. Update the Label field with the name that ends with the $ character.

The $ character activates the translated device dynamic labeling feature. If the $ 
character is not used, the default label is used.

• For an ATS, examples of labels that conform to the naming convention are EPSS_
Test$, EPSS_Emerg$, EPSS_Norm$, and EPSS_Util$.

• For a generator, examples of labels are EPSS_Start$, EPSS_Run$, and EPSS_
Stop$.

3. SetMode to Normal, Pulse Weight to a non-zero value, for example 100, and leave
Units set as NoUnits.

4. Click OK to update the parameters and to close the dialog.

5. Repeat the steps above for each I/O point that you want to configure.

6. Click Send to save the changes and send the configuration to themeter.

Configuring Analog Inputs
In the Content Viewer, double-click I/O Setup to access the Analog Inputs for themeter.

1. Select the I/O point that you want to configure and click Edit.
The following image shows Alog In C-AI1 selected.
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2. Click Edit to open the parameter window for the I/O point and update the Label field with a
name that ends with the $ character.

For a generator, examples of labels for analog inputs are Exhaust Gas L$, Exhaust
Gas R$, and Coolant T$.

The following image shows the label updated to Exhaust Gas L$.

3. Click OK to update the parameters and to close the dialog.

4. Repeat the steps above for each I/O point that you want to configure.

5. Click Send to save the changes and send the configuration to themeter.



Configuring Onboard Alarms and Events
For each digital input configured in I/O setup, configure the alarms to record when the digital
input on an ATS or a generator changes from OFF to ON, and also from ON toOFF.

Configure Digital Input Alarms for ATSs
This section assumes that you configured digital inputs Dig In B-S1 as EPSS_Test$, Dig
In B-S2 as EPSS_Emerg$, andDig In B-S3 as EPSS_Norm$.

Digital input change from OFF to ON

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following figure shows theDig In B-S1 input selected and its EPSS_Test$ label,
configured in I/O Setup.

4. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

5. Make sure that Enable is selected.

6. In the Label field, change the digital alarm name from Dig In B-S1 to Test ON.
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7. Set Priority to High(1), and select Data Log 2 as the data log to use.

When the status for EPSS_Test$ changes to ON, Data Log 2 records all channels
currently configured on it.

Digital input change from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of the
Digital Alarm Setup dialog.

If all 40 available digital input alarms have been configured already, you
need to re-configure an existing alarm for the ON to OFF status change.



2. Select Status Input Off from the list to set the alarm when the digital input changes from
ON toOFF.

3. Select EPSS_Test$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name to Test OFF.

6. Set Priority to High(1), and select Data Log 2 as the data log to use.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and
from ON toOFF for all of the applicable I/O points.

The following table summarizes the configuration of the alarms, assuming that the I/O
points are Dig In B-S1, Dig In B-S2, and Dig In B-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Test$ Dig In B-S1 Status Input On Test ON

EPSS_Test$ Dig In B-S1 Status Input Off Test OFF

EPSS_Emerg$ Dig In B-S2 Status Input On EmergON

EPSS_Emerg$ Dig In B-S2 Status Input Off Emerg OFF

EPSS_Norm$ Dig In B-S3 Status Input On Normal ON

EPSS_Norm$ Dig In B-S3 Status Input Off Normal OFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Configuring Digital Input Alarms for Generators
This section assumes that you configured digital inputs Dig In B-S1 as EPSS_Start$, Dig
In B-S2 as EPSS_Run$, andDig In B-S3 as EPSS_Stop$.

Digital input change from OFF to ON

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following screenshot shows theDig In B-S1 input selected and its EPSS_Start$
label, as configured in I/O Setup.
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4. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

5. Make sure that Enable is selected.

6. In the Label field, change the digital alarm name from Dig In B-S1 toStart ON.

7. Set Priority to High(1), and select Data Log 2 as the data log to use.

When the status for EPSS_Start$ changes to ON, Data Log 2 records all channels
currently configured on it.



Digital input change from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of the
Digital Alarm Setup dialog.

If all 40 available digital input alarms have been configured already, you
need to re-configure an existing alarm for the ON to OFF status change.

2. Select Status Input Off from the list to set the alarm when the digital input changes from
ON toOFF.

3. Select EPSS_Start$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStart OFF.

6. Set Priority to High(1), and select Data Log 2 as the data log to use.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and
from ON toOFF for all of the applicable I/O points.

The following table summarizes the configuration of the alarms, assuming that the I/O
points are Dig In B-S1, Dig In B-S2, and Dig In B-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Start$ Dig In B-S1 Status Input On Start ON

EPSS_Start$ Dig In B-S1 Status Input Off Start OFF
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Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Run$ Dig In B-S2 Status Input On RunON

EPSS_Run$ Dig In B-S2 Status Input Off RunOFF

EPSS_Stop$ Dig In B-S3 Status Input On StopON

EPSS_Stop$ Dig In B-S3 Status Input Off Stop OFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Defining a Digital Alarm for a Single Digital Input

If a single digital input is used to record signals indicating when the generator is running, and
also when the generator has stopped, you need to define the digital alarm as follows:

1. In theDigital Alarm Setup dialog, select the Digital Input/Output point that will be used
to record the alarm. For example, if you configuredDig In B-S1with a label of EPSS_
Run$, select this I/O point.

2. Select Status Input On from the list to set the alarm when the digital input changes from
OFF to ON.

3. Make sure that Enable is selected.

4. In the Label field, change the digital alarm name from Dig In B-S1 toRun ON.

5. Set Priority to High(1), and select Data Log 2 as the data log to use.

EPSS_Run$: Digital Input Change from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of the
Digital Alarm Setup dialog.

2. Select Status Input Off from the list to set the alarm when the digital input changes from
ON toOFF.

3. Select EPSS_Run$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStop ON.

6. Set Priority to High(1), and select Data Log 2 as the data log to use.

7. Click OK to close the dialog.

8. Click Send to save the changes and send the configuration to themeter.

As a result of this alarm configuration where EPSS_Run$ represents both the Running and
Stopped states for the generator, whenRun ON is TRUE, the signal is recorded as "1", and
whenStop ON is TRUE, the signal is recorded as "0".

Configure the Data Log Parameters
This section describes how to define data log parameters for the digital inputs, analog inputs,
and load profile data. The instructions assume that you use Data Logs 2 and 3. However, you
can use any Data Log that meets your requirements.



Define Data Log Parameters for Digital Inputs
Complete the following steps to define the data log parameters for the digital inputs.

1. In the Content Viewer, double-click Data Log #2 to open theSetup dialog for the data log
parameters.

2. Set Status to Enable and Interval to Only On Event.

3. Select Channels, click Edit. The Parameter Selection screen appears.

4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
EPSS_Emerg$.

5. UnderDigital Input, select the IO Point xx Digital State, where xx is the number of the
I/O point present on themeter. Click >> to move the parameter to theSelected box.

6. Repeat steps 4 - 5 for all I/O points available for the ATS or generator.

7. In theAvailable box, expandMiscellaneous and select Present MilliSeconds. Click >>
to move it to theSelected box.
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Add all I/O points for a given ATS or generator to the data log to help ensure
that all of the states are recorded in the data log when any state changes.

8. Click OK to close the screen.

9. Click Send to save the changes and send the configuration to themeter.

Define Data Log Parameters for Analog Inputs and Load Profile Data
Configure the system to log the analog inputs and load profile data automatically when the
generator state changes to Running. When the generator state is Running, the alarm status
for digital input EPSS_Run$ is ON.

Using ION Setup, the process to configure automatic logging is:

1. Associate Data Log 3 with the digital input alarm Run ON that you previously defined for
EPSS_Run$.

2. Select the parameters for the Analog Input data to be logged in Data Log 3.

3. Select the parameters for the Load Profile data to be logged in Data Log 3.

4. Set the status of Data Log 3 to Auto-Enable.

These steps assume that you use Data Log 3.

Associate Data Log 3 with the Digital Input Alarm Run ON
1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.
2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select the digital input alarm Run ON that was defined for I/O point EPSS_Run$. You
previously selected Data Log 2 when you configured this digital input alarm for the
generator.

4. In theCapture on Event list, select Data Log 3. Now both Data Logs 2 and 3 are
selected.



5. Click OK to close the screen.

6. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Analog Input Data to be logged in Data Log 3
1. In the Content Viewer, double-click Data Log #3 to open theSetup dialog.
2. Select Interval and click Edit to open theEnter Logging Interval dialog.

3. In theMode list, select Continuous. Set Interval to 1minute, and click OK to close the
dialog.
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4. Select Channels, click Edit. The Parameter Selection screen appears.

5. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
Exhaust Gas L$.

6. Under Analog Input, select the IO Point xx Analog Input Value, where xx is the
number of the I/O point present on themeter. Click >> to move the parameter to the
Selected box.

7. Repeat steps 4 - 5 for each analog input available for the generator.

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.



Select Parameters for Load Profile Data to be logged in Data Log 3
1. In theSetup dialog for Data Log 3, select Channels and click Edit. TheParameter

Selection dialog appears.
2. Expand each of the following categories. Within each category, select the parameters

indicated. For each parameter click >> to move it to theSelected column:

a. InCurrents, select Current A, Current B, Current C, Current N, and Current Avg.

b. InMinimum Readings, select Min Apparent Power Total, Min Real Power Total.

c. InMiscellaneous, select Frequency.

d. InPowers, select Real Power Total and Apparent Power Total.

e. InVoltages, select Voltage A-B, Voltage B-C, Voltage C-A, Voltage L-L Avg, Voltage
A-N, Voltage B-N, Voltage C-N, and Voltage L-N Avg.

3. Click OK to close the dialog.

4. Click Send to save the changes and send the configuration to themeter.

Set the Status of Data Log 3 to Auto-Enable
Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs.
Data is recorded in the data log at a defined interval if the loggingmode is set to
Continuous. Logging stops when the alarm ends.

1. In theSetup dialog for Data Log 3, select Status and click Edit. TheSelect Status dialog
appears.

2. Select Auto-Enable in the dropdown list and click OK.
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3. Click Send to save the changes and send the configuration to themeter.

You can also use Vista to set a Data Log to Auto-Enable. See "Configure Auto-Enable Data
Logs for CM4000 and PM800 series" on page 236.

Configure Auto-Enable Data Logs for CM4000 and PM800 series
This section explains how to use Vista to configure the data logs for PM800 Series Meters
and the CM4000 Series Meters for auto-enable.

Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs.
Data is recorded in the data log at a defined interval if the loggingmode is set toContinuous.
Logging stops when the alarm ends. The following instructions assume that you associated
Data Log 2 with the digital input alarm Run ON for the purpose of logging the analog inputs
and load profile data.

For information about using ION Setup to set a Data Log to Auto-Enable, see:

• For PM800 series meters, see "Set the Status of Data Log 2 to Auto-Enable" on page 217.

• For CM4000 series meters, see "Set the Status of Data Log 3 to Auto-Enable" on page
235.

Use Vista to Set a Data Log to Auto-Enable
Complete the following steps to use Vista to set the status of Data Log 2 to Auto-Enable.

1. Open Vista and select File > New to open an empty workspace.
2. Ensure that the Toolbox is open. If not, select Options > Show Toolbox.

3. In the Toolbox, select aControl Object and drag it to the workspace.

4. Right-click the control object. TheControl Object Configuration screen appears.



5. Click the Link tab. In the Link area, select Custom, and then click Edit Link. TheCreate
Link screen appears.

6. In theNodes list, double-click themeter name. The associatedmodule directories appear
in theManagers list.

7. In theManagers list, double-click Resets and Triggers.

8. In theModules list, double-click Log Auto-Enables.

9. In theOutput Registers list, select Data Log 2 Auto-Enable.

10.Click OK to save the selection and to close the screen.

11.Double-click the control object in the workspace to set Data Log 2 on themeter to Auto-
Enable.

Verify that Data Log 2 has been set to Auto-Enable
You can verify that Data Log 2 has been set to Auto-Enable by adding a numeric object to the
workspace and linking it to a setup register for the Data Log.

1. In Vista, ensure that the Toolbox is open. If not, select Options > Show Toolbox.
2. In the Toolbox, select aNumeric Object and drag it to the workspace.

3. Right-click the numeric object. TheNumeric Object Configuration screen appears.
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4. Click the Link tab. In the Link area, select Custom and press theCtrl key while clicking
Edit Link. TheCreate Link screen for Setup Registers.

5. In theNodes list, double-click themeter name. The associatedmodule directories
appears in theManagers list.

6. In theManagers list, double-click Data Recorders.

7. In theModules list, double-click Data Log 2.

8. In theSetup Registers list, select RE2 Enabled.

9. Click OK to save the selection and to close the screen.

When the numeric object displays "Auto," you have confirmation that Data Log 2 has been
set successfully to Auto-Enable by the control object.



Configuring Momentum PLC
This chapter describes how to configureMomentum PLC for the system.

For information about installing and configuringMomentum PLC, see the PLC's
documentation at www.powerlogic.com.

WARNING
UNINTENDED OPERATION

• Do not use theMomentum PLC with either PowerMonitoring Expert or ION Setup for
critical control or protection applications where human or equipment safety relies on the
operation of the control circuit.

• Refer to your PLC's technical documentation for more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Add a Momentum PLC to a Site
Use ION Setup to add eachMomentum PLC to a site.

1. In the Network Viewer, right-click the workstation icon and select Insert Item > Site. The
New Site screen appears.

2. Complete the fields to define the new site:

• Name - Add a name to identify the site.

• Comm Link - Select Ethernet.

• Ethernet Options - Select Gateway.

• IP Address - Enter the IP Address for the device.

• Port - Select 502.

3. Click OK to add the site. The new site appears in the Network Viewer.
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4. In the Network Viewer right-click the site name and select Insert Item > Meter. TheNew
Device screen appears.

5. Complete the fields to define the PLC:

• Name - Enter a name to identify the device.

• Type - Select Modbus RTU Device from the dropdown list.

• Unit ID - Enter the unit ID for the device.

• Group - Select a group name from the list or enter a name to define a new group.

6. Click theDisplay tab and select theMomentum PLC D16 (EPSS) template option.

7. Click OK to add the PLC to the site.

After a PLC has been added, click its icon in the Network Viewer to display the setup
screens in the Content Viewer. The following image shows a partial list of the setup screens.



The remaining topics in this chapter describe how to configure the parameters for theClock
Setup, Data Log andStatus Input setup screens.

Setting the Clock
Follow these steps to set or adjust the date and time for the PLC's clock.

1. In the Content Viewer, double-click Clock Setup. TheClock Setup screen appears.
The first time you access this screen, the label under theSelect column is "Device time"
and theDate/Time column shows the current time on the PLC.

2. Select the Date/Time entry and click Edit. TheDate/Time Setup screen appears.

3. Set the desired date and time in theMeter Date andMeter Time fields.

4. Click OK. TheDate/Time Setup screen closes.

The "Device time" label changes to "Update to" and is automatically selected. The check
mark indicates that the new date and time value will be sent to the PLC when you click
Send.
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If you clear the check box, the date and time entry reverts to the time currently configured
on the PLC.

Configuring Status Inputs
Follow these steps to configure the status inputs onMomentum PLCs so that data about the
states of the ATSs and generators is recorded.

1. In the Content Viewer, double-click Status Input 1. TheStatus Input 1 screen appears.

2. In theParameters box, select Type and click Edit. TheSelect Type screen appears.



3. In the Type box, select Dual(Form "C") and click OK. This parameter generates an
event for both the leading and trailing edges of the signal.

4. Select Invert and click Edit. TheSelect Invert screen appears.

5. In the Invert box, select No and click OK.

6. Select Log File and click Edit. TheSelect Log File screen appears.

7. In the Log File box, select the data log for the status input and click OK.

8. Click Send to save the changes and send the configuration to the PLC.

Keep track of these status inputs for correct mapping to the ATS and generator states
through theGenerator Test Module EPSS. Status inputs for ATSs need to be set to Test,
Emergency, and Normal states. For generators, they need to be set to Run and Stop states.

For example, the following table shows the relationship of Status Inputs on the PLC to the
settings that are applied through theGenerator Test Module EPSS.

Momentum PLC EPSS Generator Test Module
Slot Position Status Inputs EPSS Device State

1 Status Input 1
ATS1

Test
2 Status Input 2 Normal
3 Status Input 3 Emergency
4 Status Input 4

GEN1
Run

5 Status Input 5 Stop
… … … …

Defining Data Log Parameters for Status Inputs
Complete these steps to define the data log parameters for the Status Inputs.

1. In the Content Viewer, double-click Data Log x, where x is the number for the datalog.
TheSetup screen appears.

2. Select the following parameters and click Edit to configure them in the Parameter
Selection screen:

• Set Status to Enable.

• Set Records to a non-zero value.

• Set Interval to Only On Event.
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3. Select Channels, click Edit.

4. In theAvailable box, navigate toStatus Inputs.

5. ExpandStatus Inputs, select an EPSS input state, such as EPSS Input 1 State, click
>> to move it to theSelected column.

6. Repeat steps 4 and 5 for all status inputs available for the ATSs or generators.

7. ExpandReal-Time Clock, selectMilliSeconds and click >> to move it to theSelected
column.

8. Click OK.

9. Repeat steps 1 through 8 for all of the Data Logs that you want to configure.

10.Click Send to save the changes and send the configuration to the PLC.



Configuring Digital Outputs
The standardMomentum PLC device driver does not support the configuration of digital
outputs. However, you can use theModbus Device Importer (MDI) to define and configure
digital outputs.

The following information assumes that you already configured an Ethernet Gateway site in
Management Console and that you added a device to the site. For more information, see
Setting UpDevices for Ethernet Gateway Communications in the online help for
Management Console or in theStruxureWare PowerMonitoring Expert User Guide.

Configure Digital Outputs in MDI
Complete these steps Modbus Device Importer (MDI) to define and configure digital outputs
on the PLC.

Before proceeding, make a backup copy of theMomentum PLC map and tree files
Momentum_PLC_D16_EPSS.xml andMomentum_PLC_D16_EPSS.ion, respectively.
These files are located in the ..\Schneider Electric\system\translators\ folder.

1. In Management Console, select Tools > System > Modbus Device Importer. The
MDI main console appears.

2. Open the existingMomentum PLC driver configuration:

a. Select File > Open and browse to C:\Program Files (x86)\Schneider Electric\Power
Monitoring Expert for Healthcare\system\translators.

b. Select Momentum_PLC_D16_EPSS.ion.

c. Click Open. The register details appear in MDI.

3. Under ION Map Information, right-click Momentum_PLC_D16_EPSS and select New
Manager. TheAdd New Manager screen appears.

4. In theManager Name box, enterDigital Outputs. In theManager Type box, select
External Boolean Manager. Click OK.

5. Under ION Map Information, right-click Digital Outputs and select New Module. The
Add New Module screen appears.
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6. In theModule Name box, replaceExt Bool 1with the correct name, and click OK. In this
example, CR6 is entered.

7. Under ION Map Information, right-click CR6 and select New Register. TheEdit
Boolean_Register screen appears.

8. Update the values forRegister Label, Register Type,Modbus Address, andReset
Type and click OK. An example is shown next.

Use Copy to create other module and register entries
You can createmultiple module and register entries by usingCopy andPaste operations.

1. Right-click amodule name and select Copy.
2. Right-click Digital Outputs and select Paste to add a copy of themodule and registry

entries.

3. To change themodule name, right-click themodule, select Advanced Properties,
change the name for themodule, and click OK.

4. To change the register values in theModbus Register Information area:

• Label - In the Label column, double-click the register name. Change the label and press
Enter.

• Address - Double-click theModbus register address. Change the address and press
Enter.

5. Repeat steps 1 through 4 above to create and update additional modules.

The following image shows an example of completed entries in theMDI console.



TheModbus registers shown abovemay not match your system. Adjust
the values tomatch your particular Modbus map.

6. Select File > Save to save your changes.

7. Select Tools > Update Device Type to add the configuration to theMomentum PLC.

Create a Control Object and Status Object in Vista
Complete these steps to link a Control Object and a Status Object to anOutput Register that
you defined in theMDI.

1. Open Vista and select File > New to open an empty workspace.
2. Ensure that the Toolbox is open by clickingOptions > Show Toolbox.

3. Select aControl Object in the Toolbox and drag it to the workspace.

4. Right-click the control object. TheControl Object Configuration screen appears.

5. Select the Link tab.
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6. Under Link, select Custom and ION.

7. Under Label, select Custom and enter a label for the control object.

8. Under Link, click Edit Link. TheCreate Link screen appears.

a. In theNodes box, double-click the PLC name. Themodule directories appear in the
Managers box.

b. In theManagers box, double-click Digital Outputs

c. In theModules box, double-click CR6.

d. In theOutput Registers box, select Coil 27.



e. Click OK to save the selection and to close the screen.

9. In theWorkspace, select aStatus Object in the Toolbox and drag it to the workspace.

10.Right-click the status object. TheStatus Object Configuration screen appears.

11.Select the Link tab.

12.Under Link, select Custom and ION.

13.Under Label, select Use node label.

14.Under Link, click Edit Link. TheCreate Link screen appears.

15.Repeat steps a. through e. above.

16.Save the diagram. The following image is an example of the Vista diagram.

You can now use the Control Object to initiate a state change remotely.
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Configuring SER-2408/SER-3200
The SER-2408/SER-3200 Sequence of Event Recorders can be used with the software to
record status changes of the ATS and generator contacts in the onboard data logs.

SER3200 are recommended for PowerMonitoring Expert - Data Center Edition.

The process to set up the SER-2408/SER-3200 with PowerMonitoring Expert includes these
steps:

1. Install hardware and configure device communications and digital inputs.
The SER-2408/SER-3200 can be configured using the integral webserver of the device.
Enter the IP address of the device in the browser to open the setup page. Refer toSER-
3200/SER-2408 Instruction Bulletin: User's Guide for instructions.

Perform the following steps from theSER-3200/SER-2408 Instruction Bulletin: User's Guide
before proceeding:

2. In your browser, enter your device IP address and press Enter. Log in using your Login ID
and password.

3. Click SETUP, and then click Time. Set the time/clock correctly for your location.

4. Click SETUP, and then click Inputs. Configure all necessary inputs and select the
Enabled check box next to each input. When finished, click Apply.



5. Click SETUP, and then click Groups. Assign a group to each input. When finished, click
Apply.

6. Make sure that you enable logging for all above groups.

NOTICE
UNINTENDED OPERATION

Make sure to enable the logs in the groups section when configuring the device.

Failure to enable the logs in the groups section will result in the inputs not being
available and not appearing in the Generator Performance Tool.
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Formore information on configuring the communications and digital inputs for this device,
see theSER-3200/SER-2408 Instruction Bulletin: User's Guide located on the Power
Monitoring Expert DVD.

7. Add the device in Management Console.

8. Open Vista to verify communications.

9. Use theGenerator Performance Configuration Tool to assignmeasurements for
generators or ATS equipment.

See the following sections for instructions on step 2 - 4.

After you complete the above steps, you can generate the EPSS or Generator Test Report
for data recorded by the SER-2408/SER-3200.

WARNING
UNINTENDED OPERATION

• Do not use the SER-2408/SER-3200 with either PowerMonitoring Expert or ION Setup
for critical control or protection applications where human or equipment safety relies on
the operation of the control circuit.

• Refer to your powermeter's technical documentation located on the product DVD for
more information on its operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Adding the SER-2408/SER-3200 to Management Console
In Management Console, add the SER-2408/SER-3200 as an Ethernet device.

For proper operation, the devicemust have theUnit ID value set to 1.

Follow these steps to set the deviceUnit ID:

1. As you enter the device details in the Ethernet Device Configuration screen, right-click the
screen and click Advanced.



The Advanced Properties for the device appear.

2. In the Unit ID field, enter 1.
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3. Click OK.

4. Verify the device status is "Device Connected" as shown next.

Verify Device Communications in Vista
After you add the device toManagement Console, you can open Vista to view the device's
counter, input\output status, and data logs.

The following examples show the device diagram and recorded data details.

Power Monitoring Expert 8.1 ApplicationModules

© 2016 Schneider Electric. All rights reserved. Page 255



Power Monitoring Expert 8.1 ApplicationModules

Page 256 © 2016 Schneider Electric. All rights reserved.

Assign Measurements for Generators or ATS Equipment
After device data is logged into the database, you can assign devicemeasurements using
the Generator Performance Configuration ToolGenerator Performance Configuration Tool
with EPSS Test Module.



Add the device and select themeasurements for the generator or ATS, as explained in these
sections:

• "Define Generators for EPSS" on page 42

• "Define Generators" on page 91

• "Define Transfer Switches for EPSS" on page 51

The required status measurements for the SER-2408/SER-3200 SER3200 are “Digital Input
Status X” where X = input of the SER-2408/SER-3200 SER3200. On theGenerators tab,
the selected source andmeasurement are similar to the following example.
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Interpreting the Energy Regression Analysis Report
results

The Energy Regression Analysis Tool is a highly configurable tool that allows you tomonitor
andmanage a building or facility’s energy and resource consumption. This practice, called
energy modeling, involves analyzing building energy systems, monitoring energy
consumption, and detecting anomalies or changes in system behavior that may require that
you perform energy efficiency upgrades or fixes. The Energy Regression Analysis Report
allows you tomodel energy data one independent variable at a time with a wide range of
desired independent variables, such as weather or occupancy rate.

It is recommended that users have a basic understanding of energy modeling and understand
how to create an Energy Regression Analysis Report. This section discusses in detail the
purpose of each parameter in the report and how to read and interpret meaningful results of an
Energy Regression Analysis Report. After generating the report, conclusions can be drawn
from the generated tables and charts to monitor energy consumption andmake cost saving
decisions.

Energy Regression Analysis Report results provide a characterization of a building's
performance. You can perform different types of energy analysis with this information,
including the following:

• Energy Benchmarking

• Energy Budgeting

• Energy Savings

Glossary of terms
Term Definition

Cooling Degree Days (CDD) Measurement designed to reflect the demand for energyneeded to
cool a building.

Cost SavingsAnalysis Comparing energyprofiles against expected profiles and identifying
outlying data that maysignify areasof improvement.

Degree Day One degree of departure, on a single day, of the dailymean
temperature from a given standard temperature.

EnergyBenchmarking Comparing the energyperformance of similar buildings, or comparing
the energyperformance of a single building over time.

EnergyBudgeting Determining future energyuse and associated costs for different times
of the year.

EnergyModeling Computerized simulation of a building that focuseson energy
consumption, utility bills and life cycle costs of variousenergy related
itemssuch asair conditioning, lights and hot water.

EnergySavings Measuring savingsby comparing performance profiles before and after
energyefficiencymodifications.
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EnergyUse Breakdowns Disaggregating building energy into different categories, such as
weather-dependent energyuse or weather-independent energyuse.

Heating Degree Days (HDD) Measurement designed to reflect the demand for energyneeded to
heat a building.

Performance (Regression) Line The statistical line of best fit .

Regression Analysis Statistical process for estimating the relationshipsamong variables.
Includesmany techniques for modeling and analyzing several variables,
when the focus is on the relationship between a dependent variable and
one or more independent variables.

Reading the report
This section discusses how to read the different types of information in the report.

For information on how to configure and use this report, see "Configure andGenerate the
Energy Regression Analysis Report" on page 27.

Report Parameters Summary table
The Report Parameters Summary table appears at the beginning of the report. Based on
what you select for theShow Report Parameters Summary option on the prerequisite
page, you canmake this table appear or be hidden in the report.

This table provides important details, such as data sources, calculationmethods, and other
parameters about how the report inputs are configured that can help the user understand
report results.

Regression Analysis Chart
The Regression Analysis Chart shows the relationship between the driver andmodel data.

In this chart, the blue dots represent real data points. In this case, the data is aggregated
weekly over the course of one year, therefore, there are 52 data points with each data point
representing one week of the year. The yellow line is the regression line, or performance line,
of the building. The performance (regression) line is the best fit line--a line that indicates the
expected energy consumption. The slope of the performance line is ameasure of how much
extra fuel, energy, or other resource is consumed for an increase in the independent variable
(such as degree days, production units, and so forth).



Deviations between building performance lines over timemeans that something has
changed in the way the facility consumes energy. This may be a result of energy efficiency
modifications, or it could indicate an issue with building systems, equipment, or processes.
The performance line provides a benchmark by which changes in energy consumption can
bemonitored, and appropriate actions can be taken if variations are detected.

The point of intersection between the two performance lines is called the breakpoint. For
energy consumption analyzed with respect to average temperature, the breakpoint indicates
the temperature at which heating or cooling of a facility begins. Therefore, having a
breakpoint further to the right is better because this indicates that heating or cooling systems
are running for less time, which results in less energy usage.

Regression Analysis Main Characteristics Table
The Regression Analysis Main Characteristics Table provides information about the
Regression Analysis Chart.
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TheSide column shows the left and right sides. TheSlope column shows the slope values
of the two best-fitting lines intersect.. This intersection point is called the breakpoint. TheY-
Intercept column shows a point where the graph of a function or relation intersects with the
y-axis of the coordinate system. Therefore, these points satisfy x = 0.

TheR2 column shows a value that indicates how well the data fits themodel. TheRMSE
column shows the square root of themean/average of the square of all of the error. The
X Value andY Value columns show the coordinates of the Change point.

Monitoring the slopes and breakpoint values provides useful information about a facility’s
energy consumption. Flatter slope lines are better as they indicate a smaller increase in
energy consumption for every additional unit of the independent X-axis variable.

For more information on interpreting the report results, see "Interpreting the report" on page
264.

Measured Values Against Expected Values Chart
TheMeasured Values Against Expected Values Chart shows the relationship between the
model data and time.

In this chart, the blue line indicates the real energy usage over time and the performance line
indicates the expected energy usage over time based on the regression analysis.

The time axis, or X-axis, has different units depending on the selected aggregation period.
For weekly aggregation, the numbers on the X-axis represent the weeks of the year and for
daily aggregation, they represent the days of the year. The year or years contained within the
reporting period are displayed on the chart directly below the X-axis values.



Exceptions Table
The Exceptions Table below shows information for any data point that falls outside of the
exception range defined by the Deviation Type andMax Authorized Deviation parameters.

If there are no exception points, this table does not appear in the report.

Full Table
The Full Table below shows information for all data points.

Within the Full Table, there is a row with missing values.
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This row stores information about the breakpoint from the Regression Analysis Chart.

This report generates with almost any set of data and regardless of other parameter
selections. However, the generated report is only of assistance inmonitoring energy
consumption if the parameters are configured correctly and with specific intent.

The following section provides specific examples of how to use the Energy Modeling Report
to monitor certain aspects of a facility’s energy consumption.

Interpreting the report
After generating the report, the data can be analyzed in different ways to draw different
conclusions about energy and resource consumption. Below are two examples involving
different independent variables.

Example 1: Justifying Energy Efficiency Upgrades
Regression analysis of energy or resource consumption with respect to Degree Days can
provide valuable information about a facility’s energy efficiency with respect to outside
changes in temperature. Such information can be used to determine when energy efficiency
upgrades are necessary, and tomonitor the effectiveness of such solutions after
implementation.

For example, a facility manager could compare the Heating Degree Day energy profile of
their building to another facility in a similar climate. If the other building proves to bemuch
more energy efficient, an analysis could be performed on the differences in building design
that could cause these results. Perhaps the only significant difference is that themore
efficient building recently upgraded their insulation. The less efficient building could then use
this information, along with the Regression Analysis charts to pitch the case that an
insulation upgrade should take place to reduce natural gas usage at the facility.

If the upgrade is successful, a change appears in the Regression Analysis chart the following
year. The chart above shows a possible Regression analysis for the year before the energy
efficiency modifications. The red line in the chart shows how the performance lines and
breakpoint could change when the upgrades are successful. The slopes of the lines in the



second figure are flatter, indicating less energy usage for every additional degree day. The
breakpoint also occurs later, indicating that heating does not have to begin at as low of a
temperature as before, thereby saving additional resources.

Example 2: Identifying Equipment Failure
Regression analysis can also be used to detect equipment deterioration or failure. Below are
two Regression Analysis charts showing natural gas consumption with respect to production
units.

The red line in the chart has a steeper slope and an earlier X-axis intersection point. This
indicates that more natural gas is being used for every unit of production. If data for these
charts is collected over different periods of time, but with no changes tomanufacturing
processes or equipment, the steeper regression line in the second chart could indicate
deterioration of equipment.

Plotting energy consumption data against any independent variable, not just time, allows you
to analyze in greater detail the energy efficiency of your buildings or facilities, and tomake
necessary upgrades or cost analysis decisions.

Conclusion
Energy modeling is a relatively new practice for monitoring and analyzing energy
consumption in buildings and facilities. It involves using computerized simulations to
analyze energy consumption, and it allows customers to understand their expected energy
consumption and use this information tomake system design decisions and perform cost
benefit analysis.

The Energy Modeling Report, or XY Regression Report, allows users to create energy
profiles for their buildings or facilities. These benchmark energy models provide valuable
information about energy and resource consumption that can help facility managers identify
and address consumption issues in order to save resources.

Recommendations
Many of the report parameters on the prerequisite page are interdependent and configuring
this page requires close attention. It is recommended to rely on documentation to correctly
configure the report. Note that there is no filtering of parameters on the prerequisite page.
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Generator System Redundancy Types
You can create a generator system to achieve power redundancy for IT equipment loads in
different ways, depending on how the generators are grouped together and how they are
connected to the equipment power supplies. This configuration tool supports several industry
standard configurations.

The generator system supports the following redundancy design types:

"N Type"

"N+1 Type"

"N+2 Type"

"2N Type"

"2(N+1) Type"

"2(N+2) Type"

Before generator-related reports can be produced you need to define a generator system in
the Generator Power Configuration Utility.

N Type
The N system configuration is for one or more generators that work together to supply power
to the IT load, when the utility or utilities’ power is unavailable. There is no redundancy. The
intention is to size the generator system tomatch the peak IT load on the utility power.



N+1 Type
The N+1 system configuration is for one or more generators that work together to supply
power to the IT load. There is simple generator redundancy in that one of the generators can
stop functioning or be taken off-line, in the event that the utility power is interrupted. The load
is spread among all generators, but the peak load is such that if one generator stops working,
the others will be able to assume its load. Another way to look at it is, N generators will be
able to support the peak IT load. If the peak IT load is more than N can support, then system
design redundancy will be lost.

For example, if three generators are connected to the IT loads, in an N+1 system, the peak
utility loadmust not exceed the non-redundant capacity of two of the generators. If it does,
the designed redundancy will be lost.

N+2 Type
The N+2 system configuration is for a group of generators that work together to supply power
to amedium voltage substation and is then distributed to low voltage loads. There is simple
generator redundancy in that any two of the generators can stop functioning or be taken off-
line, in the event that the utility power is interrupted. The load is spread among all generators,
but the utility peak load is such that if two generators stop working, the others will be able to
assume their load. Another way to look at it is, N generators will be able to support the peak
utility load. If the peak utility load is more than N can support, then system design
redundancy will be lost.

For example, if five generators are connected to the IT loads, in an N+2 system, the peak
utility loadmust not exceed the non-redundant capacity of three of the generators. If it does,
the designed redundancy will be lost.
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2N Type
The 2N system configuration is for two groups of generators that supply power to the IT
loads. In a 2N system, an entire group of generators can stop functioning or be taken off-line
and the equipment will still be supplied with power, in the event that the utility power is
interrupted. The load is spread among all generators, but the peak load is such that, if an
entire group of generators stop working, the remaining generators will be able to assume the
entire load. Another way to look at it is, N generators will be able to support the peak utility
load. If the peak utility load is more than N can support, then system design redundancy will
be lost.

In this example, there are two groups with three generators in each. In a 2N configuration,
one group of generators can go offline and the system will still have the designed
redundancy. Therefore, the value for N is three. So, the total peak utility load cannot exceed
the derated nameplate of three of the generators.



2(N+1) Type
The 2(N+1) system configuration is for two groups of generators that supply power to the IT
loads. In an 2(N+1) system, an entire group of generators plus onemore generator from each
of the remaining groups can stop functioning or be taken off-line, and the equipment will still
be supplied with power, in the event that the utility power is interrupted. The load is spread
among all generators, but the peak load is such that if an entire group’s worth of generators
goes offline, plus onemore from each of the other groups stop working, the remaining
generators will be able to assume the entire load. Another way to look at it is, N generators
will be able to support the peak utility load. If the peak utility load is more than N can support,
then system design redundancy will be lost.

In this example, there are two groups with five generators in each. In a 2(N+1) configuration,
one group of generators can go offline, plus onemore generator from the remaining group and
the system will still have the designed redundancy. Therefore, the value for N is four. So, the
total peak utility load cannot exceed the derated nameplate of four of the generators.
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2(N+2) Type
The 2(N+2) system configuration is for two groups of generators that supply power to the IT
loads. In an 2(N+2) system, an entire group of generators plus twomore generators from
each of the remaining groups can stop functioning or be taken off-line and the equipment will
still be supplied with power, in the event that the utility power is interrupted. The load is
spread among all generators, but the peak load is such that if an entire group’s worth of
generators goes offline, plus twomore from each of the other groups goes offline, the
remaining generators will be able to assume the entire load. Another way to look at it is, N
generators will be able to support the peak utility load. If the peak utility load is more than N
can support, then system design redundancy will be lost.

In this example, there are two groups with four generators in each. In a 2(N+2) configuration
one group of generators can stop working, plus twomore generators from the remaining
group and the system will still have the designed redundancy. Therefore, the value for N is
two. So, the total peak utility load cannot exceed the derated nameplate of two of the
generators.

UPS System Redundancy Types
You can create a UPS system to achieve power redundancy for IT equipment loads in
different ways, depending on how the UPS units are grouped together and how they are
connected to the equipment power supplies. This configuration tool supports several industry
standard configurations.

The UPS system supports the following redundancy design types:

"N Type"

"N+1 Type"

"N+2 Type"



"2N Type"

"UPS System Redundancy Types"

"UPS System Redundancy Types"

N Type
The N system configuration is for one or more UPS modules which work together to supply
power to the IT load. There is no redundancy, except optionally to the second power supply
of each piece of equipment.

Each UPS system with an N configuration can havemultiple UPS groups, where each group
is connected to a different load. The number of modules within each UPS group can be
different. Within each group, all UPS modules must have the same derated nameplate rating
value (kW).

N+1 Type
The N+1 system configuration is for one or more UPS modules that work together to supply
power to the IT load. There is simplemodule redundancy in that one of themodules can be
rendered inoperative or be taken off-line. The load is spread among all remaining UPS
modules, but the peak load is such that if onemodule stops working, the others will be able
to assume its load. Another way to look at it is, N UPS modules will be able to support the
peak IT load. If the peak IT load is more than N can support, then system design redundancy
will be lost.

There is the option to connect the system of modules to the second power supply of each
piece of equipment, but both power supplies are connected to the group of UPS modules.

Each UPS system with an N+1 configuration can havemultiple UPS groups, where each
group is connected to a different load. The number of modules within each UPS group can be
different. Themodules within a UPS groupmust have the same derated nameplate rating
value (kW).
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N+2 Type
The N+2 system configuration is for a group of UPS modules that work together to supply
power to the IT load. There is simplemodule redundancy in that any two of themodules can
be rendered inoperative or be taken off-line. The load is spread among all remaining UPS
modules, but the peak load is such that if twomodules stop working, the others will be able to
assume their load. Another way to look at it is, N UPS modules will be able to support the
peak IT load. If the peak IT load is more than N can support, then system design redundancy
will be lost. An example of an N+2 system is five UPS modules connected to the IT load, but
the peak IT load never exceeds the capacity of three of the UPS modules.

There is the option to connect the system of modules to the second power supply of each
piece of equipment, but both power supplies are connected to the group of UPS modules.

Each UPS system with an N+2 configuration can havemultiple UPS groups, where each
group is connected to a different load. The number of modules within each UPS group can be
different. Themodules within a UPS groupmust have the same derated nameplate rating
value (kW).



2N Type
The 2N system configuration is for two or three groups of UPS modules that supply power to
two different power supplies in each IT load. For redundancy, an entire UPS group can stop
working or be taken off-line, and the IT equipment will still be supplied with power. It also
means that either one of the two power supplies in an IT load can be rendered inoperative.
The load is spread among all UPS modules, but the peak load is such that if an entire group’s
worth of modules are not working, the remainingmodules will be able to assume their load.
Another way to look at it is, N UPS modules will be able to support the peak IT load. If the
peak IT load is more than N can support, then system design redundancy will be lost.

Each UPS system with a 2N configuration can have two or three UPS groups. If there are
two groups, both of themmust be connected to the same load. If there are three groups, then
there are three separate loads and each group is connected to two of the loads. The number
of modules within each UPS group in a UPS systemmust be the same in a 2N configuration.
Additionally, all UPS modules within a UPS groupmust have the same derated nameplate
rating value (kW).

In the first example, there are two groups with four UPS modules each. In a 2N configuration,
one group can stop working and the system will still have the designed redundancy.
Therefore, the value for N is four. So, the total IT load cannot exceed the derated nameplate
rating of four of the UPS modules.
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In the second example, there are three groups with four UPS modules each. In a 2N
configuration, one group’s worth of UPS modules can be rendered inoperative and the
system will still have the designed redundancy. Therefore, the value for N is eight. So, the
total IT load (for all three IT load groups shown below) cannot exceed the derated nameplate
rating of eight of the UPS modules.

2(N+1) Type
The 2(N+1) system configuration is for two or three groups of UPS modules that supply
power to two different power supplies in each IT load. The redundancy providedmeans that
an entire group of UPS modules, plus onemoremodule from the remaining groups, can stop
working or be taken off-line, and the IT equipment will still be supplied with power. It also
means that either one of the two power supplies in an IT load can be rendered inoperative.
The load is spread among all UPS modules, but the peak load is such that if an entire group’s
worth of modules be rendered inoperative, plus onemore from each other group, the
remainingmodules will be able to assume their load. Another way to look at it is, N UPS
modules will be able to support the peak IT load. If the peak IT load is more than N can
support, then system design redundancy will be lost.

Each UPS system with a 2(N+1) configuration can have two or three UPS groups. If there
are two groups, both of themmust be connected to the same load. If there are three groups,
then there are three separate loads and each group is connected to two of the loads. The
number of modules within each UPS group in a UPS systemmust be the same in a 2(N+1)
configuration. Additionally, all UPS modules within a UPS groupmust have the same
derated nameplate rating value (kW).



In the first example, there are two groups with four UPS modules in each group. One group
plus one UPS module from the other group can be rendered inoperative, and the system will
still have the designed redundancy. Therefore, the value for N is three. So, the total IT load
cannot exceed the derated nameplate rating of three of the UPS modules.

In the second example, there are three groups with four UPS modules in each group. One
group plus onemodule from each of the other two groups can stop working and the system
will still have the designed redundancy. Therefore, the value for N is six. So, the total IT load
(for all three IT load groups shown below) cannot exceed the derated nameplate rating of six
of the UPS modules.
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2(N+2) Type
The 2(N+2) system configuration is for two or three groups of UPS modules that supply
power to two different power supplies in each IT load. The redundancy providedmeans that
an entire group of UPS modules, plus twomoremodules from the remaining groups, can stop
working or be taken off-line and the IT equipment will still be supplied with power. It also
means that either one of the two power supplies in an IT load can stop working. The load is
spread among all UPS modules, but the peak load is such that, if an entire group stops
working, plus twomore from the other group, the remainingmodules will be able to assume
their load. Another way to look at it is, N UPS modules will be able to support the peak IT
load. If the peak IT load is more than N can support, then system design redundancy will be
lost.

Each UPS system with a 2(N+2) configuration can have two or three UPS groups. If there
are two groups, both of themmust be connected to the same IT load. If there are three
groups, then there are three separate loads and each group is connected to two of the loads.
The number of modules within each UPS groupmust be the same. All UPS modules within a
groupmust have the same derated nameplate rating value (kW).

In the first example, there are two groups with four UPS modules each. One group can be
rendered inoperative, plus twomore UPS modules from the other group and the system will
still have the designed redundancy. Therefore, the value for N is two. The total IT load cannot
exceed the derated nameplate rating of two of the UPS modules.



In the second example, there are three groups with four UPS modules each. One group plus
twomodules from each of the other two groups can stop working, and the system will still
have the designed redundancy. Therefore, the value for N is four. So, the total IT load cannot
exceed the derated nameplate rating of four of the UPS modules.
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Uninterrupted Power Supply (UPS) Battery Health
Report calculations

The following terms and explanations of various calculations are used in theUPS Battery
Health Report:

First Drop Analysis – Minimum Drop Voltage (V), Maximum Drop Voltage (V) and
Difference (%): The voltage dropminimum, maximum and percentage difference values are
shown in the Drop Analysis table section. To calculate these values, a valid waveform
voltage dropmust be found first by sampling the waveform data.

A valid voltage drop is defined as the first waveform section of size n, where the relative
minimum andmaximum voltage values have a percentage difference d. In addition, the next
sample n+1must be greater in value than theminimum voltage, to ensure that the lowest
value has been found in the voltage drop.

The sampling section size n and the percentage difference d are determined by the user-
defined report parameters Waveform Drop Sample Size andWaveform Drop Percentage,
respectively.

After the voltage drop has been found, theMinimum Voltage andMaximum Voltage are
simply themin andmax values in that drop samples, and the Difference is the percentage of
themaximum voltage over theminimum voltage. For example:

Minimum Drop Voltage = Min(ws1 <= WaveformValues < = wsN)

Maximum Drop Voltage= Max(ws1 <= WaveformValues <= wsN)

ws1 is the first point in the sample and wsN is the last point in the sample

Difference (%) = [(Maximum Drop Voltage –Minimum Drop Voltage) / Maximum Drop
Voltage]

Recovery Analysis – Target Recovery Voltage (V), Actual Recovery Voltage (V) and
Recovery Time (ms):

Target Recovery Voltage (V): This value is calculated for the reference waveform only.
This is calculated as follows:

Target Recovery Voltage (V) = [Recovery Voltage * Recovery ValueMultiplier]

Where Recovery Voltage = Average(w1 <= WaveformValues < wN)

w1 is the very first point in the waveform and wN is the lowest point in the waveform
voltage drop and Recovery ValueMultiplier is a user-defined value in the report pre-
requisite page

Actual Recovery Voltage (V): The first point in the reference and comparison waveforms
that occurs after the voltage drop, that is equal or greater than the Target Recovery Voltage
value.

Recovery Time (ms): This is the time elapsed from theMinimum Voltage Drop time and the
Actual Recovery Voltage time, expressed inmilliseconds.



Additional Calculations
Voltage Threshold: This is the red horizontal area that is highlighted in the waveform drop
chart. It represents a nominal voltage value, therefore there are no calculations for the
Voltage Threshold.

For example, if the user sets the Voltage Threshold to 50V, then a red line will be drawn at
50v (based on the Y-axis) and the area below the red line appears shaded in red .
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